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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 
 

Графический дизайн становится все более интегрирующей профессией, 
объединяющей в работе со сложным, многоуровневым предметом 
визуальной реальности принципы и методы различных профессиональных 
дисциплин. Кроме визуального образа, текста, пространства, графический 
дизайн осваивает такие реальности, как движение, время, интерактивность и 
оперирует все более разнообразными средствами экономических, 
маркетинговых и культурных коммуникаций. 

Качественный дизайн невозможен без целого набора практических 
навыков и теоретических знаний. Современные требования дизайна в разных 
отраслях предполагают умение работать с векторной и растровой графикой. 
В мире современных технологий компьютерная графика занимает по 
популярности одно из первых мест. Она используется для создания рекламы, 
сайтов, мультипликационных фильмов, анимации, компьютерных игр. 

Целью создания УМК по курсу  «Графический дизайн» является 
овладение навыками графического дизайна в программе векторной графики 
Adobe Illustrator, приемами практического использования инструментов 
программы в будущей профессиональной деятельности. 

Для достижения поставленной цели необходимо решение следующих 
учебных задач дисциплины: 

- формирование системы базовых знаний и навыков для создания и 
обработки векторной графики; 

- развитие творческого подхода к поставленной задаче в процессе 
практической деятельности учащихся; 

- освоение эффективных методов и средств решения творческих задач в 
области графического дизайна  на основе совместного использования 
растровой и векторной компьютерной графики; 

- расширение базы для ориентации слушателя в мире современных 
профессий. 

В результате изучения дисциплины студенты должны знать: 
- принципы построения, обработки и хранения изображений с помощью 

графических редакторов; 
- особенности, достоинства и недостатки векторной графики; 
- инструментарий графического редактора; 
- основные приемы работы в программе Adobe Illustrator. 
уметь: 
- создавать и редактировать графические изображения; 
- выполнять типовые действия с объектами и документами в среде 

Adobe Illustrator; 
- применять различные графические эффекты. 
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https://ru.wikipedia.org/wiki/%D0%9C%D0%B0%D1%80%D0%BA%D0%B5%D1%82%D0%B8%D0%BD%D0%B3


владеть: 
- практическими навыками использования инструментария программы 

для обработки цифровых изображений и создания графического контента для 
использования в различных областях. 

Содержание УМК по данной учебной дисциплины направлено на 
формирование академических компетенций, включающих знания и умения 
по изученным учебным дисциплинам, умение учиться, а также социальных и 
профессиональных компетенций. 
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ТЕОРЕТИЧЕСКИЙ РАЗДЕЛ 
      КОНСПЕКТ ЛЕКЦИЙ 

 
ТЕМА 1. ВВЕДЕНИЕ. ТЕОРЕТИЧЕСКИЕ ОСНОВЫ ГРАФИЧЕСКОГО 

ДИЗАЙНА 
 
Основные понятия в графическом дизайне. Историческая реконструкция 

развития графического дизайна. Разделы графического дизайна по 
категориям решаемых задач. Основные концепции графического дизайна. 

Цель:  
- познакомить с понятием «графический дизайн»  
- изучить основные характеристики графического дизайна 
- рассмотреть графический дизайн как специализированный вид научной 

деятельности  
- развить интерес к предмету 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- подведение итогов 

ЛЕКЦИЯ  
 
В настоящее время графический дизайн является многокомпонентным 

явлением, в котором представлены учебно-образовательная деятельность, 
связанная с подготовкой профессиональных кадров (образование), 
проектирование дизайн-объектов (практика), а также развитие научных основ 
дизайнерской деятельности (теория).  

В рамках данной лекции мы рассмотрим графический дизайн как 
специализированный вид научной деятельности.  

Если обратиться к истории становления графического дизайна, то на 
протяжении длительного времени наблюдалось взаимное обособление 
художественно-проектной и научно-исследовательской деятельности, что 
вписывалось в рамки общей тенденции развития духовной культуры. Так, в 
историческом процессе, начиная с эпохи Нового времени, научное познание 
(не искусство) в системе ценностей европейской культуры занимало 
центральное место.  

Ситуация изменяется в эпоху неклассической и постнеклассической 
науки, когда, согласно Х.Г. Гадамеру, происходит сближение науки и 
искусства. С одной стороны, появляется потребность в «человекоразмерном» 
познании, в создании «коммуникативной общности», что связано с 
ценностно-эмоциональными сторонами познания [2].  

В социокультурном плане актуальность проблемы соотношения 
графического дизайна и науки конца ХХ – начала ХХI вв. обусловлена тем, 
что искусство и наука становятся взаимодополнительными принципами в 
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общей структуре познавательного процесса. С другой стороны, в 
профессиональной и повседневной деятельности увеличивается влияние 
визуальных образов на сознание современного человека, возрастает роль 
визуальных коммуникаций. В этих условиях «художественные умения 
оказались востребованными не только в художественных, но и в 
нехудожественных видах творчества, таких как сфера коммуникаций, 
реклама, дизайн» [3, с. 3]. Иными словами, в зависимости от трансформаций 
социально-культурного контекста изменялось соотношение не только между 
наукой и визуальными искусствами, но и преодолевается обособление между 
наукой и графическим дизайном. 

Растущий интерес к исследованию научных основ графического дизайна 
обнаруживается, начиная с 80-х гг. ХХ века. К этому времени позиция по 
отношению к графическому дизайну как к технологическому процессу «не 
обременённому теорией» исчерпала себя. 

Данные обстоятельства определили появление двух направлений в 
рамках теоретических исследований. Первое направление обусловлено 
потребностью в осмыслении природы графического дизайна, его функций, 
направлений развития в связи с достижениями в области проектирования 
дизайн-объектов. Появление первых теоретических исследований было 
ориентировано на систематизацию конкретных результатов, полученных в 
различных областях дизайна. Как отмечает Е.М. Бизунова, ещё в 60-е гг. 
ХХ века в отечественном дизайне, с опорой на западных теоретиков, таких 
как Т. Мальдонадо и др., были сформированы концептуальные основания 
теоретических исследований в области дизайна [1, с. 13]. Эти исследования 
имели целью развитие общей теории дизайна, её принципов. Проблематика 
научных исследований касалась, прежде всего, разработки теоретических 
основ дизайна, его методологии, выявления исторических, социальных 
условий, психологических факторов дизайн-проектирования.  

Итогом исследований, осуществляемых научным сообществом 
лаборатории общетеоретических проблем отдела теории и методов 
художественного конструирования ВНИИТЭ (1965–1968 гг.), явилось 
формирование системно-деятельностной методологии общей теории дизайна, 
выявление типов и особенностей проектной культуры, создание понятийного 
аппарата исследований. 

Важным аспектом данных исследований являлся вопрос о структуре 
научного знания в дизайне и выделении в нём двух типов теорий: общей и 
частной. Полагаем, что эта идея может быть положена в основу определения 
статуса графического дизайна как научной теории. А именно: по отношению 
к общей теории она выступает в роли частной (специальной) теории.  

При этом формально общая теория дизайна и теория дизайн-графики 
отличны друг от друга, так как решают неодинаковые задачи. Но на практике 
между ними обнаруживается глубокая взаимосвязь, так как общая теория 
дизайна выступает «алгоритмом проектной деятельности», а частная – 
обеспечивает принципы и методику проектирования. Поэтому значение 
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исследований в области общей теории дизайна, осуществлённых научным 
сообществом, представляющих лабораторию ВНИИТЭ в 60-е гг., нельзя 
переоценить. Модель общей теории дизайна, разработанная научным 
сообществом ВНИИТЭ, выступает в роли парадигмы, которая позволяет 
организовывать и проводить исследования в различных областях дизайна, 
обеспечивая прогресс в многообразных видах дизайн-проектирования. 

В создавшихся обстоятельствах, полагаем, проектная деятельность в 
области графического дизайна, может опираться на данную научную 
традицию. В нашем случае продолжение традиции отечественных 
исследований в области общей теории дизайна является необходимым 
условием развития графического дизайна. Благодаря этой преемственности, 
опираясь на фундаментальные знания, представленные в общей теории 
дизайна, графический дизайн развивается как особый вид проектной 
деятельности и социальный проект [5]. 

Однако прогресс в области графического дизайна зависит не только от 
фундаментальных идей, но и от эффективного решения практических задач. 
В этом смысле, как свидетельствует история графического дизайна, общие 
теоретико-методологические принципы в области проектирования находят 
преломление в графическом дизайне и обусловливают исследование такого 
рода проблем: выявление особенностей стиля в графическом дизайне с 
учётом особенностей проектной ситуации, разработки методик решения 
проблем прикладного характера и т. п.  

Практика графического дизайна в современных социально-
экономических и культурных условиях задействована на решение задач 
«соединения» рынка и массового потребления. Другими словами, в 
современном графическом дизайне на первый план выходит 
коммуникативная функция, согласно которой, акцент в проектировании 
визуальных дизайн-объектов делается на предоставление понятной и 
полезной информации в целях формирования определённой реакции 
потребителей. Поэтому проблемы визуализации, решаемые современной 
дизайн-графикой требуют от дизайнера обращения к достижениям не только 
области дизайна, но и науки на всех ступенях дизайн-проектирования. 

Первые попытки интеграции научного знания, осуществляемые в 
Х1Х веке, были не всегда эффективными. Однако в настоящее время 
интеграция является важнейшей особенностью современной науки, 
обеспечивающей комплексный характер решения многих проблем в 
изучении мира. 

Применительно к концепциям в области современного графического 
дизайна, важно учитывать, что они формируются также в пространстве 
взаимодействия технического, социально-гуманитарного и 
естественнонаучного знания. Как замечает Б. Мартин, новые стратегии в 
визуальных коммуникациях возможны на основе применения научных 
методов [4, с. 7]. Выявим формы интеграции научных идей в дизайн-графику 
с учётом системной методологии: 

8 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



• заимствование понятийного аппарата и символики других наук. Так, из 
технических и социально-гуманитарных наук вошли в теоретический арсенал 
графического дизайна понятия: «информация», «шум», «избыточность», 
«коммуникация», «сообщение» и т. п.; 

• построение структуры проектного процесса с использованием идей 
классических теорий передачи информации, например, И.К. Шеннона и 
У. Уивера. Она включает следующие ступени в проектном процессе: 
коммуникатор – сообщение – канал – получатель – последствия; 

• использование социологических моделей осуществления массовых 
коммуникаций. Так, например, осуществляется экстраполяция вопросов, 
представленная в модели изучения массовых коммуникаций Г. Лансвелла. 
Применительно к графическому дизайну вопросы экстраполируются в таком 
виде: кто является коммуникатором? Какова роль дизайнера в 
осуществлении коммуникационного проекта? С какой целью осуществляется 
дизайн-проект? Какими ресурсами обладает графический дизайнер 
(профессиональными, техническими, экономическими)? Какое влияние на 
потребителей оказывают дизайн-продукты? Как обеспечивается обратная 
связь с потребителями? Как видим, характер вопросов свидетельствует о том, 
что происходит изменение проблемного поля графического дизайна; 

• использование качественных и количественных методов 
естественнонаучных исследований: наблюдение, эксперимент, 
математического исчисления; 

• применение методов социально-гуманитарных наук (социологии, 
маркетинга, психологии, семиотики, этнографии, философии, культурологи, 
визуальных искусств и др.). К ним можно отнести: использование интервью, 
наблюдений, анкетирование, фокус-группы, анализ документов и др. 
Заметим, что данная разновидность методов имеет универсальное значение 
для графического дизайна, потому что дизайн-графика является частью 
социально-гуманитарной сферы. Поэтому этим методам принадлежит 
главная роль в осуществлении эффективных визуальных коммуникаций 
средствами дизайн-графики. 

Итак, особенностью графического дизайна в современных условиях 
является то, что его успешность как вида проектной деятельности, зависит от 
расширяющегося использования науки на разных ступенях дизайн-
проектирования. Проблемы визуализации, решаемые в дизайн-графике 
требуют от дизайн-мышления соблюдения методов, приёмов, правил. 

  
Список литературы: 
1. Бизунова, Е.М. Дизайн 60-х: поиски концептуальных основ // 

Генисаретский О.И., Бизунова Е.М. Теоретические и методологические 
исследования в дизайне – М.: Изд-во Школы Культурной Политики, 2004. 
373 с. 
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ТЕМА 2. КОМПЬЮТЕРНАЯ ГРАФИКА В ГРАФИЧЕСКОМ ДИЗАЙНЕ 
 
 Основы 2D графики, возможности и применение программ. Виды 

компьютерной графики, отличительные особенности. Характеристики 
цифровых изображений: цветовые модели (режимы), глубина цвета, размер и 
разрешение, форматы файлов.  

Цель:  
- познакомить с основами компьютерной графики 
- изучить виды и особенности компьютерной графики  
- охарактеризовать цветовые режимы цифровых изображений 
- научить различать понятия: размер, разрешение и форматы файлов 

цифровой графики 
- развить интерес к предмету 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- подведение итогов 

ЛЕКЦИЯ 
 
Компьютерная графика – это наука, один из разделов информатики, 

изучающая способы формирования и обработки изображений с помощью 
компьютера. Компьютерная графика является одним из наиболее «молодых» 
направлений информатики, она существует около 40 лет.  
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Хотя сфера применения компьютерной графики очень широка, тем не 
менее, можно выделить несколько основных направлений, где средства 
компьютерной графики стали важнейшими для решения задач: 

1. Иллюстративное, самое широкое из направлений, охватывающее 
задачи от визуализации данных до создания анимационных фильмов. 

2. Саморазвивающее – компьютерная графика позволяет расширять и 
совершенствовать свои возможности. 

3. Исследовательское – создание средствами компьютерной графики 
изображения абстрактных понятий либо моделей, физического аналога 
которых пока не существует с целью корректировки их параметров. 

Компьютерная графика делится на двумерную и трехмерную. 2D, или 
двумерная графика – раздел компьютерной графики, работающий с 
изображением, формируемым в двух измерениях, обладающим только двумя 
параметрами – шириной и высотой. 2D еще называется изображением 
плоским. 

ЗD или трехмерная графика – раздел компьютерной графики, объектом 
которого является изображение, формируемое в трех измерениях, к 
параметрам которого добавлена глубина. Проще говоря, 3D – это объемное 
изображение. 

3D позволяет оценить размеры объекта и расстояние до него благодаря 
способности нашего зрения воспринимать перспективу. 2D же 
реалистичному восприятию картинки обязано особенности нашего мозга: 
глаза считывают плоское изображение, а мозг дорисовывает представления в 
трехмерном формате.  

Виды 2D компьютерной графики 
Несмотря на то, что для работы с компьютерной графикой существует 

множество классов программного обеспечения, различают всего три вида 
компьютерной графики. Это растровая графика, векторная и фрактальная 
графика. Они отличаются принципами формирования изображения при 
отображении на экране монитора или при печати на бумаге.  

Слово фрактал образовано от латинского "fractus" и в переводе означает 
«состоящий из фрагментов». Фракталом называется структура, состоящая из 
частей, которые в каком-то смысле подобны целому. Фрактальная 
компьютерная графика позволяет создавать абстрактные композиции, где 
можно реализовать множество приёмов: горизонтали и вертикали, 
диагональные направления, симметрию и асимметрию и др. С чем можно 
сравнить фрактальное изображение? Ну, например, со сложной структурой 
кристалла, со снежинкой, элементы которой выстраивается в одну сложную 
композицию. Это свойство фрактального объекта может быть удачно 
использовано для создания орнамента или декоративной композиции. 

 Растровую графику применяют при разработке электронных 
(мультимедийных) и полиграфических изданий. Иллюстрации, выполненные 
средствами растровой графики, редко создают вручную с помощью 
компьютерных программ. Чаще для этой цели используют, сканируют 
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иллюстрации, подготовленные художником на бумаге, или фотографии. В 
последнее время для ввода растровых изображений в компьютер нашли 
широкое применение цифровые фото- и видеокамеры. Соответственно, 
большинство графических редакторов, предназначенных для работы с 
растровыми иллюстрациями, ориентированы не столько на создание 
изображений, сколько на их обработку. Основным элементом растрового 
изображения является точка. Если изображение экранное, то эта точка 
называется пикселом. Основными достоинствами пиксельной графики 
являются: 

• возможность отобразить на экране или напечатать фотореалистичное 
изображение. Поэтому такой тип компьютерной графики используют для 
печати фотографических изображений, а также для размещения фотографий 
в Интернете; 

• получение таких изображений возможно не только рисованием, но и 
сканированием; 

• для обработки пиксельных изображений в настоящее время создано 
много программ, которые поддерживают одни и те же форматы пиксельных 
файлов. Это позволяет выполнять импорт и экспорт изображений в 
различные программы, что расширяет возможность их обработки. Программа 
Adobe Photoshop наиболее известна и используемая в настоящее время для 
создания и обработки пиксельных изображений. Однако недостатки 
пиксельной графики также велики: 

• Основным недостатком пиксельной графики является большой размер 
файла. Обычная цветная фотография размером 9x12 см, отсканированная с 
разрешением 300 ppi, имеет объем порядка 6 Мбайт. 

• Такие изображения трансформируются с искажениями. Наибольшие 
проблемы возникают при добавлении пикселов, т. к. неизвестно, каким 
цветом закрасить эти пикселы. Аналогичные проблемы, может быть с 
меньшей остротой, проявляются и при попытке удалить пикселы. 

• Любая наклонная линия или фрагмент изображения, расположенный 
под углом, представляются на экране или при печати в виде "лестницы". 
Ничего другого и быть не может, т. к. любой фрагмент построен из 
квадратных пикселов. Правда, эти "кирпичики" могут быть настолько малы, 
что искажения не слишком заметны, однако все равно это создает проблемы 
при работе с пиксельными изображениями. 

Программные средства для работы с векторной графикой наоборот 
предназначены, в первую очередь, для создания иллюстраций и в меньшей 
степени для их обработки. Такие средства широко используют в рекламных 
агентствах, дизайнерских бюро, редакциях и издательствах. Оформительские 
работы, основанные на применении шрифтов и простейших геометрических 
элементов, решаются средствами векторной графики намного проще. 
Существуют примеры высокохудожественных произведений, созданных 
средствами векторной графики, но они скорее исключение, чем правило, 
поскольку художественная подготовка иллюстраций средствами векторной 
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графики чрезвычайно сложна. Как в растровой графике основным элементом 
изображения является точка, так в векторной графике основным элементом 
изображения является линия (при этом не важно, прямая это линия или 
кривая). Разумеется, в растровой графике тоже существуют линии, но там 
они рассматриваются как комбинации точек. 

Основными достоинствами векторной графики являются следующие 
особенности: 

• рисунок строится из векторных объектов, которые при сохранении на 
диск описываются в виде математических формул, что существенно 
уменьшает объем файла; 

• векторные объекты легко трансформируются без ухудшения их 
качества; 

• обработка векторных изображений удобна и продуктивна, т. к. имеется 
возможность оперировать целыми объектами или сразу выделять и 
обрабатывать несколько объектов рисунка; 

• печать векторных иллюстраций не связана с разрешением 
изображения. Они могут быть напечатаны с максимальным разрешением, на 
которое способно устройство; 

• одними из лучших векторных программ являются программы Adobe 
Illustrator и CorelDraw. 

К недостаткам векторной графики можно отнести следующее: 
• векторные рисунки выглядят примитивными, плоскими, не 

фотореалистичными; 
• создание сложных художественных векторных изображений 

затруднительно и требует высоких навыков и больших затрат времени; 
• векторные изображения не могут быть получены сканированием. Их 

можно либо создавать "от руки", либо с использованием программ 
трассировки, которые не обеспечивают надлежащего качества. 

Цвет в компьютерной графике нужен для того, чтобы: 
• Нести в себе определенную информацию об объектах. Например, летом 

деревья зеленые, осенью - желтые. На черно-белой фотографии определить 
пору года практически невозможно, если на это не указывают какие-либо 
другие дополнительные факты. 

• Цвет необходим также для того, чтобы различать объекты. 
• С его помощью можно вывести одни части изображения на первый 

план, другие же увести в фон, то есть акцентировать внимание на важном - 
композиционном - центре. 

• Без увеличения размера при помощи цвета можно передать некоторые 
детали изображения. 

В двумерной графике, а именно таковую мы видим на мониторе, так как 
он не обладает третьим измерением, именно при помощи цвета, точнее 
оттенков, имитируется (передается) объем. Цвет используется для 
привлечения внимания, создания красочного и интересного изображения. 
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Любое компьютерное изображение характеризуется, кроме 
геометрических размеров и разрешения (количество точек на один дюйм), 
максимальным числом цветов, которые могут быть в нем использованы. 
Максимальное количество цветов, которое может быть использовано в 
изображении данного типа, называется глубиной цвета.  

Системы отображения графической информации воздействуют на 
зрительный аппарат человека, поэтому с необходимостью должны учитывать 
как физические, так и психофизиологические особенности зрения. 

Цвета в природе редко являются простыми. Большинство цветовых 
оттенков образуется смешением основных цветов. Способ разделения 
цветового оттенка на составляющие компоненты называется цветовой 
моделью. Существует много различных типов цветовых моделей, но в 
компьютерной графике, как правило, применяется не более трех. Эти модели 
известны под названиями: RGB, CMYK и HSB.  

Цветовая модель RGB  
Наиболее проста для понимания и очевидна модель RGB. В этой модели 

работают мониторы и бытовые телевизоры. Любой цвет считается 
состоящим из трех основных компонентов: красного (Red), зеленого (Green) 
и синего (Blue). Эти цвета называются основными. Данную модель 
применяют всегда, когда готовится изображение, предназначенное для 
воспроизведения на экране. Если изображение проходит компьютерную 
обработку в графическом редакторе, то его тоже следует представить в этой 
модели. В графических редакторах имеются средства для преобразования 
изображений из одной цветовой модели в другую.  

Цветовая модель CМYK  
Эту модель используют для подготовки не экранных, а печатных 

изображений. Они отличаются тем, что их видят не в проходящем, а в 
отраженном свете. Чем больше краски положено на бумагу, тем больше света 
она поглощает и меньше отражает. Совмещение трех основных красок 
поглощает почти весь падающий свет, и со стороны изображение выглядит 
почти черным. В отличие от модели RGB увеличение количества краски 
приводит не к увеличению визуальной яркости, а наоборот к ее уменьшению. 
Поэтому для подготовки печатных изображений используется не аддитивная 
(суммирующая) модель, а субтрактивная (вычитающая) модель. Цветовыми 
компонентами этой модели являются не основные цвета, а те, которые 
получаются в результате вычитания основных цветов из белого:  

ГОЛУБОЙ (Cyan) 
 ПУРПУРНЫЙ (Magenta) 
ЖЕЛТЫЙ (Yellow)  
Эти три цвета называются дополнительными, потому что они дополняют 

основные цвета до белого. Существенную трудность в полиграфии 
представляет черный цвет. Теоретически его можно получить совмещением 
трех основных или дополнительных красок, но на практике результат 
оказывается негодным. Поэтому в цветовую модель CМYK добавлен 
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четвертый компонент — черный. Ему эта система обязана буквой К в 
названии (blacK).  

Цветоделение. В типографиях цветные изображения печатают в 
несколько приемов. Накладывая на бумагу по очереди голубой, пурпурный, 
желтый и черный отпечатки, получают полноцветную иллюстрацию. 
Поэтому готовое изображение, полученное на компьютере, перед печатью 
разделяют на четыре составляющих одноцветных изображения. Этот процесс 
называется цветоделением. Современные графические редакторы имеют 
средства для выполнения этой операции.  

Цветовая модель HSB  
Некоторые графические редакторы позволяют работать с цветовой 

моделью HSB. Если модель RGB наиболее удобна для компьютера, а модель 
CMYK — для типографий, то модель HSB наиболее удобна для человека. 
Она проста и интуитивно понятна. В модели HSB тоже три компонента: 
оттенок цвета (Hue), насы- щенность цвета (Saturation) и яркость цвета 
(Brightness). Регулируя эти три компонента, можно получить столь же много 
произвольных цветов, как и при работе с другими моделями.  

Цветовая модель HSB удобна для применения в тех графических 
редакторах, которые ориентированы не на обработку готовых изображений, а 
на их создание своими руками. Существуют такие программы, которые 
позволяют имитировать различные инструменты художника (кисти, перья, 
фломастеры, карандаши), материалы красок (акварель, гуашь, масло, тушь, 
уголь, пастель) и материалы полотна (холст, картон, рисовая бумага и пр.). 
Создавая собственное художественное произведение, удобно работать в 
модели HSB, а по окончании работы его можно преобразовать в модель RGB 
или CМYK, в зависимости от того, будет ли оно использоваться как экранная 
или печатная иллюстрация.  

В цветовом пространстве Lab значение светлоты отделено от значения 
тона и  насыщенности. Светлота задана координатой L (изменяется от 0 до 
100, то есть от самого темного до самого светлого), тон и насыщенность – 
двумя координатами a и b. Первая обозначает положение цвета в диапазоне 
от зеленого до пурпурного, вторая – от синего до желтого. В отличие от 
цветовых пространств RGB или CMYK, Lab однозначно определяет цвет. 
Поэтому Lab нашел широкое применение в программном обеспечении для 
обработки изображений в качестве промежуточного цветового пространства, 
через которое происходит конвертирование данных между другими 
цветовыми пространствами (например, из RGB сканера в CMYK печатного 
процесса). Благодаря характеру определения цвета в Lab появляется 
возможность отдельно воздействовать на яркость, контраст изображения и на 
его цвет. Во многих случаях это позволяет ускорить обработку изображений, 
например, при допечатной подготовке. Lab предоставляет возможность 
избирательного воздействия на отдельные цвета в изображении, усилиения 
цветового контраста, незаменимыми являются и возможности, которые это 
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цветовое пространство предоставляет для борьбы с шумом на цифровых 
фотографиях. 

 
 
 

ТЕМА 3. ВЕКТОРНАЯ ГРАФИКА В ГРАФИЧЕСКОМ ДИЗАЙНЕ 
 

Обзор инструментария  для создания и обработки векторной графики. 
Редактор векторной графики Adobe Illustrator. Элементы интерфейса. Работа 
с палитрами. Рабочее пространство. Навигация в окне документа. Настройки 
программы. Работа с документом. Создание и сохранение документа. 
Организация окон. Монтажные области. Линейки. Сетка. Направляющие. 

Цель:  
- познакомить учащихся с интерфейсом программы Adobe Illustrator 
- научиться открывать, создавать, сохранять файлы, работать с 

документами в окнах программы 
- изучить настройки программы 
- развить интерес к предмету 
- воспитать дисциплинированность и целеустремленность 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
Теория: 
Обзор интерфейса программы Adobe Illustrator. Основными элементами 

являются: главное меню, панель инструментов, панель параметров и 
палитры. 

Горячие клавиши для базовых операций: создать новый документ, 
открыть документ, сохранить, печать, закрыть. 

Настройки программы: цветовая схема, память, тонкие настройки. 
Палитры как наборы и настройки. Организация и представление палитр. 

Строение палитр. Работа с палитрами. 
Настройка рабочего пространства. 
Навигация в окне документа. Инструменты навигации и горячие 

клавиши. Работа с несколькими документами. Организация окон программы. 
Режимы отображения. 

Выбор инструментов. Использование горячих клавиш. 
Изменение цветового режима изображений. Визуальное представление 

каналов изображения. 
Практика: 
- изменить цветовую схему интерфейса 
- изменить рабочий диск для кеширования 
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- назначить количество оперативной памяти для программы 
- настроить и сохранить рабочее пространство 
- создать новый документ с заданными параметрами: размер, 

ориентация, количество монтажных областей, цветовой режим, разрешение. 
- открыть несколько документов и упорядочить их в окне программы в 

виде закладок  
- открыть документ и изменить его цветовой режим, размер монтажной 

области, ориентацию, сохранить под новым именем 
Смостоятельная работа: 
В приложенных файлах произвести изменения размеров монтажной 

области, ориентацию, сохранить под новым именем. 
 

КРАТКИЙ КОНСПЕКТ 
 
Adobe Illustrator — векторный графический редактор, разработанный и 

распространяемый фирмой Adobe Systems.  
Illustrator был задуман как редактор векторной графики, однако 

дизайнеры используют его в самых разных целях. Программа обладает 
понятным интерфейсом, легким доступом ко многим функциям, широким 
набором инструментов для рисования и большими возможностями 
управления цветом, текстом, что позволяет создавать векторные изображения 
любого уровня сложности. Adobe Illustrator является одним из наиболее 
удобных редакторов для создания различных макетов для прессы или 
наружной рекламы. Часто она используется для создания иллюстраций, 
мультяшной графики, диаграмм и логотипов.  

Преимущества при использовании векторной графики 
• Масштабируема без потерь в разрешении  
• Линии четкие и ровные при любых размерах  
• Печать на высоких разрешениях  
• Меньший размер файлов  
• Хорошо подходит для создания иллюстраций  
Недостатки векторной графики 
• Рисунки склонны выглядеть плоскими и «мультяшными»  
• Тяжело создать фотореалистичные изображения  
Перед  тем, как приступить к созданию файлов  в Adobe Illustrator, 

необходимо изучить инструменты и средства управления интерфейсом 
программы. Компания Adobe использует схожий пользовательский 
интерфейс во всех своих продуктах. Благодаря этому пользователи Adobe 
Photoshop легко могут освоить Adobe Illustrator, и наоборот.  

Интерфейс программы Adobe Illustrator включает в себя много 
уникальных элементов, которые позволяют выполнять различные операции. 
Как только вы научитесь использовать эти элементы, то также узнаете о 
комбинациях клавиш, с помощью которых можно выполнять различные 
задачи.  
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Окно документа. Окно документа состоит из рабочей и монтажной 
областей, в которых отображается рисунок. Оно появляется всякий раз при 
открытии уже существующего или создании нового документа.  

 Панель инструментов. Данная палитра содержит основные 
инструменты. Каждому инструменту соответствует определенный значок. 
Для того чтобы выбрать инструмент, достаточно щелкнуть на необходимом 
значке.  

 Палитры. Это плавающие окна с вкладками, которые при 
необходимости можно открыть или закрыть.  

 Меню. В верхней части окна программы расположены меню, в которых 
содержатся подменю команд и параметров.  

Монтажная область. Монтажная область – это часть окна программы, в 
которой отображается распечатываемый рисунок. Монтажная область 
обозначается прямоугольником с  тонкой обводкой. 

Окно документа состоит из двух основных элементов: монтажной 
области и рабочей области. Монтажная область всегда расположена в центре 
рабочей области, а почти все палитры закрыты, чтобы обеспечить 
возможность просмотра документа в целом. Для настройки размера, 
ориентации и единиц измерения монтажной области используется 
диалоговое окно Document Setup (Параметры документа). Для его 
отображения воспользуйтесь командой File-Document Setup. Для изменения 
размера станицы используйте команду File-Print (Файл-Печать). 
Обратившись к меню View (Вид), вы сможете скрыть монтажную область с 
помощью команды Hide Artboard (Скрыть монтажную область). После этого 
команда превратится в View Artboard (Отобразить монтажную область). 

Возможно, самая неприятная вещь, которая может случиться при работе 
с программой Illustrator – это потеря всего, что вам удалось сделать. “Куда 
оно все подевалось?” – печатный вариант оборота, который обычно 
употребляется в подобных случаях. В такую ситуацию легко попасть, если 
щелкнуть несколько раз на полосе прокрутки, расположенной в нижней 
части окна документа. При одном таком щелчке происходит перемещение 
области изображения примерно на половину ее ширины (или высоты), а 
после трех щелчков ваша страница (и все, что на ней изображено) исчезает из 
поля зрения. Вместо нее вы видите рабочую область (pasteboard) во всем 
величии белой пустоты.  

Рабочая область – это квадратная область, размером 227,5×227,5 дюймов 
(578×578 cм), которая занимает практически все пространство в пределах 
окна документа. Она доступна для создания, редактирования и временного 
хранения элементов иллюстрации. При реальном размере вы можете видеть 
лишь очень небольшую часть рабочей области. Маленький документ 
размером с письмо выглядит просто крошечным в рабочей области, которая 
довольно велика. Если вы “заблудитесь“ в ней, то советуем выполнить 
команду View-Actual Size (Вид-Реальный размер). При этом ваша страница 
переместится в центр окна с масштабом отображения, равным 100%, и тогда 
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вы сможете увидеть хотя бы часть своей иллюстрации. Чтобы увидеть всю 
страницу, выберите команду View-Fit in Window (Вид-По размеру окна). 

Настройка интерфейса 
Бывает, что набор палитр, загружаемых по умолчанию, и их внешний 

вид вас не устраивают. Ситуацию нетрудно изменить, так как по умолчанию 
программа запоминает состояние палитр на момент закрытия. Для этого 
достаточно будет открыть нужные палитры на экране и закрыть ненужные, 
сгруппировать и разместить их оптимальным образом и установить нужный 
вариант отображения элементов — тогда при следующем открытии 
программа загрузит палитры в точно таком же виде. Правда, бесполезно 
пытаться настроить подобным образом содержимое палитр, добавив в них, 
например, другие цвета, градиентные и текстурные заливки, графические 
стили, символы и кисти, поскольку данная информация при закрытии 
программы не сохраняется — для ее запоминания используются иные 
механизмы, о которых мы расскажем далее. 

Работа с пользовательскими рабочими областями 
Применение пользовательских рабочих областей (Workspace), 

сохраняющих расположение и группировку палитр в окне программы, 
позволяет быстро восстанавливать соответствующие пользовательские 
настройки. Данная возможность позволяет сконфигурировать несколько 
оптимальных рабочих областей, настроенных для решения определенных 
видов задач или для разработки разноплановых проектов (например, одна 
рабочая область может использоваться для web-дизайна, а другая — для 
полиграфии и т.п.). Пользовательские рабочие области могут применяться и 
при работе на одном компьютере нескольких пользователей, каждый из 
которых использует свою индивидуально настроенную рабочую область. Это 
очень удобно, так как можно быстро настроить программу либо под 
потребности конкретного пользователя, либо для текущей работы, загрузив 
соответствующую рабочую область из меню. При необходимости можно 
быстро переключаться между разными рабочими областями. 
Пользовательские рабочие области представляют собой файлы, которые 
можно хранить на диске и вновь подключать после переустановки 
программы. 

По умолчанию предусмотрены две базовые конфигурации рабочих 
областей: [Default] и [Minimal]. Первая загружается при создании нового 
документа, может вызываться 
командой Window=>Workspace=>[Default] (Окно=>Рабочая область=>По 
умолчанию) и обеспечивает загрузку рабочей области по умолчанию, что 
требуется в ходе работы для восстановления палитр. Вторая конфигурация 
загружается при помощи команды Window=>Workspace=>[Minimal] 
(Окно=>Рабочая область=>Минимальная) и позволяет освободить 
максимально возможное пространство для работы, так как при ее вызове 
закрываются все палитры, кроме панели инструментов и палитры Control 
Palette, содержащей переключатели и настройки используемого инструмента.  
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Форматы импортируемых в Adobe Illustrator файлов 
 
Формат файла Команда 

импортирования 
Примечание 

AI Open(Открыть) Форматы всех 
версий программы 

EPS 
(Encapsulated 
PostScript) 

Open(Открыть),  
Place(Поместить) 

 

Acrobat PDF 
(Portable Document 
Format) 

Open(Открыть),      
Place(Поместить) 

Предлагает 
возможность выбора 
отдельной страницы 

Photoshop PSD Open(Открыть),  
Place(Поместить) 

Поддержка файлов, 
допускается прямая 
буксировка из 
программы 

WMF (Windows 
Metafile)/EMF 

Open(Открыть), 
Place(Поместить) 

"Буксировка" 
возможна 
непосредственно из 
программ Microsoft 
Office 

FreeHand Open(Открыть), 
  Place(Поместить) 

Поддержка файлов  

CorelDRAW 
CDR 

Open(Открыть) Поддержка файлов  

Форматы 
пиксельной графики, 
поддерживаемые 
программой 
Photoshop 

Open(Открыть), 
  Place(Поместить) 

Форматы: GIF, 
JPEG, PCX, PIXAR, PNG, 
TIFF и TGA 

Текстовые 
форматы 

Open(Открыть),  
Place(Поместить) 

Форматы: MS RTF, 
MS Word, Corel 
WordPerfect  и т.д. 

1. Сохранение в формате Illustrator 
Если в документе содержится несколько монтажных областей и 

требуется их сохранение в предыдущей версии Illustrator, выберите функцию 
сохранения каждой монтажной области в отдельный файл или объединения 
содержимого всех монтажных областей в один файл. 

1. Выберите команду «Файл» > «Сохранить как» или «Файл» > 
«Сохранить копию». 

2. Введите имя файла и выберите папку для сохранения. 
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3. Выберите в качестве формата файла формат Illustrator (*.AI) и 
нажмите кнопку «Сохранить». 

4. В диалоговом окне «Параметры Illustrator» задайте нужные 
параметры и нажмите кнопку «ОК». 

Версия 
Определяет версию Illustrator, совместимость с которой необходимо 

обеспечить при сохранении файла. Устаревшие форматы не поддерживают 
все возможности текущей версии Illustrator. Поэтому при выборе версии, 
отличной от текущей, некоторые параметры сохранения окажутся 
недоступными, и часть данных будет изменена. Обязательно прочитайте 
предупреждения в нижней части диалогового окна, чтобы узнать, как будут 
изменены данные. 

Сократить знаковый состав шрифтов, если используется символов 
меньше чем 

Определяет, должен ли быть встроен весь шрифт (а не только символы, 
использованные в документе) на основе процентной доли символов шрифта, 
использованных в документе. Например, если шрифт содержит 1000 
символов, но в документе используется только 10 из них, возможно, 
встраивание всего шрифта не требуется, чтобы не увеличивать размер файла. 

2. Создать PDF-совместимый файл 
Сохраняет представление документа в формате PDF в файле Illustrator. 

Выберите этот параметр, если необходимо создать файл Illustrator, 
совместимый с другими приложениями Adobe. 

Включить связанные файлы 
Встраивает файлы, связанные с иллюстрацией. 
Встроить ICC-профили 
Создает документ, в котором используется управление цветом. 
Применить сжатие 
Выполняет сжатие данных PDF в файле Illustrator. При использовании 

сжатия время, необходимое для сохранения документа, увеличивается, 
поэтому отмените выбор этого параметра, если сохранение файлов 
осуществляется медленно. 

Сохранить каждую монтажную область в отдельный файл 
Сохранение каждой монтажной области в отдельном файле. При этом 

также создается отдельный главный файл, включающий все монтажные 
области. В этот файл также включено все содержимое, затрагивающее 
какую-либо монтажную область. Если требуется сместить иллюстрацию и 
подогнать ее под размер одной монтажной области, будет выдано 
соответствующее предупреждение. Размер монтажной области, 
используемой для сохраненного файла, берется из стартового профиля 
документа по умолчанию. 

Сохранение в формате EPS 
Практически все графические приложения, программы верстки и 

текстовые редакторы работают с импортированными или помещенными 
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файлами EPS (Encapsulated PostScript). Формат EPS сохраняет многие из 
графических элементов, которые можно создавать в Adobe Illustrator, 
поэтому файлы EPS можно повторно открывать и редактировать как файлы 
Illustrator. Поскольку в основе файлов EPS лежит язык PostScript, эти файлы 
могут содержать как векторные, так и растровые изображения. Если 
иллюстрация содержит несколько монтажных областей, они сохраняются 
при сохранении в формате EPS. Сохранение в формате SVG 

SVG – векторный формат, используемый для высококачественных 
интерактивных веб-изображений. Существуют две версии формата SVG: 
SVG и сжатый SVG (SVGZ). При использовании формата SVGZ размер 
файла может быть уменьшен на 50–80%, однако нельзя редактировать файлы 
SVGZ с помощью текстового редактора. 

При сохранении иллюстрации в формате SVG сетчатые объекты 
растрируются. Кроме того, изображения, не содержащие альфа-канала, 
преобразуются в формат JPEG. Изображения, содержащие альфа-канал, 
преобразуются в формат PNG. Если в документе содержится несколько 
монтажных областей, то при сохранении этого документа в формате SVG 
будет сохранена только активная монтажная область. Отдельные монтажные 
области не могут быть сохранены как отдельные файлы SVG. 

 
 

ТЕМА 4. ПОСТРОЕНИЕ ДВУМЕРНЫХ ПРИМИТИВОВ. 
ИНСТРУМЕНТЫ ВЫДЕЛЕНИЯ. ОСНОВЫ КОМБИНИРОВАНИЯ 

ИЗОБРАЖЕНИЙ 
 

Рисование фигур. Способы рисования. Настройки инструмента. 
Рисование линейных объектов. Границы и габариты выделенного объекта.  

Инструменты выделения. Команды меню Выделение. Выделение 
схожих объектов. Выделение объектов на заднем плане. Инструмент 
Карандаш, Сглаживание, Стирание контура. Атрибуты объектов. 

Цель:  
- освоить инструменты выделения объектов  
- изучить способы размещения и выравнивания объектов на монтажной 

области 
- познакомить учащихся со способами создания простых фигур 
- научиться изменять параметры создаваемых объектов 
- развить интерес к предмету 
- воспитать дисциплинированность и целеустремленность 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
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- выдача заданий 
Теория: 
Инструменты выделения. Команды меню Выделение. Выделение 

схожих объектов. Выделение объектов на заднем плане. Выделение 
инструментом Волшебная палочка. Выделение через панель свойств. 

Выравнивание и распределение группы объектов. Способы 
выравнивания: по монтажной области, по выделению, по ключевому 
объекту. 

Рисование фигур. Замкнутые и незамкнутые контуры. Способы 
рисования. Настройки инструмента. Рисование линейных объектов. Границы 
и габариты выделенного объекта. Порядок следования и режимы рисования. 

Практика: 
- выбор объектов со схожими свойствами 
- выравнивание объектов в различных режимах 
- рисование фигур и настройка их параметров 
- изменение порядка следования фигур на монтажной области 
- создание векторной иллюстрации 
Смостоятельная работа: 
закончить векторную иллюстрацию. 

 
КРАТКИЙ КОНСПЕКТ 

 
Примитивные фигуры создаются при помощи группы инструментов 

«Основные фигуры».   
Для рисования прямоугольных областей используется инструмент 

прямоугольник:  Rectangle Tool (M). Следующий инструмент – Ellipse Tool 
(L). Этот инструмент предназначен для создания окружностей и эллипсов. В 
этой группе находятся инструменты для создания звезд, многоугольников 
(Polygon Tool), бликов. Механизм работы прост: кликаем на монтажной 
области и, не отпуская клавишу мыши, тянем курсор по диагонали.  

Инструменты создания основных фигур 
На панели инструментов, если вы зажмете инструмент Rectangle Tool 

(Прямоугольник), выскочит всплывающий список доступных инструментов 
основных фигур на выбор: прямоугольник, прямоугольник со скругленными 
углами, эллипс, многоугольник, звезда, блик. 

Заливка и обводка фигуры 
По умолчанию фигуре ставится белая заливка и черная обводка.  
Чтобы изменить цвет заливки или обводки необходимо дважды 

кликнуть на иконку Fill или Stroke на панели инструментов. Выскочит окно 
цветовой палитры (Color Picker), в котором можно выбрать любой цвет. 

Чтобы удалить обводку, необходимо кликнуть по иконке None, 
перечеркнутой красным. 

Чтобы нарисовать фигуру в равных пропорциях при рисовании нужно 
удерживать клавишу Shift. 
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Изменение размеров и вращение фигур 
Чтобы изменить размер фигур, выделите фигуру, используя инструмент 

Seleсtion Tool (Выделение). Появится прямоугольная рамка выделения, 
потянув за угловую точку которой можно менять размер фигуры. Чтобы 
сохранить пропорции, нужно удерживать клавишу Shift во время 
перетягивания. Если зажать Alt, то размер изменится из той же точки. 

При проведении курсора рядом с угловой точкой появляется стрелка 
вращения. С помощью нее можно поворачивать фигуру. Чтобы повернуть 
сразу на 45 градусов, при поворачивании нужно зажать клавишу Shift. 

Если дважды щелкнуть по инструменту рисования основных фигур, 
появится окно опций будущей фигуры, в котором можно задать 
определенные параметры: высоту, ширину, количество углов, количество 
вершин и т.д.  

К инструментам выделения относятся: 
Selection Tool 
Direct Selection tool 
Group Selection Tool   
Magic Wand Tool   
Lasso Tool 
Selection Tool (Выделение) или черная стрелочка. Клавиша быстрого 

вызова ‹V›. 
Инструмент Selection Tool, пожалуй, самый часто используемый 

инструмент Adobe Illustrator. Им пользуются когда объект нужно выделить, 
переместить, скопировать или изменить его масштаб. 

Для того, чтобы выделить объект при помощи инструмента Selection 
Tool существует два способа: 

1. Выбрать инструмент Selection Tool в панели инструментов, 
навести на объект курсор мыши и кликнуть левой кнопкой мыши. 

2. Выбрать инструмент Selection Tool, кликнуть левой кнопкой 
мыши рядом с объектами, которые следует выделить и, не отпуская кнопку 
мыши, потянуть курсор в сторону и выделить необходимые объекты. Можно 
захватить их полностью в рамку выделения, а можно только пересечь части 
контуров — выделенными окажутся все затронутые объекты. 

Для того, чтобы переместить выделение, нужно зажать левую кнопку 
мыши и перетащить выделенные объекты на нужное место. 
Для перемещения строго по вертикали, горизонтали или под углом 45° 
при перетаскивании объекта нужно держать зажатой клавишу Shift. 

Для копирования выделения, при перемещении держите зажатой 
клавишу Alt. 

Соответственно, если вы хотите скопировать объекты строго 
по вертикали, горизонтали или под углом 45° при перетаскивании объекта 
зажмите клавиши Shift и Alt. 

При выделении объекта или группы объектов вокруг них появляется 
рамка с маркерами: 

24 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



Lasso Tool (Лассо). Клавиша быстрого вызова ‹Q›. 
Инструмент Lasso Tool предназначен для выделения секторов контура 

и опорных точек. Он используется в том случае, когда нужно выделить 
несколько опорных точек, расположенных рядом у одного или нескольких 
объектов. 

Просто выберите этот инструмент в панели Tools или клавишей 
быстрого вызова и обведите инструментом вокруг точек, которые нужно 
выделить, зажав левую кнопку мыши. 

 Magic Wand Tool (Волшебная палочка). Клавиша быстрого вызова ‹Y›. 
Инструмент Magic Wand Tool предназначен для объектов, имеющих 

одинаковые атрибуты заливки. 
Для того, чтобы выбрать объекты с одинаковыми настройками выберите 

Magic Wand Tool в панели инструментов и щелкните курсором по объекту, 
который можно считать образцом и выделятся все объекты с такими же 
настройками. 

 Group Selection Tool (Групповое выделение). 
Инструмент Group Selection Tool предназначен для выделения объектов 

в группе и целых групп. 
Он пригодится вам, если вы хотите выделить объект, который 

сгруппирован с другими элементами. 
 
 
ТЕМА 5. РАБОТА С КРИВЫМИ БЕЗЬЕ В ВЕКТОРНОМ РЕДАКТОРЕ 

 
Контуры и опорные точки. Виды опорных точек. Создание прямых 

линий. Создание криволинейных контуров. Инструмент Перо. Инструменты 
для работы с контурами. Редактирование кривых: добавление и удаление 
точек, замыкание контура. Выравнивание опорных точек. Инструмент 
ножницы. Инструмент нож. Преобразование контура в кривые. 

Цель:  
- познакомиться с инструментами для работы с контурами и опорными 

точками 
- освоить инструмент ножницы, инструмент нож 
- научиться преобразовывать контур в кривые 
- развить интерес к предмету 
- воспитать дисциплинированность и целеустремленность 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача заданий 
Теория: 
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Контуры и опорные точки. Режим просмотра «Контуры». Виды опорных 
точек. Создание прямых линий. Создание криволинейных контуров. 
Инструмент Перо. Инструменты для работы с контурами. Редактирование 
кривых: добавление и удаление точек, замыкание контура. Выравнивание 
опорных точек.  

Инструмент ножницы. Инструмент нож. Инструмент Карандаш, 
Сглаживание, Стирание контура.  Преобразование контура в кривые. 

Практика: 
- рисование контуров, прямых и изогнутых.  
- работа с опорными точками.  
- работа с инструментами: Карандаш, Перо, Сглаживание, Стирка, 

Ножницы, Нож 
- рисование пейзажа 
Смостоятельная работа: 
Нарисовать логотип в виде животного. 

 
КРАТКИЙ КОНСПЕКТ 

 
Кривые безье 
1. Модифицирование существующих контуров. Добавление точек к 

контуру. Удаление и преобразование типа точек. 
2. Кривые Безье. Классификация точек и сегментов. Инструмент 

Pen. Инструменты работы с кривыми Безье. 
3. Операции с кривыми (меню Object > Path) 
Векторная графика основана на векторных контурах — на 

геометрических примитивах, на фигурах, построенных из примитивов и 
разнообразных кривых. Все они представляют собой векторные кривые 
Безье, названные так в честь французского математика Пьера Безье, впервые 
воспользовавшегося ими при моделировании кузова легкового автомобиля. 

Сегодня кривые Безье применяются во всех современных программах, 
работающих с векторной графикой, и Illustrator не составляет исключения. 
Главное преимущество их использования состоит в том, что нет 
необходимости запоминать каждую точку кривой — достаточно знать, во-
первых, координаты ее начала и конца, а во-вторых, математическую 
формулу, описывающую кривую. В итоге — полная свобода трансформации 
векторных изображений без какой-либо потери качества. 

Любой векторный контур состоит из одного или нескольких 
криволинейных сегментов (как исключение, сегменты могут быть и 
прямолинейными), каждый из которых является элементарной кривой Безье. 
В начале и конце каждого сегмента находятся так называемые опорные точки 
(рис. 1), которые бывают двух типов: гладкие и угловые. Гладкая опорная 
точка соединяет две кривые без излома, а угловая опорная точка находится 
на изгибе между двумя кривыми (рис. 2). По умолчанию опорные точки 
создаются гладкими, но их тип несложно изменить с помощью 
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инструмента Convert Anchor Point (Угол) из группы Pen (Перо). Кроме того, 
каждый сегмент имеет направляющие линии, ограниченные направляющими 
точками и определяющие угол наклона и кривизну кривой. Изменить форму 
сегмента можно посредством перемещения опорных точек или точек 
направляющих. В конце концов, благодаря бесконечным перемещениям 
точек и трансформациям отдельных сегментов можно сформировать любой 
самый причудливый векторный контур. 

Создавать и редактировать контуры можно с помощью инструментов из 
групп Pencil (Карандаш) и Pen (Перо), а также 
инструментами Brush (Кисть), Spiral (Спираль) и Arc (Дуга).  

Кроме того, рассмотренные графические примитивы — прямоугольники 
(Rectangle), закругленные прямоугольники (Rounded Rectangle), эллипсы 
(Ellipse), многоугольники (Polygon), звезды (Star) и блики (Flare), 
создаваемые с помощью соответствующих инструментов, — также являются 
контурами. Однако основным инструментом для построения кривых Безье 
является Pen, предоставляющий максимальные возможности как для их 
создания, так и для редактирования. 

При создании контуров довольно часто приходится менять масштаб 
изображения, увеличивая его при рисовании мелких деталей и уменьшая при 
создании крупных. Для быстрого изменения масштаба удобнее пользоваться 
комбинациями клавиш: Ctrl+«+» (в случае увеличения масштаба) и Ctrl+«-
» (при его уменьшении). Если выбран большой масштаб, то изображение не 
будет умещаться на экране и по нему придется перемещаться. Использовать 
же для этого полосы прокрутки неудобно, поэтому гораздо лучше с этой 
целью нажимать клавишу пробела (при этом курсор принимает вид руки) и 
перемещать изображение. При отпускании пробела вы вновь возвратитесь в 
обычный режим работы. 

Создание контуров инструментами из группы Pencil 
В данную группу входят инструменты: Pencil (Карандаш), 

предназначенный для рисования произвольных 
линий, Smooth (Сглаживание), позволяющий смягчить форму контура, 
и Erase(Ластик), служащий для удаления отдельных фрагментов контура. 
Особенности использования первого и последнего из них напоминают 
применение аналогичных инструментов в других графических пакетах — с 
той лишь разницей, что они ориентированы на обработку контуров. 

Создание контуров инструментами из группы Pen 
Pen (Перо) — это самый главный инструмент работы с контурами, и в 

его состав входят еще три инструмента: Add Anchor Point — (Перо+), Delete 
Anchor Point (Перо–) и Convert Anchor Point(Угол). Первый отвечает за 
добавление новых опорных точек, второй — за их удаление, а третий 
осуществляет преобразование опорных точек из одного типа в другой. 

При создании и редактировании кривой необходимо быстро 
переключаться с одного перьевого инструмента на другой, для чего служат 
клавиатурные комбинации. В целом инструмент Penвыбирается при нажатии 
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клавиши P, а далее: Add Anchor Point — нажатием клавиши «+»,Delete 
Anchor Point — клавиши «-», а Convert Anchor Point — клавиши Alt. 

Прямые и ломаные линии 
Для рисования прямых отрезков достаточно задать конечную и 

начальную точку, которые будут соединены прямой линией. При этом 
формирование каждой следующей точки будет автоматически создавать еще 
один отрезок, образующий с предыдущим ломаную линию. 

Выберите инструмент Pen, щелкните в первой точке контура, затем во 
второй и т.д. — будут созданы несколько опорных точек, которые программа 
автоматически соединит отрезками прямых. Перед созданием первой точки у 
значка маркера мыши автоматически появляется крестик, который означает, 
что вы начинаете рисовать новый контур, а отсутствие крестика говорит о 
продолжении начатого контура. Для завершения контура следует вновь 
щелкнуть на инструменте Pen в палитре инструментов или при нажатой 
клавише Ctrl щелкнуть левой кнопкой мыши в стороне от контура — при 
этом рядом с указателем вновь появится крестик, сигнализирующий о том, 
что можно начинать новый контур. 

Для рисования строго вертикальных или горизонтальных линий либо 
линий, лежащих под углом 45°, следует создавать новые опорные точки при 
нажатой клавише Shift. При этом Illustrator в зависимости от положения 
новой опорной точки самостоятельно решает, какую из перечисленных 
линий вы хотели провести. 

В случае создания замкнутого контура поставьте последнюю точку 
точно на месте первой точки контура — контур при этом автоматически 
заканчивается, и потом можно сразу приступать к рисованию следующего. 
Определить, удачно ли вы установили маркер, можно по его внешнему виду: 
при попадании маркера точно на первую опорную точку рядом с ним 
появляется значок окружности, символизирующий завершение контура. 

Гладкие кривые 
При рисовании кривой Безье инструментом Pen (как и при создании 

отрезка) задаются конечные точки и дополнительно определяются 
направление касательной и радиус кривизны, в результате чего точки 
соединяются не прямой, а кривой линией. 

Если необходимо, чтобы линия была строго вертикальной, 
горизонтальной или под углом 45°, то перемещайте мышь, удерживая 
клавишу Shift. 

Получить строго вертикальную, горизонтальную или находящуюся под 
углом 45° направляющую линию можно, если при перемещении мыши 
удерживать клавишу Shift. 

Затем нужно сформировать следующий участок кривой, поставив 
очередную опорную точку и получив желаемый сегмент и т.д.  

Выделение сегментов и контуров 
Для выделения отдельного сегмента кривой можно воспользоваться 

инструментом Direct Selection (Частичное выделение), щелкнув на нужном 
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сегменте или на опорной точке. В зависимости от типа сегмента или контура 
и места щелчка окажутся выделенными либо все опорные точки контура, 
либо только управляющие точки и линии сегмента, либо вообще ничего. 

Изменение типа опорных точек 
Нарисуйте произвольный контур в виде замкнутой ломаной линии и 

попробуйте превратить его в криволинейный. Для этого подведите указатель 
мыши к одной из опорных точек и нажмите клавишу Alt — после этого 
указатель мыши примет вид черной жирной стрелки, затем щелкните в 
опорной точке (опорная точка из угловой превратится в гладкую) и 
переместите ее подходящим образом. Точно такого же результата можно 
достичь и без нажатия клавиши Alt, но тогда следует обратиться к палитре 
инструментов, выбрать инструмент Convert Anchor Point (угол) и проделать 
те же манипуляции по превращению угловой опорной точки в гладкую и по 
ее перемещению. 

Создание новых опорных точек 
Новые опорные точки не сложно создать с помощью инструмента Add 

Anchor Point (Перо+). Для примера щелкните им в любой части только что 
полученного криволинейного сегмента, что приведет к появлению новой 
опорной точки и двух ее направляющих. 

Затем измените кривизну контура, перетащив созданную опорную точку 
при нажатой клавише Alt. Таким образом, добавляя новые опорные точки, 
изменяя их типы и тут же перемещая точки и меняя степень кривизны 
сегментов, можно в считанные секунды до неузнаваемости преобразить 
исходный контур. 

Если же необходимо добавить опорную точку точно в центр между 
двумя выделенными опорными точками, лучше воспользоваться 
командой Object=>Path=>Add Anchor Points(Объект=>Контур=>Добавить 
опорные точки). 

Перемещение опорных и направляющих точек 
Можно изменить форму контура, перетащив выделенные точки 

(опорные или направляющие) с помощью клавиш «стрелка влево», «стрелка 
вправо», «стрелка вверх» или «стрелка вниз» или мышью, предварительно 
активировав инструмент Direct Selection. А можно обойтись и без выбора 
инструмента Direct Selection: если в процессе перемещения удерживать 
клавишу Ctrl, то результат окажется тот же. 

Не пугайтесь, все это проще делать, чем описывать. Практикуйтесь 
сразу на реальных работах. Во-первых, это имеет практическую пользу, а во-
вторых, лучше откладывается в памяти. И всегда следите за соблюдением 
двух принципов: 

1. Не ставьте лишних точек. Не стройте 2 примитива там, где 
можно обойтись одним. Любая лишняя точка ухудшает плавность кривой, 
создает паразитные искажения и снижает редактопригодность пути. Кроме 
того, это лишние движения мышкой и отнятое у вас время. 
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2. Не жадничайте — ставьте точку, если она нужна. Если участок 
контура невозможно передать одним примитивом, разбей его на несколько. 

Именно этим хороший путь отличается от посредственного или просто 
плохого. 

Инструмент Reshape (Форма).  
Если щелкнуть инструментом Reshape (Форма) на сегменте, то 

образуется новая выделенная опорная точка, которая также может служить 
основой при перемещении. Таких опорных точек, которые не изменяют 
своего расположения относительного друг друга, может быть 
неограниченное количество. Новые опорные точки добавляются в число 
выделенных при нажатой клавише Shift или с помощью рамки выделения.  

Перемещение опорной точки (или точек) вызывает перемещение всех 
опорных точек, выделенных обычным способом, пропорционально 
расстоянию до опорной точки.  

Инструмент Scissors (Ножницы).  
Разбиение контура означает получение из одной опорной точки двух 

точек, независимых друг от друга. Эту операцию можно осуществить с 
помощью инструментов Scissors (Ножницы) и Knife (Нож).  

Для этого необходимо включить инструмент и щелкнуть в месте 
предполагаемого разрыва. Если разрыв попал в пределы сегмента, то 
образуются две новых опорных точки, расположенных одна на другой. Если 
разрыв производился на имеющейся уже опорной точке, то над ней 
добавляется новая.  

Инструмент Knife.  
Разбить объект можно с помощью инструмента Knife (Нож). Для этого 

необходимо включить инструмент и протянуть над объектом или группой 
объектов линию предполагаемого разбиения. Если требуется разбиение по 
прямой линии, то следует удерживать нажатой клавишу Alt.  

Выравнивание опорных точек.  
Достаточно часто возникает проблема расположения опорных точек 

контура строго по горизонтали или строго по вертикали. Этого можно 
добиться, если при рисовании сегментов контуров удерживать клавишу Shift.  

Для того чтобы добиться того же результата в уже имеющемся контуре, 
необходимо использовать команду Average (Усреднить) меню Object / Path 
(Объект / Контур), которая выводит на экран одноименное диалоговое окно.  

Для того чтобы выровнять определенные опорные точки по горизонтали 
или по вертикали, их необходимо выделить с помощью инструмента Direct 
Selection (Частичное выделение) или использовать команду Average 
(Усреднить).  

 В диалоговом окне Average (Усреднить) следует установить один из 
трех переключателей в группе Axis (Оси):  

o   Horizontal (Горизонтальная) — обеспечивает выравнивание по 
горизонтали;  
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o   Vertical (Вертикальная) — обеспечивает выравнивание по 
вертикали;  

o   Both (Обе) — обеспечивает выравнивание по обеим осям 
одновременно.  

Соединение краевых опорных точек.  
Открытый контур имеет две концевых опорных точки — начальную и 

конечную, а у закрытого контура таких точек нет. Для преобразования 
открытого контура в закрытый служит команда Join (Соединить) меню Object 
| Path (Объект | Контур).  

o Если соединяемые крайние точки совпадают друг с другом по 
местоположению (одна расположена на другой), то они заменяются на одну 
общую опорную точку.  

o  Если же краевые точки расположены на определенном 
расстоянии друг от друга, то между ними создается дополнительный 
соединительный сегмент.  

Для соединения двух краевых точек их необходимо выделить с 
помощью инструмента Direct Selection (Частичное выделение) и выбрать 
команду Join (Соединить).  

Установка в группе Points (Точка) переключателя Corner (Угловая) 
(принимается по умолчанию) обеспечивает создание угловой опорной точки, 
а переключателя Smooth (Гладкая) — гладкой опорной точки.  

 
 
 
 

ТЕМА 6. ТИПОГРАФИКА. ШРИФТЫ. РАБОТА С ТЕКСТОВОЙ 
ИНФОРМАЦИЕЙ 

Инструменты для работы с текстом. Создание и размещение текста. 
Заголовочный текст. Блочный текст. Форматирование текста: палитра 
Символ, палитра Абзац. Работа с избыточным текстом. Создание текста в 
области. Создание текста по закрытому и открытому контуру. 
Преобразование текста в кривые. Стили символов и абзацев. 

 
Цель:  
- освоить инструменты работы с текстом  
- изучить способы создания заголовочного и блочного текста 
- познакомить учащихся с созданием связанных текстовых блоков 
- научиться создавать текст вдоль кривой и внутри области 
- научиться переводить текст в кривые 
- развить интерес к предмету 
- воспитать дисциплинированность и целеустремленность 
План: 
- организационный момент 
- сообщение темы и цели занятия 
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- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача заданий 
Теория: 
Инструменты для работы с текстом. Создание и размещение текста. 

Заголовочный текст. Блочный текст.  
Связанные текстовые блоки и перетекание текста. Работа с избыточным 

текстом. 
Форматирование текста: палитра Символ, палитра Абзац. Создание 

текста в области. Создание текста по закрытому и открытому контуру. 
Преобразование текста в кривые. Стили символов и абзацев. 

Практика: 
- набор заголовочного текста 
- набор блочного текста 
- создание связанных текстовых блоков 
- работа с избыточным текстом 
- отрисовка леттеринга 
Самостоятельная работа: 
- Создать макет визитки 
- Промежуточный тест 

КРАТКИЙ КОНСПЕКТ 
 
Ввод текста в точке  
Текст из точки представляет собой горизонтальную или вертикальную 

строку текста с началом в месте щелчка, которая увеличивается по мере 
ввода символов. Каждая строка текста является независимой – текст 
удлиняется или сокращается при редактировании, но не переходит на 
следующую строку. Ввод текста таким способом удобен для добавления к 
иллюстрации нескольких слов. 

1. Выберите инструмент «Текст»  или «Вертикальный текст» . 
Курсор примет I-образную форму внутри пунктирного прямоугольника. 

Маленькая горизонтальная линия в нижней части I-образного курсора 
соответствует положению базовой линии текста. 

2. (Необязательно) Задайте параметры форматирования текста на 
панели «Управление», палитре «Символ» или «Абзац». 

3. Щелкните в том месте, где должен начинаться текст. 
Примечание.  
Не щелкайте по существующему объекту, иначе он будет преобразован 

в область текста или контур для текста. Если в месте ввода расположен 
объект, закрепите или скройте его. 

4. Введите текст. Нажмите клавишу «Ввод», чтобы начать новую 
строку в этом же текстовом объекте. 
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5. Закончив ввод текста, выделите текстовый объект с помощью 
инструмента «Выделение» . Или щелкните текст с нажатой клавишей 
«Ctrl». 

Ввод текста в область  
Текст в области (называемый также текстом в абзаце) использует 

границы объекта, чтобы управлять размещением символов по горизонтали 
или вертикали. Когда текст достигает границы, он автоматически 
переносится, чтобы уместиться в заданной области. Ввод текста таким 
способом удобен, если нужно создать один или несколько абзацев (например, 
при подготовке брошюры). 

1. Определите ограничительную рамку: 
o Выберите инструмент «Текст»  или «Вертикальный текст»  

и перетащите курсор по диагонали для определения прямоугольной 
ограничительной области. 

o Нарисуйте объект, который будет использоваться в качестве 
ограничительной рамки (наличие у объекта атрибутов обводки или заливки 
значения не имеет, так как Illustrator их автоматически удаляет). Затем 
выберите инструмент «Тест» , «Вертикальный текст» , «Текст в 
области»  или «Вертикальный текст в области»  и щелкните на контуре 
объекта. 

Если введенный текст не умещается в пределах области, рядом с нижней 
частью ограничивающей области появляется значок «плюс» (+). 

Для отображения неуместившегося текста можно изменить размер 
текстовой области или удлинить контур. Также можно связать несколько 
текстовых блоков. 

Изменение размера области текста  
Изменить размер текстового поля можно разными способами, в 

зависимости от того, создаете ли вы текст из точки, текст в области или текст 
по контуру. 

Ограничения на объем текста из точки, который можно ввести, не 
существует, поэтому изменение размера текстового поля в этом случае не 
требуется. 

При использовании инструмента «Текст в области» требуется выбрать 
объект, перетащив инструмент, и ввести внутри области нужный текст. В 
этом случае размер текстового поля изменяется при изменении размера 
объекта с помощью инструмента «Частичное выделение». 

Если при вводе текста по контуру текст не вмещается на выбранный 
контур, можно набрать связанный текст на нескольких объектах. В этом 
случае размер текстового поля также изменяется при изменении размера 
контура с помощью инструмента «Частичное выделение». 

Убедитесь, что параметр «Показать ограничительную рамку» 
установлен. Если ограничительная рамка не отображается, нажмите 
«Просмотр» > «Показать ограничительную рамку». 
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• Чтобы изменить размер текстовой области, выполните одно из 
следующих действий: 

o Используя инструмент «Выделение» или палитру «Слои», 
выделите текстовый объект и перетащите маркер на ограничительной рамке. 

Изменение размера текстовой области с помощью инструмента 
«Выделение»  

o Используя инструмент «Частичное выделение» , выделите край 
или угол текстового контура. Затем перетащите его, чтобы изменить форму 
контура. 

Совет. Изменение текстового контура с помощью инструмента 
«Частичное выделение» — самый простой способ, если объект 
отображается в виде контуров. 

Изменение размера текстовой области с помощью инструмента 
«Частичное выделение»  

o Используя инструмент «Выделение» или палитру «Слои», 
выделите текстовый объект, а затем выберите команду «Текст» > 
«Параметры текста в области». Введите значения ширины и высоты и 
нажмите кнопку «ОК». Если форма текстовой области не прямоугольная, эти 
значения определяют размеры ограничительной рамки объекта. 

Изменение поля вокруг текстовой области  
При работе с текстом в области можно изменять размер поля между 

текстом и ограничительным контуром. Это поле называют отступом. 
1. Выберите объект с текстом в области. 
2. Выберите команду «Текст» > «Параметры текста в области». 
3. Введите значение в поле «Отступ» и нажмите кнопку «ОК». 
Текст без отступа (слева) и текст с отступом (справа)  
Создание строк и столбцов текста  
1. Выберите объект с текстом в области. 
2. Выберите команду «Текст» > «Параметры текста в области». 
3. В разделах «Ряды» и «Колонки» задайте следующие параметры. 
Количество 
Определяет количество строк и столбцов объекта. 
Размер 
Определяет высоту отдельных строк и ширину отдельных столбцов. 
Разгонка заголовка по всей ширине текстовой области  
1. Выберите инструмент «Текст» и щелкните абзац, который нужно 

разогнать в текстовой области. 
2. Выберите команду «Текст» > «Разогнать заголовок». 
Примечание.  
Если изменить форматирование текста, нужно будет снова применить 

команду «Разогнать заголовок». 
Связывание текста между объектами  
Чтобы продолжить текст из одного объекта в следующем объекте, 

объекты необходимо связать. Связанные текстовые объекты могут иметь 
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любую форму, однако текст необходимо вводить в область или по контуру 
(не в точке). 

У каждого объекта «Текст в области» есть входной порт и выходной 
порт, позволяющие связывать эти объекты с другими объектами и создавать 
связанную копию текстовых объектов. Пустой порт указывает, что 
отображается весь текст и что объект не связан. Стрелка в порте указывает на 
связь с другим объектом. Красный значок «плюс» в выходном порте 
указывает на наличие в объекте дополнительного текста. Такой оставшийся 
невидимым текст называется переполнением текста. 

Можно разорвать связи, чтобы перенести текст в первый или 
следующий объект, а можно удалить все связи и оставить текст на месте. 

Примечание.  
При работе со связанным текстом бывает полезно видеть связи. Чтобы 

просмотреть связи, выберите команду «Просмотр» > «Показать связи 
текстовых блоков», а затем выберите связанный объект. 

Связь текста  
1. Выделите текстовую область инструментом «Выделение». 
2. Щелкните входной или выходной порт выбранного текстового 

объекта. Курсор преобразуется в значок загруженного текста . 
3. Выполните одно из следующих действий: 
o Чтобы установить связь с существующим объектом, наведите 

курсор на контур объекта. Вид курсора изменится на . Щелкните контур 
для связи объектов. 

o Чтобы установить связь с новым объектом, щелкните или 
перетащите курсор на пустое место в монтажной области. При щелчке 
создается объект того же размера и формы, что и исходный; перетаскивание 
позволяет создать прямоугольный объект любого размера. 

Другой способ связывания текста между объектами таков: выберите 
текстовую область и объекты для связи, затем выберите команду «Текст» > 
«Связанные текстовые блоки» > «Связать». 

Удаление или разрыв связей  
1. Выделите связанный текстовый объект. 
2. Выполните любое из следующих действий: 
o Чтобы разорвать связи между двумя объектами, дважды 

щелкните порт на любом конце связи. Текст будет перенесен в первый 
объект. 

o Чтобы исключить объект из связанных текстовых блоков, 
выберите команду «Текст» > «Связанные текстовые блоки» > «Исключить 
выделенные». Текст будет перенесен в следующий объект. 

o Чтобы удалить все связи, выберите команду «Текст» > 
«Связанные текстовые блоки» > «Удалить связь текстовых блоков». Текст 
останется на месте. 

Обтекание текстом вокруг объекта  
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Текст в области может обтекать любой объект, включая текстовые 
объекты, импортированные изображения и объекты, нарисованные в 
Illustrator. Если объектом обтекания является встроенное растровое 
изображение, Illustrator выполняет обтекание текстом вокруг непрозрачных 
или частично прозрачных пикселов и игнорирует полностью прозрачные 
пикселы. 

Обтекание определяется порядком размещения объектов, который 
можно просмотреть в палитре «Слои», щелкнув треугольник рядом с именем 
слоя. Для обтекания текстом вокруг объекта объект должен находиться в том 
же слое, что и текст, и располагаться непосредственно над текстом в 
иерархии слоя. Иерархию можно изменить, перетаскивая объекты вверх или 
вниз в палитре «Слои». 

Обтекание текстом  
1. Убедитесь, что для обтекания текстом выполнены следующие 

условия: 
o Текст введен в области (в текстовом поле). 
o Текст находится в том же слое, что и объект обтекания. 
o В иерархии слоя текст расположен прямо под объектом 

обтекания. 
Примечание.  
Если слой содержит несколько текстовых объектов, переместите 

текстовые объекты, которые не будут участвовать в обтекании, в другие слои 
или выше объекта обтекания. 

2. Выберите объект или объекты, вокруг которых будет выполнено 
обтекание текстом. 

3. Выберите команду «Объект» > «Обтекание текстом» > 
«Создать». 

Установка параметров обтекания  
Параметры обтекания можно задать до или после обтекания текстом. 
1. Выделите объект обтекания. 
2. Выберите команду «Объект» > «Обтекание текстом» > 

«Параметры обтекания текстом» и задайте следующие параметры: 
Отступы 
Задает расстояние между текстом и объектом обтекания. Можно ввести 

положительное или отрицательное значение. 
Инвертировать обтекание 
Выполняет обтекание текстом вокруг обратной стороны объекта. 
Отмена обтекания текстом вокруг объекта  
1. Выделите объект обтекания. 
2. Выберите команду «Объект» > «Обтекание текстом» > 

«Освободить». 
Выравнивание текста по объекту  
Чтобы выровнять текст по ограничительной рамке текущих глифов, а не 

метрик шрифтов, выполните следующие действия: 
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1. Примените интерактивный эффект «Контурный объект» к 
текстовому объекту используя команду «Эффект» > «Контур» > «Контурный 
объект». 

2. Задайте использование границ просмотра в палитре 
«Выравнивание», установив флажок для параметра «Использовать границы 
просмотра» во всплывающем меню палитры. 

После применения этих настроек выполняется выравнивание, 
аналогичное выравниванию контурного текста, интерактивность текста при 
этом сохраняется. 

Удаление пустых текстовых объектов из изображения  
Удаление неиспользуемых текстовых объектов упрощает процесс 

печати изображения и уменьшает размер файла. Создать пустые текстовые 
объекты можно, если, например, случайно щелкнуть инструментом «Текст» в 
области изображения, а затем выбрать другой инструмент. 

1. Выберите команду «Объект» > «Контур» > «Вычистить». 
2. Выберите параметр «Пустые текстовые контуры» и нажмите 

кнопку «ОК». 
Выбор текста  
Выделение символов позволяет их редактировать, форматировать с 

помощью палитры «Символ», применять к ним атрибуты заливки и обводки 
и изменять их прозрачность. Такие изменения можно применять к одному 
символу, диапазону символов или ко всем символам в текстовом объекте. 
Если выделены символы, они подсвечиваются в окне документа, а в палитре 
«Оформление» отображается слово «Символы». 

Выделение текстового объекта позволяет применять глобальные 
параметры форматирования ко всем символам объекта, включая параметры в 
палитрах «Символ» и «Абзац», атрибуты заливки и обводки и настройки 
прозрачности. Кроме того, к выбранному текстовому объекту можно 
применять эффекты, различные заливки и обводки, а также непрозрачные 
маски. (Это невозможно сделать для отдельно выбранных символов). Если 
выделен текстовый объект, в окне документа вокруг него появляется 
ограничительная рамка, а в палитре «Оформление» отображается слово 
«Текст». 

Выделение контура текста позволяет изменить его форму и применить к 
нему атрибуты заливки и обводки. Такой уровень выделения недоступен для 
текста из точки. Если выделен контур текста, в палитре «Оформление» 
отображается слово «Контур». 

Выделение символов  
• Выберите любой инструмент для работы с текстом и выполните одно 

из следующих действий: 
o Перетащите курсор, чтобы выделить один или несколько 

символов. Перетащите курсор с нажатой клавишей «Shift» для увеличения 
или уменьшения выделенной области. 
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o Установите курсор на слове и двойным щелчком выделите это 
слово. 

o Установите курсор на абзаце и тройным щелчком выделите весь 
абзац. 

o Выделите один или несколько символов и выберите команду 
«Выделение» > «Все» – будут выделены все символы в текстовом объекте. 

Выделение текстовых объектов  
Выделение текстового объекта позволяет применять глобальные 

параметры форматирования ко всем символам объекта, включая параметры в 
палитрах «Символ» и «Абзац», атрибуты заливки и обводки и настройки 
прозрачности. Кроме того, к выбранному текстовому объекту можно 
применять эффекты, различные заливки и обводки, а также непрозрачные 
маски. (Это невозможно сделать для отдельно выбранных символов). Если 
выделен текстовый объект, в окне документа вокруг него появляется 
ограничительная рамка, а в палитре «Оформление» отображается слово 
«Текст». 

• Выполните любое из следующих действий: 
o В окне документа щелкните текст с помощью инструмента 

«Выделение»  или «Частичное выделение» . Чтобы выбрать 
дополнительные текстовые объекты, щелкните их с нажатой клавишей 
«Shift». 

o В палитре «Слои» найдите текстовый объект, который нужно 
выделить, и щелкните его правый край (между целевой кнопкой и полосой 
прокрутки). Чтобы добавить или удалить объекты из выделенного набора в 
палитре «Слои», щелкните правый край этих объектов с нажатой клавишей 
«Shift». 

o Чтобы выделить все текстовые объекты в документе, выберите 
команду «Выделение» > «По типу объектов» > «Текстовые объекты». 

Выделение контура текста  
Выделение контура текста позволяет изменить его форму и применить к 

нему атрибуты заливки и обводки. Такой уровень выделения недоступен для 
текста из точки. Если выделен контур текста, в палитре «Оформление» 
отображается слово «Контур». 

Выделить контур текста проще всего в режиме отображения контуров. 
1. Выберите инструмент «Частичное выделение»  или «Групповое 

выделение» . 
2. Если текстовый объект выделен, щелкните за пределами его 

ограничительной рамки, чтобы отменить выделение. 
3. Щелкните контур текста, при этом постарайтесь не щелкать 

символы. (Если щелкнуть символ, вместо контура будет выделен текстовый 
объект.) 

Изменение цвета и оформления символов  
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Можно изменить цвет и оформление текстовых объектов, применяя к 
ним заливки, обводки, параметры прозрачности, эффекты и стили графики. 
Текст остается редактируемым, пока он не растрирован. 

1. Выполните одно из следующих действий: 
o Чтобы изменить оформление отдельных символов в текстовом 

объекте, выделите эти символы. 
o Чтобы изменить оформление всех символов текстового объекта 

или применить несколько заливок и обводок, выделите текстовый объект. 
o Чтобы добавить заливку или обводку в контур текста, выделите 

контур. 
2. Примените заливки, обводки, параметры прозрачности, эффекты 

и графические стили. 
При изменении цвета текстового объекта Illustrator перезаписывает 

атрибуты отдельных символов в текстовом объекте. 
Для быстрого изменения цвета выбранного объекта используйте панель 

«Управление». 
Обзор палитры «Символ»  
Палитра «Символ» («Окно» > «Текст» > «Символ») используется для 

применения параметров форматирования к отдельным символам в 
документах. Если выделен текст или активен инструмент «Текст», для 
форматирования символов также можно использовать параметры на панели 
«Управление». 

По умолчанию в палитре «Символ» видны только наиболее часто 
используемые параметры. Чтобы вывести все параметры, выберите в меню 
параметров команду «Показать параметры». Также можно щелкать двойной 
треугольник на вкладке палитры, чтобы циклически переходить от одного 
размера отображения к другому. 

Подчеркивание и перечеркивание текста  
1. Выделите текст, который надо подчеркнуть или перечеркнуть. 

Если текст не выделен, параметр применяется к новому тексту. 
2. Выполните одно из следующих действий: 
o Чтобы подчеркнуть текст, нажмите кнопку «Подчеркнутый» в 

палитре «Символ». 
o Чтобы перечеркнуть текст, нажмите кнопку «Перечеркнутый» в 

палитре «Символ». 
Толщина линии подчеркивания и перечеркивания по умолчанию зависит 

от кегля шрифта. 
Преобразование текста в кривые  
Можно превратить текст в набор сложных контуров (кривых), 

редактирование и другая обработка которых осуществляется аналогично 
работе с любыми другим графическими объектами. Текст в виде кривых 
удобно использовать для изменения внешнего вида крупного выделенного 
шрифта. При работе с основным текстом или другим типом текста, 
набранного шрифтом малого размера, этот способ применяется редко. 
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Информация о кривых, образующих символы шрифта, содержится в 
файлах шрифтов, установленных на компьютере. При создании кривых из 
текста символы преобразуются в текущих позициях с сохранением всех 
параметров графического форматирования, таких как обводка и заливка. 

Примечание.  
В кривые не могут быть преобразованы растровые шрифты, а также 

шрифты, защищенные от такого преобразования. 
При преобразовании шрифта в кривые утрачиваются контрольные 

точки – инструкции по корректировке формы, встроенные в шрифты и 
позволяющие системе оптимизировать отображение и печать текста в 
широком диапазоне размеров. Если планируется изменение размера шрифта, 
это следует сделать перед преобразованием. 

Преобразованию подлежит весь текст в выделенной области. 
Преобразовать одну букву из строки текста невозможно. Чтобы 
преобразовать в кривые одиночную букву, нужно создать отдельный 
текстовый объект, содержащий только эту букву. 

1. Выделите текстовый объект. 
2. Выберите команду «Текст» > «Создать кривые». 
 

 
ТЕМА 7. ГРУППИРОВКА И УПОРЯДОЧИВАНИЕ ГРАФИЧЕСКИХ 

ОБЪЕКТОВ. ВЫРАВНИВАНИЕ И РАСПРЕДЕЛЕНИЕ ОБЪЕКТОВ 
Порядок следования. Изменение порядка наложения объектов. Скрытие 

объектов. Закрепление объектов. Группировка объектов. Работа с группами. 
Вложенные группы. Добавление в группу. Работа в режиме изоляции. 
Инструмент выделения в группе. Палитра Выравнивание. Выравнивание 
объектов относительно друг друга. Выравнивание по ключевому объекту. 
Выравнивание по монтажной области. Распределение объектов.  

 
Цель:  
- познакомиться с режимами создания объектов 
- научиться изменять порядок следования объектов, группировать 

объекты 
- изучить режим изоляции и инструмент «Групповое выделение» 
- освоить работу с множеством объектов  
- изучить способы выравнивания и распределения объектов в документе 
- познакомить учащихся с палитрой Выравнивание 
- научиться распределять объекты на определенном расстоянии друг от 

друга 
- развить интерес к предмету 
- воспитать дисциплинированность и целеустремленность 
План: 
- организационный момент 
- сообщение темы и цели занятия 

40 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача заданий 
Теория: 
Порядок следования объектов. Группировка и разгруппировав объектов.  
Инструмент Групповое выделение. Добавление объектов в группу. 

Режим изоляции.  
Скрытие и закрепление объектов командами Скрыть и Заблокировать в 

меню Объект.  
Инструменты для выравнивания и распределения объектов. Палитра 

Выравнивание. Выравнивание объектов относительно друг друга. 
Выравнивание по ключевому объекту. Выравнивание по монтажной области. 
Распределение объектов. Распределение объектов с заданными 
промежутками. 

Практика: 
- работа группами объектов  
- группировка и разгруппировка 
- работа в режиме изоляции 
- скрытие и закрепление объектов 
- создание городского пейзажа. 
 

КРАТКИЙ КОНСПЕКТ 
 

Группировка объектов  
В процессе работы удачно найденные сочетания объектов разумно 

объединять в группу с тем, чтобы оградить от возможных случайных 
сдвигов, а также для удобства дальнейших комбинационных построений. 
Ведь, как известно, в хорошей композиции все держится на очень точных 
расчетах взаимного расположения объектов и их масштабного 
взаимодействия.  

Объединение объектов в группу позволяет обращаться с ней как с 
отдельным объектом. Все индивидуальные объекты, входящие в группу, 
подчиняются всем действиям и операциям, применяемым к группе.  

Например, все элементы фирменного знака, соединенные в группу, 
можно легко перемещать, масштабировать, вращать и выполнять с ними все 
мыслимые операции, не заботясь о том, что какой-либо объект случайно 
окажется вне воздействия (эта ситуация возможна, когда объекты, входящие 
в фирменный знак, выбираются последовательно или при помощи 
штриховой рамки — какой-нибудь объект может остаться невыделенным и к 
нему не будут применены операции).  

Для того чтобы поместить совокупность объектов в группу, их 
необходимо выделить и выполнить команду Group (Сгруппировать) меню 
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Object (Объект). Для обратной операции предназначена команда Ungroup 
(Разгруппировать) того же меню.  

Группа может быть "вложенной", т. е. иметь определенную иерархию. В 
этом заключается великолепная возможность строить композицию из 
отдельных законченных совокупностей объектов, которые постепенно, по 
мере необходимости, включаются в группу. Разгруппировка вложенной 
группы осуществляется в обратном порядке и требует столько же этапов, 
сколько и ее создание.  

Инструмент Selection (Выделение) ( ) выделяет всю группу в 
независимости от того, на каком из объектов произведен щелчок. К 
сожалению, никакой информации о количестве объектов в группе не 
отображается.  

Работа с отдельными объектами группы  
Помещение объекта в группу отнюдь не означает его полное и 

окончательное "поглощение коллективом", любой объект в любой момент 
может быть выделен и подвергнут трансформации.  

Для выделения объекта в составе группы (иерархия не играет роли) 
следует использовать инструмент Direct Selection (Частичное выделение) ( 
).  

Если объекты, которые требуется выделить, являются "вложенной" 
группой, то в этом случае применяется инструмент Group Selection 
(Выделение в группе) ( ), причем каждый новый щелчок добавляет 
объекты следующего уровня иерархии 

Группировка объектов в "стопке"  
При группировке объектов следует учесть, что наилучшим вариантом 

при этом является следование этих объектов в "стопке", ибо в противном 
случае их порядок может измениться и тем самым изменится общая картина.  

Объекты, которые помещаются в группу, "подтягиваются" к объекту, 
занимающему самое верхнее положение. Если между этими объектами 
расположены другие объекты, которые не предназначены для помещения в 
группу, то они перемещаются ниже самого нижнего объекта, включаемого в 
группу. Эта ситуация может иметь негативные последствия для объектов, 
перекрывающих друг друга 

Выравнивание и размещение объектов по горизонтали и по вертикали  
В практике графического дизайна постоянно требуется выравнивать 

объекты по одной линии или размещать их на равном расстоянии друг от 
друга. Облегчить эту достаточно рутинную и нудную операцию помогает 
палитра Align (Выравнивание), которая отображается на экране одноименной 
командой меню Window (Окно).  

В этой палитре в ряду Align Objects (Выровнять объекты) представлены 
следующие кнопки (слева направо), которые позволяют выравнивать 
выделенные объекты:  

•  по правому краю;   
•  по верхнему краю;  
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•  по горизонтальному центру;  
•  по вертикальному центру;  
•  по левому краю;  
•   по нижнему краю.  
В ряду Distribute Objects (Распределить объекты) представлены кнопки, 

которые позволяют размещать выделенные объекты:  
•  по равным расстояниям между верхними краями;  
•  между горизонтальными центрами;  
•  между нижними краями;  
•  между правыми краями;  
•  между вертикальными центрами;  
•  между левыми краями.  
В ряду Distribute Spacing (Распределить с равными промежутками) 

представлены кнопки, которые позволяют обеспечить одинаковые 
расстояния между объектами по вертикали и по горизонтали. Кнопки 
работают таким образом, если в списке справа выбран вариант Auto 
(Автоматически). А если выбрано какое-либо Цифровое значение, то 
объекты раздвигают на это расстояние друг друга, начиная с исходного, на 
котором необходимо дополнительно щелкнуть инструментом Selection 
(Выделение) ( ).  

Если кнопки нижнего ряда отсутствуют, следует выполнить команду 
Show Options (Показать дополнительные поля) меню палитры, которая 
открывается щелчком на треугольной стрелке в верхней части палитры.  

Для выравнивания объектов приняты следующие правила:  
•  если объекты выделяются последовательно (с помощью клавиши 

<Shift>), то выравнивание происходит по последнему выделенному объекту;  
•  если объекты были выделены с помощью штриховой рамки, то 

выравнивание происходит по тому объекту, расположение которого 
совпадает с кнопкой (например, выравнивание по правому краю будет 
осуществляться по правому краю самого правого объекта и т. д.). 

  
 

ТЕМА 8. СОЗДАНИЕ СЛОЖНЫХ ФОРМ ИЗ ПРОСТЫХ. 
ИНСТРУМЕНТЫ ДЕФОРМАЦИИ. ТРАНСФОРМАЦИЯ ОБЪЕКТОВ 

 
Комбинирование и редактирование фигур. Палитра Обработка контуров. 

Объединение, пересекание, вычитание и исключение контуров. Работа с 
инструментом Создание форм. Инструменты деформации объектов. 
Инструмент Переход. Поворот и масштабирование габаритного контейнера. 
Трансформация объекта командами меню Трансформация: перемещение, 
масштабирование, поворот, наклон, зеркальное отражение. Применение 
нескольких преобразований. Меню Трансформирование. Инструмент 
Свободная трансформация. Повтор трансформаций. 
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Цель:  
- познакомить с инструментами для построения объектов сложной 

формы. 
- научиться создавать фигуры различной формы и сложности. 
- научиться использовать палитру Pathfinder для построения 

комбинированных фигур и комбинированных контуров. 
- познакомить учащихся с инструментом Shape Builder и Blend. 
научиться работать с палитрой Трансформирование 
- познакомиться с командами в меню Объект - Трансформирование 
- научиться работать с инструментами трансформации: поворот, наклон, 

отражение, масштабирование 
- изучить инструмент Свободное трансформирование 
- развить интерес к предмету 
- воспитать дисциплинированность и целеустремленность 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача заданий 
Теория: 
Способы создания фигур в программе. Способы создания фигур и 

контуров сложной формы путем комбинирования нескольких объектов. 
Палитра Pathfinder и режимы ее работы. 

Инструмент Shape Builder, как альтернатива Pathfinder. Получение 
промежуточных форм объектов при помощи инструмента Blend. 

Инструменты деформации существующих объектов. Локальное 
изменение формы контура объекта. 

Способы трансформации объектов. Виды трансформации. 
Трансформация объектов инструментами и командами меню. 

Трансформация через палитру Трансформирование. 
Повтор трансформации. Функция Трансформировать каждый. 
Практика: 
- создать фигуры сложной формы используя палитру Pathfinder 
- создать аналогичные фигуры используя инструмент Shape Builder 
- получить промежуточную форму объектов при помощи инструмента 

Blend 
- деформировать полученные объекты инструментами деформации 
- отредактировать локально форму обводки фигур. 
- трансформация объектов через палитру Трансформирование 
- трансформация объектов через меню Объект – Трансформирование 
- трансформация объектов инструментами трансформации.  
- создание паттерна из набора животных в стиле «Плосктй дизайн» 
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КРАТКИЙ КОНСПЕКТ 

В программе Illustrator можно комбинировать векторные объекты, 
создавая фигуры разными способами. Получившиеся контуры или фигуры 
различаются в зависимости от способа комбинирования контуров. Составные 
фигуры позволяют комбинировать объекты и указывать, как каждый из них 
должен взаимодействовать с другими объектами. Составные фигуры 
являются более гибким средством, чем составные контуры, поскольку 
обеспечивают четыре способа взаимодействия: сложение, вычитание, 
пересечение и исключение. Кроме того, нижние объекты не изменяются, что 
позволяет выбирать каждый объект в составной фигуре для редактирования 
или изменения его режима взаимодействия. 

Составные контуры позволяют использовать объекты для создания 
отверстий в других объектах. Например, можно создать кольцо из двух 
вложенных кругов. После создания составного контура контуры ведут себя 
как сгруппированные объекты. Можно выбрать объекты и управлять ими по 
отдельности с помощью инструментов «Частичное выделение» или 
«Групповое выделение», а также выбрать и редактировать составной контур. 

Палитра Pathfinder (Обработка контуров), которая вызывается на экран 
одноименной командой меню Window (Окно), предназначена для 
комбинирования объектов различными способами, зачастую с образованием 
составных контуров (compound path). Своеобразие сложных контуров 
состоит в том, что пересекающиеся области двух различных контуров, 
становятся прозрачными. 

Следует учесть, что объектами для палитры Pathfinder (Обработка 
контуров) не могут служить результаты работы инструмента Gradient Mesh 
(Градиентная сетка). Кроме того, предпочтительнее использовать замкнутые 
контуры без обводок. 

Палитра Pathfinder (Обработка контуров) является очень мощным 
средством векторного формообразования, что чрезвычайно ценно для 
создания довольно сложных форм. В связи с этим можно временно не 
обращать внимания на параметры заливок и обводок. При комбинировании 
контуров с различными цветными заливками, как правило, результирующему 
объекту присваивается заливка верхнего объекта. 

Для комбинирования объектов следует разместить и выделить 
необходимые объекты, а затем нажать одну из кнопок палитры Pathfinder 
(Обработка контуров). В зависимости от выполняемой операции на экран 
может быть выведено диалоговое окно, в котором следует ввести требуемые 
дополнительные данные. У команд палитры Pathfinder (Обработка контуров) 
существует несколько общих установок, которые изменяются в диалоговом 
окне Pathfinder Options (Обработка контуров: Параметры), которое 
вызывается командой Pathfinder Options (Параметры обработки контуров) 
меню палитры. 

В этом диалоговом окне можно задать следующие параметры: 
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• В поле Precision (Точность вычислений) вводится степень точности, с 
которой команды палитры Pathfinder (Обработка контуров) выполняет 
вычисления при комбинировании выделенных объектов. Чем меньшее 
значение установлено, тем с большей точностью выполняются вычисления, 
но и тем больше времени требуется для завершения операции. Разумеется, 
здесь необходим разумный компромисс. По умолчанию принимается 
значение, равное 0,028 пунктам. 

• При установке флажка Remove Redundant Points (Удалять лишние 
точки) обеспечивается удаление любых опорных точек, которые 
расположены точно друг над другом и при комбинировании являются 
излишними. 

• При установке флажка Divide and Outline Will Remove Unpainted 
Artwork (Удалять незакрашенные объекты) удаляются все незаполненные 
объекты, получаемые в результате выполнения команд Divide (Разделение) и 
Outline (Обводка). 

• Для того чтобы повторить последнюю операцию, выполненную с 
помощью палитры Pathfinder (Обработка контуров), можно воспользоваться 
командой Repeat (Повторить) меню палитры. 

Команды палитры Pathfinder: 
1. Add to shape area (Добавление в составной объект) на панели 

комбинирует выделенные объекты таким образом, что контур 
результирующего объекта совпадает с общим периметром всех объектов. В 
предыдущих версиях эта кнопка называлась Unite (Объединение). Если 
требуется создать составной контур, следует нажать кнопку Expand 
(Преобразовать). Все объекты и детали, расположенные внутри общего 
периметра, удаляются, поэтому, если они требуются для дальнейшей работы, 
следует предварительно создать их копию. Если комбинируемые объекты не 
имеют пересечений, они все равно объединяются в единый объект с 
одинаковыми параметрами контура и заливки. Если требуется таким же 
образом объединить все контуры, входящие в группу или расположенные на 
слое (подслое), следует использовать команду Add (Добавить) меню Effect | 
Pathfinder (Эффект | Обработка контуров). Это же относится и к шрифтовым 
объектам.  

2. Subtract from shape area  (Удаление из составного объекта) 
комбинирует выделенные объекты таким образом, что контур 
результирующего объекта равняется площади самого нижнего объекта с 
вырезом площадей объектов, расположенных над ним. В предыдущих 
версиях эта кнопка называлась Minus Front (Минус верхний). Если требуется 
создать составной контур, следует нажать кнопку Expand (Преобразовать). 
Все объекты и детали, не попадающие в результирующий контур, удаляются, 
поэтому, если они требуются для дальнейшей работы, необходимо 
предварительно их скопировать. Если требуется таким же образом 
объединить все контуры, входящие в группу или расположенные на слое 
(подслое), то следует использовать команду Subtract (Удаление) меню Effect | 
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Pathfinder (Эффект | Обработка контуров). Это же относится и к шрифтовьм 
объектам. 

3. Intersect shape areas  (Пересечение составных объектов) на панели 
комбинирует выделенные объекты таким образом, что контуром 
результирующего объекта является область пересечения объектов. Если 
требуется создать составной контур, то следует нажать кнопку Expand 
(Преобразовать). Все объекты и детали, не попадающие в результирующий 
контур, удаляются, поэтому, если они необходимы для дальнейшей работы, 
следует предварительно создать их копию. Выполнение команды возможно, 
если объекты "пересекаются". Если требуется таким же образом объединить 
все контуры, входящие в группу или расположенные на слое (подслое), 
следует использовать команду Intersect (Пересечение) меню Effect | Pathfinder 
(Эффект | Обработка контуров). Это же относится к шрифтовым объектам. 

4. Exclude overlapping shape areas (Исключение пересекающихся 
областей) комбинирует выделенные объекты таким образом, что 
непересекающиеся области входят в результирующий объект, а 
пересекающиеся — "исключаются", делаются прозрачными. Однако при 
этом следует учитывать количество пересекаемых областей:  

 если их число четное, то они становятся прозрачными; 
 если их число нечетное, они включаются в объект с соответствующей 

заливкой. 
Эмпирически это правило можно трактовать следующим образом. Если 

мысленно провести линию слева направо через выделенные объекты, то с 
первого контура, который пересекла линия, начинается заливка, после 
второго контура заливка прекращается, после последующего— начинается и 
т. д.  

Если требуется создать составной контур, необходимо нажать кнопку 
Expand (Преобразовать). Все объекты и детали, не попадающие в 
результирующий контур, удаляются, поэтому, если они понадобятся для 
дальнейшей работы, следует предварительно создать их копию. 
Если необходимо таким же образом объединить все контуры, входящие в 
группу или расположенные на слое (подслое), то следует использовать 
команду Exclude (Исключение) меню Effect | Pathfinder (Эффект | Обработка 
контуров). Это же относится и к шрифтовым объектам. 

5. Divide (Разделение) на панели выполняет в некотором смысле 
противоположное действие в сравнении с комбинированием: она разбивает 
сложный объект на простые объекты. Пользователь должен заранее решить, 
удалять или сохранять объекты без заливки. Для этого предназначен флажок 
Divide and Outline Will Remove Unpainted Artwork (Удалять незакрашенные 
объекты) диалогового окна Pathfinder Options (Параметры палитры 
"Обработка контуров"). Следует обратить внимание, что команда Divide 
(Разделение) не возвращает исходные объекты, существующие до 
выполнения, например, команды Exclude (Исключение), а разбивает сложный 
объект на объекты, представляющие собой отдельные заполненные области. 
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После применения кнопки Divide (Разделение) все образуемые объекты 
остаются в группе, для свободного манипулирования отдельными объектами 
следует выполнить команду Ungroup (Разгруппировать) меню Object 
(Объект). Если необходимо таким же образом объединить все контуры, 
входящие в группу или расположенные на слое (подслое), следует 
использовать команду Divide (Разделение) меню Effect | Pathfinder (Эффект | 
Обработка контуров). Это же относится к шрифтовым объектам. 

6. Trim (Обрезка) комбинирует выделенные объекты таким образом, 
что удаляет все части объектов, которые являются скрытыми, при этом 
объекты с одинаковыми заливками не объединяются. Следует иметь в виду, 
что при этом удаляются параметры обводки. После применения кнопки Trim 
(Обрезка) все образуемые объекты остаются в группе, для свободного 
манипулирования отдельными объектами следует выполнить команду 
Ungroup (Разгруппировать) меню Object (Объект). Если необходимо таким 
же образом объединить все контуры, входящие в группу или расположенные 
на слое (подслое), следует использовать команду Trim (Обрезка) меню Effect 
| Pathfinder (Эффект | Обработка контуров). Это же относится и к шрифтовым 
объектам. 

7. Merge (Слияние) комбинирует выделенные объекты таким 
образом, что удаляет все части объектов, которые являются скрытыми, при 
этом объекты с одинаковыми заливками объединяются. Следует иметь в 
виду, что при этом удаляются параметры обводки. После применения кнопки 
Merge (Слияние) все образуемые объекты остаются в группе, для свободного 
манипулирования отдельными объектами следует выполнить команду 
Ungroup (Разгруппировать) меню Object (Объект). Если необходимо таким 
же образом объединить все контуры, входящие в группу или расположенные 
на слое (подслое), следует использовать команду Merge (Слияние) меню 
Effect | Pathfinder (Эффект | Обработка контуров). Это же относится и к 
шрифтовым объектам. 

8. Crop (Кадрирование) комбинирует выделенные объекты таким 
образом, что удаляет все части объектов, которые выходят за границы самого 
верхнего объекта. Верхний объект после применения кнопки удаляется, а все 
образуемые объекты остаются в группе. Для свободного манипулирования 
отдельными объектами необходимо выполнить команду Ungroup 
(Разгруппировать) меню Object (Объект).Следует иметь в виду, что при этом 
удаляются параметры обводки. Если необходимо таким же образом 
объединить все контуры, входящие в группу или расположенные на слое 
(подслое), следует использовать команду Crop (Кадрирование) меню Effect | 
Pathfinder (Эффект | Обработка контуров). Это же относится к шрифтовым 
объектам. 

9. Outline (Обводка) аналогична команде Divide (Разделение), 
только разбиение происходит не на закрытые объекты, а на открытые 
контуры — отдельные линии, разбиваемые в точках пересечения. 
Пользователь должен заранее решить, удалять или сохранять объекты без 
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заливки. Для этого предназначен флажок Divide and Outline Will Remove 
Unpainted Artwork (Удалять незакрашенные объекты) диалогового окна 
Pathfinder Options (Параметры палитры "Обработка контуров"). После 
применения кнопки Outline (Обводка) все образуемые контуры остаются в 
группе, для свободного манипулирования отдельными контурами следует 
выполнить команду Ungroup (Разгруппировать) меню Object (Объект). Если 
необходимо таким же образом объединить все контуры, входящие в группу 
или расположенные на слое (подслое), следует использовать команду Outline 
(Обводка) меню Effect | Pathfinder (Эффект | Обработка контуров). Это же 
относится и к шрифтовым объектам. 

10. Minus Back (Минус нижний) комбинирует выделенные объекты 
таким образом, что результирующим объектом становится самый верхний 
объект, у которого отсекается область, пересекающаяся со всеми объектами, 
расположенными ниже. Данная кнопка также сохраняет исходную заливку 
объекта. Если необходимо таким же образом объединить все контуры, 
входящие в группу или расположенные на слое (подслое), то следует 
использовать команду Minus Back (Минус нижний) меню Effect | Pathfinder 
(Эффект | Обработка контуров). Это же относится к шрифтовым объектам. 

11. Hard Mix и Soft Mix (Жесткое наложение и Мягкое наложение), 
расположенные в меню Effect | Pathfinder (Эффект | Обработка контуров), 
предназначены для управления преобразованием цветов у перекрывающихся 
объектов. Эти кнопки находят свое основное применение при подготовке 
документа к цветоделению. Команда Hard Mix (Жесткое наложение) 
преобразует цвета таким образом, что у перекрывающихся областей 
образуется цвет, составленный из цветовых компонентов с наибольшими 
значениями. Например, цвет первого объекта имеет следующие параметры: С 
(голубой) — 20%, М (пурпурный) — 66%, Y (желтый) — 40% и В (черный) 
— 0%, а цвет второго объекта такие параметры: С (голубой) — 40%, М 
(пурпурный) — 30%, Y (желтый) — 10% и В (черный) — 10%. 
Результирующий цвет, преобразованный кнопкой Hard Mix (Жесткое 
наложение), получит следующие параметры: С (голубой) — 40%, М 
(пурпурный) — 66%, Y (желтый) - 40% и В (черный) - 10%. 

Команда Soft Mix (Мягкое наложение) преобразует цвет верхнего 
объекта в области пересечения с нижележащим объектом в Полупрозрачный 
в соответствии с установкой в поле Mixing Rate (Прозрачность) диалогового 
окна Pathfinder Options (Параметры обработки контуров). Диапазон 
установки — от 1 до 100%. 

 Применение команд Hard Mix (Жесткое наложение) и Soft Mix (Мягкое 
наложение) к объектам, у которых используются составные (триадные) и 
плашечные цвета, а также различные цветовые модели, ведет к 
преобразованию их в цветовую модель CMYK. Если команда Soft Mix 
(Мягкое наложение) применяется к нескольким объектам, то качество 
полупрозрачности приобретают все объекты, кроме самого нижнего. Следует 
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иметь в виду, что использование любой из этих кнопок ведет к удалению 
параметров обводки, разбиению объектов и их последующей группировке. 

Инструмент Shape Builder (Создание форм) – очень удобный способ 
быстро и легко создавать фигуры, не прибегая к помощи панели Pathfinder. 
Клавиши быстрого вызова ‹Shift›+‹M›. 

Итак, инструмент предназначен для быстрого объединения и создания 
новых фигур. Позволяет объединять и стирать кусочки фигур, разделенные 
границами объектов. Для работы с ним необходимо выделить 
пересекающиеся объекты и навести курсор на объекты — подсветится 
область, ограниченная краями объектов. Для того, чтобы создать новый 
объект путем объединения соседних областей, нажмите левую кнопку мыши 
и «протяните» через нужные области. По мере движения мыши каждая из 
встреченных областей будут подсвечиваться. Когда выделенные области 
примут очертания фигуры, которая вам нужна, отпустите кнопку мыши. 
Результатом работы инструмента станет набор разгруппированных объектов. 

Для того, чтобы «вычесть» выделяемую область, при использовании 
инструмента держите зажатой клавишу Alt на клавиатуре. 

А чтобы обозначить объединяемые области не линией, а прямоугольной 
рамкой, удерживайте Shift на клавиатуре. 

Настройки чувствительность и отображения Shape Builder Tool можно 
изменить. Для этого дважды кликните на иконку Shape Builder Tool в панели 
инструментов. Появится диалоговое окно: 

Инструмент Adobe Illustrator Shape Builder Tool. Настройки. 
Галочка Gap Detection (Обнаружение зазоров) позволяет установить 

значение зазора, меньше которого он будет игнорироваться. 
При активации этой возможности становится доступным установка 

величины Gap Length: Small (3px), Medium (6px), Large (12px) и Custom — 
установка величины зазора вручную. 

Пример: значение Gap Length 12px, а зазоры между объектами меньше. 
Не смотря на то, что зазор виден визуально, пространство между объектами 
воспринимается как область, которая может участвовать в объединении. 

Consider Open Filled Path as Closed — считать открытый контур с 
заливкой закрытым. Если стоит эта галочка, то часть контура, которая 
отсутствует не будет восприниматься как разрыв, а будет тоже считаться 
краем объекта. 

In Merge Mode, Clicking Stroke Splits the Path — В режиме «Объединить» 
контур разделяется при щелчке по обводке в местах, где этот контур 
пересекается с ближайшими объектами. Если выбран этот параметр, то при 
щелчке на обводке контур разделится на 2 части — первая часть будет 
создана из части контура по которой кликнули, вторая — из оставшейся. Оба 
контура будут незамкнуты. 

Pick Color From — позволяет выбирать заранее цвет полученных 
объектов. Возможны два варианта: Artwork и Color Swatches. Если 
установлен Artwork, то цвет полученного объекта будет определяться цветом 
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фигуры от которой тянули линию для объединения контуров. 
В случае выбора Color Swatches выбрать цвета можно из панели Color 
Swatches. При этом лучше поставить галочку «Cursor Swatch Preview» — при 
установленной галочке можно визуально наблюдать процесс выбора цвета; 
выбирать цвет можно стрелками вправо-влево на клавиатуре. Кстати, если 
галочка не стоит, то стрелки цвет тоже меняют, только этого не видно. 

Fill — заливка. Стоит по‑умолчанию. Установка этого флажка говорит о 
том, что при наведении курсора Shape Builder Tool на область она 
подсветится серой сеткой. Если галочку снять, то области не будут 
подсвечиваться при наведении. 

Highlight Stroke when Editable — подсвечивать обводку при наведении. 
Установка этого флажка говорит о том, что при наведении курсора Shape 
Builder Tool на область ее контур подсветится цветом. По‑умолчанию это 
розовый цвет, но его можно сменить при помощи выпадающего списка Color. 
После установки всех параметров нажмите кноку «Ok» для принятия 
изменений. 

Трансформация объектов 
Трансформирование включает вращение, отражение, масштабирование и 

наклон объектов. Объекты можно преобразовывать с помощью палитры 
«Трансформирование», команд «Объект» > «Трансформировать» и 
специальных инструментов. Также можно осуществлять множество 
вариантов преобразования путем перетаскивания ограничительной рамки для 
выбора. 

Иногда, особенно при копировании объектов, может возникнуть 
необходимость повторять одно и то же преобразование несколько раз. 
Команда «Повторить трансформирование» в меню «Объект» позволяет 
повторять операции перемещения, масштабирования, поворота, отражения и 
наклона при выполнении различных операций преобразования столько раз, 
сколько необходимо. 

Для просмотра текущих размеров и положения выбранных объектов при 
преобразовании следует использовать палитру «Информация». 

Обзор палитры «Трансформирование» 
В палитре «Трансформирование» («Окно» > «Трансформирование») 

выводится информация о местоположении, размере и ориентации одного или 
нескольких выбранных объектов. Вводя новые значения, можно изменять 
выбранные объекты и их узорную заливку. Также можно изменить 
контрольную точку преобразования или зафиксировать пропорции объекта. 

Все значения в палитре относятся к ограничительным рамкам объектов, 
за исключением значений X и Y, которые относятся к выбранной 
контрольной точке. Чтобы выровнять отдельные объекты по пиксельной 
сетке, установите флажок «Выровнять по пиксельной сетке». 

Примечание. Локатор контрольной точки в палитре 
«Трансформирование» указывает на контрольную точку объекта, только если 
объект трансформируется путем изменения значений в палитре. Другие 
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методы трансформирования (например, инструмент «Масштаб») используют 
в качестве контрольной точки объекта его центральную точку или положение 
курсора. 

Преобразование узоров объекта 
При перемещении, повороте, отражении, масштабировании или наклоне 

объектов, залитых узором, можно трансформировать только объект, только 
узор или оба элемента вместе. При преобразовании заполняющего объект 
узора все узоры, позднее наложенные на этот объект, преобразуются 
одинаковым образом. 

Чтобы указать способ преобразования узора при использовании палитры 
«Трансформирование», выберите вариант из меню палитры: 
«Трансформировать только объект», «Трансформировать только узоры» или 
«Трансформировать все». 

 Указать, как преобразовать узоры при использовании команды 
трансформирования, можно с помощью флажков «Объекты» и «Узоры» в 
соответствующем диалоговом окне. Например, чтобы преобразовать узоры, 
оставив объекты неизменными, установите флажок «Узоры» и снимите 
флажок «Объекты». 

Для предотвращения трансформирования узоров при использовании 
инструментов трансформации выберите команду «Редактирование» > 
«Установки» > «Основные» (Windows) и снимите флажок «Преобразовать 
мозаику узора».Для возврата к исходному заполняющему объект узору 
выполните заливку объекта сплошным цветом и повторно выберите нужный 
узор.  

Масштабирование объектов с помощью инструмента 
«Масштабирование» 

1. Выделите один или несколько объектов. 
2. Выберите инструмент «Масштабирование» . 
3. Выполните любое из следующих действий: 
• Для масштабирования относительно центральной точки объекта 

перетаскивайте курсор в любое место окна документа, пока объект не 
достигнет требуемого размера. 

• Для масштабирования относительно другой контрольной 
точки  щелкните в том месте окна документа, где следует поместить 
контрольную точку, уберите курсор из контрольной точки и перетаскивайте 
его, пока объект не достигнет требуемого размера. 

• Для сохранения пропорций объекта при масштабировании 
удерживайте нажатой клавишу «Shift» при перетаскивании курсора по 
диагонали. 

Совет. Перетаскивайте инструмент «Масштаб», удерживая нажатой 
клавишу «Shift», под углом 45° по горизонтали или вертикали. 

• Для масштабирования объекта по одной из осей удерживайте 
нажатой клавишу «Shift» и перетаскивайте курсор по горизонтали или 
вертикали. 
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Для более точного управления масштабированием начинайте 
перетаскивание как можно дальше от контрольной точки. 

Масштабирование объектов с помощью ограничительной рамки 
1. Выделите один или несколько объектов. 
2. Выберите инструмент «Выделение» или «Свободное 

трансформирование» . 
3. Перетаскивайте маркер ограничительной рамки, пока объект не 

достигнет требуемого размера. 
Объекты масштабируются относительно противоположного маркера 

ограничительной рамки. 
4. Для управления масштабированием выполните одно из 

следующих действий: 
• Для сохранения пропорций объекта во время перетаскивания 

удерживайте нажатой клавишу «Shift». 
• Для масштабирования относительно центральной точки объекта 

во время перетаскивания удерживайте нажатой клавишу «Alt» (Windows). 
Масштабирование объектов до определенной высоты или ширины 
1. Выделите один или несколько объектов. 
2. В палитре «Трансформирование» введите новое значение в поле 

«Ширина» (Ш), «Высота» (В) или в оба поля. 
Для управления масштабированием перед вводом значения можно 

выполнить одно из следующих действий: 
• Для сохранения пропорций объекта нажмите кнопку фиксации 

пропорций . 
• Для изменения контрольной точки для масштабирования 

щелкните белый квадрат на локаторе контрольной точки . 
• Для масштабирования контура с обводкой и других эффектов, 

зависящих от масштаба, выберите в меню палитры пункт «Масштабировать 
обводки и эффекты». 

Также можно поддерживать пропорции, задав значения в полях «Ш» и 
«В» и нажав клавишу «Ctrl» (Windows). 

Масштабирование объектов с указанием масштаба в процентах 
1. Выделите один или несколько объектов. 
2. Выполните одно из следующих действий: 
• Для масштабирования относительно центра выберите команду 

«Объект» > «Трансформировать» > «Масштабирование» или дважды 
щелкните инструмент «Масштабирование» . 

• Для масштабирования относительно другой контрольной точки 
выберите инструмент «Масштабирование» и, удерживая клавишу «Alt» 
(Windows) или «Option» (Mac OS), щелкните в том месте окна документа, где 
следует поместить контрольную точку. 

3. В диалоговом окне «Масштабирование» выполните одно из 
следующих действий: 
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• Для сохранения пропорций объекта при масштабировании 
установите флажок «Равномерно» и введите процент в текстовое поле 
«Масштаб». 

• Для раздельного масштабирования по горизонтали или вертикали 
установите флажок «Неравномерно» и введите процент в поля 
«Вертикально» и «Горизонтально». 

Коэффициенты масштабирования относятся к контрольной точке и 
могут быть как положительными, так и отрицательными. 

4. Для масштабирования контуров с обводкой и других эффектов, 
зависящих от масштаба, выберите пункт «Масштабировать обводки и 
эффекты». 

5. Если объекты содержат заполняющий узор, для масштабирования 
узора установите флажок «Узоры». Снимите флажок «Объекты», если 
требуется масштабировать узоры, оставляя объекты неизменными. 

6. Нажмите кнопку «ОК» или «Копировать», чтобы повернуть 
копию объектов. 

Масштабирование нескольких объектов 
1. Выделите объекты. 
2. Выберите команду «Объект» > «Трансформировать» > 

«Трансформировать каждый». 
Примечание. 
Невозможно выбрать заказную длину при масштабировании нескольких 

объектов. Масштабировать объекты в Illustrator можно только с 
использованием процентных измерений. 

3. Установите значения в процентах для горизонтального и 
вертикального масштабирования в разделе «Масштаб» диалогового окна. 

4. Чтобы изменить контрольную точку, щелкните белый квадрат на 
локаторе контрольной точки . 

5. Нажмите кнопку «OK» или «Копировать», чтобы 
масштабировать копии объектов. 

Наклон объектов 
При наклоне объекты отклоняются относительно вертикальной или 

горизонтальной оси на указанный угол, который отсчитывается от указанной 
оси. Объекты наклоняются относительно контрольной точки, которая 
устанавливается в зависимости от выбранного метода наклона и может быть 
изменена для большинства методов. При наклоне объекта можно 
зафиксировать один из его размеров, также можно сдвинуть один объект или 
одновременно несколько объектов. 

Наклон используется для создания структуры тени. 
Наклон относительно центра (слева) и относительно заказной 

контрольной точки (справа) 
Наклон объектов с помощью инструмента «Наклон» 
1. Выделите один или несколько объектов. 
2. Выберите инструмент «Наклон» . 
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3. Выполните одно из следующих действий: 
• Для наклона относительно середины объекта перетащите курсор 

в любом месте окна документа. 
• Для наклона относительно другой контрольной точки 

 щелкните в окне документа, чтобы переместить контрольную точку, уберите 
курсор из контрольной точки и перетаскивайте его, пока объект не будет 
сдвинут нужным образом. 

• Для наклона в направлении вертикальной оси перетащите курсор 
в окне документа вверх или вниз. Чтобы сохранить исходную ширину 
объекта, нажмите и удерживайте клавишу «Shift». 

• Для наклона в направлении горизонтальной оси перетащите 
курсор в окне документа влево или вправо. Чтобы сохранить исходную 
высоту объекта, нажмите и удерживайте клавишу «Shift». 

Наклон объектов с помощью команды «Наклон» 
1. Выделите один или несколько объектов. 
2. Выполните одно из следующих действий: 
• Для сдвига относительно центра выберите команду «Объект» > 

«Трансформировать» > «Наклон» или дважды щелкните инструмент 
«Наклон» . 

• Для сдвига относительно другой контрольной точки выберите 
инструмент «Наклон» и, удерживая клавишу «Alt» (Windows) или «Option» 
(Mac OS), щелкните в том месте окна документа, где следует поместить 
контрольную точку. 

3. В диалоговом окне «Наклон» введите угол наклона от -359 до 
359. Угол наклона – это угол, на который объект отклоняется в направлении 
по часовой стрелке относительно линии, перпендикулярной к оси сдвига. 

4. Выберите ось, вдоль которой будет наклоняться объект. 
Если выбрана ось, расположенная под углом, введите значение между -

359 и 359 относительно горизонтальной оси. 
5. Если объекты содержат узорную заливку, выберите параметр 

«Узоры», чтобы переместить узор. Снимите флажок «Объекты», если 
требуется перемещать узоры, оставляя объекты неизменными. 

6. Нажмите кнопку «OK» или «Копировать», чтобы наклонить 
копии объектов. 

Наклон объекта с помощью инструмента «Свободное 
трансформирование» 

1. Выделите один или несколько объектов. 
2. Выберите инструмент «Свободное трансформирование» . 
3. Выполните одно из следующих действий: 
• Для наклона вдоль вертикальной оси объекта потяните за 

средний левый или средний правый маркер ограничительной рамки и 
удерживайте нажатой комбинацию клавиш «Ctrl»+«Alt» (Windows). Чтобы 
сохранить исходную ширину объекта, можно также нажать и удерживать 
клавишу «Shift». 
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• Для наклона вдоль горизонтальной оси объекта потяните за 
средний верхний или средний нижний маркер ограничительной рамки и 
удерживайте нажатой комбинацию клавиш «Ctrl»+«Alt» (Windows). Чтобы 
сохранить исходную высоту объекта, можно также нажать и удерживать 
клавишу «Shift». 

Наклон объектов с помощью палитры «Трансформирование» 
1. Выделите один или несколько объектов. 
2. В палитре «Трансформирование» введите значение в текстовое 

поле «Наклон». 
Для изменения контрольной точки перед вводом значения щелкните 

белый квадрат на локаторе контрольной точки . 
Можно также вызвать палитру «Трансформирование» щелкнув «X», 

«Y», «Ш» или «В» на панели «Управление».  
 
Искажение объектов 
Подвергнуть объекты искажению можно с помощью инструмента 

«Свободное трансформирование» или инструментов «Пластика». 
Используйте инструмент «Свободное трансформирование» для 
произвольного искажения объекта, а инструменты «Пластика», чтобы 
воспользоваться преимуществами заранее заданных искажений, таких как 
воронкообразное искажение, втягивание и складки. 

Искажение объектов с помощью инструмента «Свободное 
трансформирование» 

1. Выделите один или несколько объектов. 
2. Выберите инструмент «Свободное трансформирование» . 
3. Начните перетаскивание углового (не бокового) маркера 

ограничительной рамки и выполните одно из следующих действий: 
• Удерживайте нажатой клавишу «Ctrl» (Windows). 
• Удерживайте нажатыми клавиши «Shift»+«Alt»+«Ctrl» 

(Windows). 
Искажение объектов с помощью инструментов «Пластика» 
Нельзя использовать инструменты «Пластика» для работы со 

связанными файлами или объектами, содержащими текст, графику или 
символы. 

1. Выберите инструмент «Пластика», щелкните или перетаскивайте 
курсор по объекту, в который следует внести искажение. 

2. (Необязательно) Чтобы применить искажение к конкретным 
объектам, перед использованием инструмента выберите нужные объекты. 

3. (Необязательно) Чтобы изменить размер курсора инструмента и 
указать другие параметры инструмента, дважды щелкните инструмент 
«Пластика» и укажите один из параметров. 

Ширина и Высота 
Управляет размером курсора инструмента. 
Угол 
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Управляет ориентацией курсора инструмента. 
Интенсивность 
Указывает скорость изменений при искажении. Более высокие значения 

указывают на более быстрое изменение. 
Чувствительность к нажиму пера 
Вместо значения интенсивности использовать параметры ввода с 

планшета или пера. Если нет подключенного планшета, чувствительного к 
нажатию, этот параметр неактивен. 

Сложность (инструменты «Зубцы», «Кристаллизация» и «Морщины») 
Указывает, насколько близко результаты работы определенной кистью 

приближены к контурам объекта. Тесно связан со значением детализации. 
Детализация 
Определяет расстояние между точками, вводимыми в контур объекта 

(более высокое значение означает более тесное расположение точек). 
Упрощение (инструменты «Деформация», «Воронка», «Втягивание» и 

«Раздувание») 
Указывает, как много лишних точек, не влияющих значительным 

образом на общую форму фигуры, можно удалить. 
Скорость вращения (только инструмент «Воронка») 
Указывает скорость вращения в используемой воронке. Введите 

значение от -180° до 180°. Отрицательные значения закручивают воронку в 
объекте по часовой стрелке, положительные значения – против часовой 
стрелки. Воронка закручивается сильнее при значениях, близких к -180° или 
180°. Для слабого закручивания воронки укажите значение, близкое к 0°. 

Горизонтально и Вертикально (только инструмент «Морщины») 
Указывает, как далеко друг от друга размещаются контрольные точки. 
Кисть воздействует на опорные точки, Кисть воздействует на 

направленные внутрь манипуляторы или Кисть воздействует на 
направленные наружу маркеры (инструменты «Зубцы», «Кристаллизация», 
«Морщины») 

Для внесения изменений в эти свойства включается кисть инструмента. 
Необходимо сказать еще об одной возможности трансформации. 

Находится эта функция в меню Effekt- Distort and Transform- Transformation 
(Эффект-Исказить и трансформировать-Трансформировать).  

Инструменты деформации объектов.  
1. Инструмент Width Tool (Ширина). Клавиши быстрого вызова 

‹Shift›+‹W›. Предназначен для создания переменной толщины у обводки. Для 
изменения толщины обводки выберите в панели инструментов Width Tool, 
наведите на контур, которому нужно изменить толщину обводки.Как только 
возле курсора появится значок «+» кликните на обводку и перетащите мышь 
в сторону. Кстати, важно понимать, что точки ширины и опорные точки 
контура не обязательно должны совпадать и даже чаще всего не совпадают. 
То есть увеличить или уменьшить толщину можно в любом месте контура. 
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Кроме этого, точки ширины можно перемещать, удалять, копировать, а также 
создавать двойные точки — место, где ширина контура резко меняется. 

Кроме метода перетаскивания толщину обводки в точке ширины можно 
настроить вручную. Для этого выберите Width Tool в панели инструментов и 
дважды кликните по контуру, которому нужно изменить толщину. Появится 
диалоговое окно: 

Side 1 — толщина одной стороны 
Side 2 — толщина второй стороны 
Total Width — общая толщина обводки 
Adjust Adjoining Width Points — установка этой галочки скорректирует 

толщину контура в соседних точках ширины, если они есть. Если кликать по 
контуру инструментом Width Tool ударживая клавишу Shift, то эта галочка 
поставится автоматически. 

Если нажать на кнопку с разомкнутой цепочкой справа от полей ввода 
для Side 1 и Side 2 иконка примет вид замкнутой цепочки, а толщина контура 
будет меняться одинаково с обеих сторон. Для применения настроек нажмите 
на кнопку «Ok» 

Для редактирования уже готовой точки ширины нужно дважды 
кликнуть по точке ширины. Появится диалоговое окно настроек точки. 

Также, точку ширины можно удалить, нажав на кнопку Delete в 
диалоговом окне или на клавиатуре. Копировать точки ширины можно с 
зажатой клавишей Alt. Выделять несколько точек можно с Shift. 

2. Warp Tool (Деформация). Клавиши быстрого вызова ‹Shift›+‹R›. 
Предназначен для трансформации формы объекта, имитирующей 

“лепку”. Визуально выглядит как смещения пальцем. Выделите объект, 
который необходимо подвергнуть деформации и выберите Warp Tool в 
панели инструментов. Зажмите левую кнопку мыши, когда курсор находится 
рядом с выделенным объектом и проведите курсором по направлению к 
нему. 

Изменение размера кисти Warp Tool: держите нажатой клавишу Alt на 
клавиатуре, кликните в любом месте рабочей области и, не отпуская кнопку, 
двигайте мышью. Таким образом можно менять и ширину, и длину кисти. 
Инструмент Adobe Illustrator Warp Tool. Настройки инструмента: 

Width – ширина кисти, 
Height – длина, 
Angle – значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины) 
Intensity – интенсивность сдвига. 
Галочка Use Pressure Pen – учитывать нажим пера планшета, если вы 

используете планшет. 
Detail – детализация определяет расстояние между дополнительными 

точками, создаваемыми на контуре после применения Warp Tool. 
Simplify – сглаживание или упрощение. Влияет на плавность контура 

после применения Warp Tool и определяет количество точек, которые можно 
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удалить, если они оказывают не значительное влияние на окончательную 
форму контура после деформации. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

3. Инструмент Twirl Tool (Воронка). Предназначен для трансформации 
формы объекта, имитирующей закручивание. 

Изменение размера кисти Twirl Tool: Держите нажатой клавишу Alt на 
клавиатуре, кликните в любом месте рабочей области и, не отпуская кнопку, 
двигайте мышью. Таким образом, можно менять и ширину, и длину кисти. 
Кликните на объекте левой кнопкой мыши. Удерживайте кнопку до тех пор, 
пока результат не устроит вас. Для того, чтобы изменить настройки эффекта 
Twirl Tool дважды кликните на иконке Twirl Tool в панели инструментов: 

Width – ширина кисти, 
Height – длина, 
Angle – значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины) 
Intensity – интенсивность закручивания. 
Галочка Use Pressure Pen – учитывать нажим пера планшета, если вы 

используете планшет. 
Twirl Rate – скорость вращения. Определяет направление и 

интенсивность вращения. Возможные значения: от -180 ° до 180 °. 
Отрицательные величины вращают объект по часовой стрелке, 
положительное – против часовой стрелки. Интенсивность закручивания 
будет максимальной при значениях близких к -180° и 180°. Чтобы вращение 
было медленным, нужно устанавливать значения Twirl Rase близкие к 0°. 

Detail – детализация определяет расстояние между дополнительными 
точками, создаваемыми на контуре после применения Wirl Tool. 

Simplify – сглаживание или упрощение. Влияет на плавность контура 
после применения Wirl Tool и определяет количество точек, которые можно 
удалить, если они оказывают незначительное влияние на окончательную 
форму контура после деформации. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

3. Инструмент Pucker Tool (Втягивание). Втягивает объект по 
направлению к курсору. Выделите объект, который необходимо подвергнуть 
деформации и выберите Pucker Tool в панели инструментов. 

Изменение размера кисти Pucker Tool: держите нажатой клавишу Alt на 
клавиатуре, кликните в любом месте рабочей области и, не отпуская кнопку, 
двигайте мышью. Таким образом, можно менять и ширину, и длину кисти. 
Кликните на объекте левой кнопкой мыши. Удерживайте кнопку до тех пор, 
пока результат не устроит вас. 

Для того, чтобы изменить настройки эффекта Pucker Tool дважды 
кликните на иконке Pucker Tool в панели инструментов: 

Width — ширина кисти, 
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Height — длина, 
Angle — значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины) 
Intensity — интенсивность втягивания. 
Галочка Use Pressure Pen — учитывать нажим пера планшета, если вы 

используете планшет. 
Detail — детализация определяет расстояние между дополнительными 

точками, создаваемыми на контуре после применения Pucker Tool. 
Simplify — сглаживание или упрощение. Влияет на плавность контура 

после применения Pucker Tool и определяет количество точек, которые 
можно удалить, если они оказывают не значительное влияние на 
окончательную форму контура после деформации. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

4. Bloat Tool (Раздувание). Раздувает объект от центра курсора. 
Изменение размера кисти Bloat Tool: Держите нажатой клавишу Alt на 

клавиатуре, кликните в любом месте рабочей области и, не отпуская кнопку, 
двигайте мышью. Таким образом, можно менять и ширину, и длину кисти. 
Кликните на объекте левой кнопкой мыши. Удерживайте кнопку и двигайте 
мышь до тех пор, пока результат не устроит вас. 

Для того, чтобы изменить настройки эффекта Bloat Tool дважды 
кликните на иконке Bloat Tool в панели инструментов: 

Width — ширина кисти, 
Height — длина, 
Angle — значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины) 
Intensity — интенсивность раздувания. 
Галочка Use Pressure Pen — учитывать нажим пера планшета, если вы 

используете планшет. 
Detail — детализация определяет расстояние между дополнительными 

точками, создаваемыми на контуре после применения Bloat Tool. 
Simplify — сглаживание или упрощение. Влияет на плавность контура 

после применения Bloat Tool и определяет количество точек, которые можно 
удалить, если они оказывают не значительное влияние на окончательную 
форму контура после деформации. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

5. Инструмент Scallop Tool (Зубцы). Добавляет зубцы к контуру объекта. 
Выделите объект, который необходимо подвергнуть деформации и выберите 
Scallop Tool в панели инструментов. Изменение размера кисти Scallop Tool: 
держите нажатой клавишу Alt на клавиатуре, кликните в любом месте 
рабочей области и, не отпуская кнопку, двигайте мышью. Таким образом,  
можно менять и ширину, и длину кисти. Кликните на объекте левой кнопкой 
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мыши. Удерживайте кнопку и перемещайте мышь до тех пор, пока результат 
не устроит вас. 

Для того, чтобы изменить настройки эффекта Scallop Tool дважды 
кликните на иконке Scallop Tool в панели инструментов: 

Width — ширина кисти, 
Height — длина, 
Angle — значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины) 
Intensity — интенсивность. 
Галочка Use Pressure Pen — учитывать нажим пера планшета, если вы 

используете планшет. 
Complexity — сложность. Чем больше значение Complexity, тем больше 

результат воздействия Scallop Tool будет отличаться от исходного контура. 
Detail — детализация определяет расстояние между дополнительными 

точками, создаваемыми на контуре после применения Scallop Tool. 
Brush Affects Anchor Points — эффект воздействует на опорные точки. 
Brush Affects In Tangent Handles — эффект воздействует на точки, чьи 

направляющие направленны внутрь объекта. 
Brush Affects Out Tangent Handles — эффект воздействует на точки, чьи 

направляющие направленны наружу. 
Brush Affects Anchor Points, Brush Affects In Tangent Handle и Brush 

Affects Out Tangent Handles не могут быть установлены все одновременно, в 
один момент можно поставить максимум две из этих галочек. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

6. Инструмент Crystallize Tool (Кристаллизация). Добавляет шипы к 
контуру объекта. Выделите объект, который необходимо подвергнуть 
деформации и выберите Crystallize Tool в панели инструментов. 

Изменение размера кисти Crystallize Tool: держите нажатой клавишу Alt 
на клавиатуре, кликните в любом месте рабочей области и, не отпуская 
кнопку, двигайте мышью. Таким образом, можно менять и ширину, и длину 
кисти. Для того, чтобы изменить настройки эффекта Crystallize Tool дважды 
кликните на иконке Crystallize Tool в панели инструментов: 

Width — ширина кисти, 
Height — длина, 
Angle — значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины) 
Intensity — интенсивность. 
Галочка Use Pressure Pen — учитывать нажим пера планшета, если вы 

используете планшет. 
Complexity — сложность. Чем больше значение Complexity, тем больше 

результат воздействия Crystallize Tool будет отличаться от исходного 
контура. 
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Detail — детализация определяет расстояние между дополнительными 
точками, создаваемыми на контуре после применения Crystallize Tool. 

Brush Affects Anchor Points — эффект воздействует на опорные точки. 
Brush Affects In Tangent Handles — эффект воздействует на точки, чьи 

направляющие направленны внутрь объекта. 
Brush Affects Out Tangent Handles — эффект воздействует на точки, чьи 

направляющие направленны наружу 
Brush Affects Anchor Points, Brush Affects In Tangent Handle и Brush 

Affects Out Tangent Handles не могут быть установлены все одновременно, в 
один момент можно поставить максимум две из этих галочек. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

7. Инструмент Wrinkle Tool (Морщины). Искажает контур объекта, 
добавляя искажения, напоминающие морщины. 

Выделите объект, который необходимо подвергнуть деформации и 
выберите Wrinkle Tool в панели инструментов. 

Изменение размера кисти Wrinkle Tool: держите нажатой клавишу Alt на 
клавиатуре, кликните в любом месте рабочей области и, не отпуская кнопку, 
двигайте мышью. Таким образом, можно менять и ширину, и длину кисти. 
Кликните на объекте левой кнопкой мыши. Удерживайте кнопку мыши до 
тех пор, пока результат не устроит вас. 

Для того, чтобы изменить настройки эффекта Wrinkle Tool дважды 
кликните на иконке Wrinkle Tool в панели инструментов: 

Width — ширина кисти, 
Height — длина, 
Angle — значение угла, под которым наклонена ось кисти, если она не 

круглая (если значение ширины отличается от длины), 
Intensity — общая интенсивность воздействия, 
Галочка Use Pressure Pen — учитывать нажим пера планшета, если вы 

используете планшет. 
Horizontal — интенсивность воздействия эффекта на горизонтали, 
Vertical — интенсивность воздействия эффекта на вертикали, 
Complexity — сложность. Чем больше значение Complexity, тем больше 

результат воздействия Crystallize Tool будет отличаться от исходного 
контура, 

Detail — детализация определяет расстояние между дополнительными 
точками, создаваемыми на контуре после применения Wrinkle Tool. 

Brush Affects Anchor Points — эффект воздействует на опорные точки, 
Brush Affects In Tangent Handles — эффект воздействует на точки, чьи 

направляющие направленны внутрь объекта, 
Brush Affects Out Tangent Handles — эффект воздействует на точки, чьи 

направляющие направленны наружу, 
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Brush Affects Anchor Points, Brush Affects In Tangent Handle и Brush 
Affects Out Tangent Handles не могут быть установлены все одновременно, в 
один момент можно поставить максимум две из этих галочек. 

Если стоит галочка Show Brush Size, то видно размер кисти инструмента 
перед его использованием. 

 Создание серии промежуточных объектов. Инструмент Blend. 
С помощью инструмента Blend (Переход) и команды Make (Создать) 

меню Object/Blends (Объект/ Переход) можно получить произвольное 
количество промежуточных объектов, получаемых из двух или более 
исходных форм. Исходными формами могут быть открытые и закрытые 
контуры, объекты с градиентными заливками, а также предыдущие 
результаты работы инструмента Blend (Переход). "Группы перехода" в 
дальнейшем можно перемещать, масштабировать, удалять из них или 
добавлять в них объекты. Процесс редактирования облегчается тем, что 
программа оперативно "отрабатывает" все производимые изменения. 

При использовании инструмента Blend следует учитывать некоторые 
условия: 

В процессе создания промежуточных форм могут участвовать 
неограниченное число контуров с цветными и градиентными заливками. 

"Группы перехода" можно редактировать с помощью инструментов 
Selection (Выделение), Rotate (Поворот) и Scale (Размер). 

В "группы перехода" нельзя включать объекты, создаваемые с помощью 
инструмента Gradient Mesh (Градиентная сетка). 

Создание "группы перехода". 
Для того чтобы получить серию промежуточных объектов, можно 

включить инструмент Blend (Превращение) и последовательно выбирать 
необходимые объекты, а можно, выделив несколько объектов, применить к 
ним команду Make (Создать) меню Object/Blends (Объект/Превращение). 

Параметры: 
Количество промежуточных объектов и характер расположения их 

вдоль траектории определяются в диалоговом окне Blend Options 
(Параметры)  

В раскрывающемся списке Spacing (Интервалы) представлены способы 
определения количества промежуточных объектов. 

Вариант Smooth Color (Сглаженный переход цветов) обеспечивает 
автоматическое вычисление количества объектов. Если исходные объекты 
имеют заливки или обводки различного цвета, то обеспечивается 
соответствующее количество объектов, необходимое для того, чтобы 
цветовая растяжка выглядела гладкой. 

Вариант Specified Steps (Количество промежуточных объектов) дает 
возможность пользователю самому определить нужное количество 
промежуточных объектов в диапазоне от 1 до 1000. 

Вариант Specified Distance (Расстояние) дает возможность определить не 
количество объектов, а расстояние между ними, которое отмеряется между 
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однотипными элементами, например, между левой стороной одного 
прямоугольника и левой стороной следующего прямоугольника. 

Помимо количества объектов в поле Orientation (Ориентация) 
диалогового окна можно определить расположение промежуточных 
объектов, а именно: 

левая кнопка Align to Page (Привязка к странице) обеспечивает 
расположение исходных и промежуточных объектов перпендикулярно оси Х 
страницы; 

правая кнопка Align to Path (Привязка к контуру) обеспечивает 
расположение объектов перпендикулярно траектории контура. 

Направление вдоль траектории. 
После создания "группы превращения" ее можно направить вдоль 

произвольной траектории, заменив на нее прямую, которая создается 
первоначально по умолчанию. Для выполнения этой операции необходимо 
выделить "группу перехода", а затем при нажатой клавише [Shift] выделить 
объект, вдоль контура которого она направляется. Последний шаг — 
выполнение команды Replace Spine (Заменить траекторию) меню 
Object/Blends (Объект/Переход). 

Порядок расположения промежуточных объектов вдоль траектории 
можно изменить на противоположный. Для этого необходимо выделить 
"группу перехода" и выполнить команду Reverse Spine (Изменить 
направление траектории) меню Object/Blends (Объект/Переход). 

Если объекты в "группе превращения" перекрывают друг друга, то с 
помощью команды Reverse Front to Back (Изменить расположение в стопке) 
меню Object/Blends (Объект/Переход) можно изменить расположение 
объектов в "стопке" на обратное. 

После создания "группы перехода" она может подвергаться различным 
изменениям: перемещению, удалению, масштабированию, вращению, 
редактированию контуров, присвоению новых цветов и декоративных 
заливок. Все трансформации являются традиционными и выполняются с 
помощью соответствующих инструментов и команд. 

Удаление "группы перехода". Для того чтобы вернуть исходные объекты 
в первоначальное положение и удалить "группы перехода", необходимо их 
выделить и выполнить команду Release (Исключить) меню Object/Blends 
(Объект/Переход). 

 
 

ТЕМА 9. РАБОТА С ЦВЕТОМ. ЦВЕТОВЫЕ АТРИБУТЫ 
 

Цветовые режимы. Палитра Цвет и Образцы. Создание и сохранение 
образцов цвета. Глобальные цвета. Плашечные цвета. Создание цветовых 
групп. Библиотека образцов. Инструмент Пипетка. Инструмент Быстрая 
заливка. Панель Обводка. Палитра Градиент. Настройка и выбор цвета. 
Сохранение образцов. Инструмент градиент. Инструмент Градиентная сетка: 
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способы создания. Применение существующих узоров. Создание 
собственных узоров. Редактирование узоров. Трансформирование объектов с 
заливкой узором. Палитра Стили графики. Библиотека стилей. Создание и 
редактирование стилей.  

 
Цель:  
- -изучить палитры для работы с цветом. 
-познакомить с инструментами для создания градиентной заливки 

объектов и обводок. 
- научиться работать с палитрой Gradient. 
- научиться создавать собственные градиенты и добавлять их в образцы. 
- познакомить учащихся с инструментом Gradient Tool. 
- научиться создавать собственные узоры (Patterns) и добавлять их в 

библиотеку. 
- освоить работу с инструментом Gradient Mesh. 
- научиться создавать собственные каталоги и образцы цветов. 
-  освоить работу с инструментом Eyedropper Tool и Live Paint Bucket 

Tool. 
- научиться создавать собственные каталоги и образцы цветов. 
- развить интерес к предмету. 
- воспитать дисциплинированность и целеустремленность. 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача домашних заданий 
Теория: 
Цвет и палитры для работы с цветом в программе. Заливка объекта и 

контура цветом. Использование и создание собственных библиотек каталогов 
и образцов цветов. 

Способы создания градиентной заливки и обводки. 
Палитра Gradient  и инструмент  Gradient Tool. Создание и сохранение 

собственных градиентов. 
Инструмент Gradient Mesh. 
Повторяющиеся узоры, создание собственных узоров. 
Добавление и редактирование эффектов для векторных объектов.  
Стили графики. Палитра Graphic Styles. Создание собственных стилей. 
Инструменты Eyedropper Tool и Live Paint Bucket Tool для быстрой 

заливки объектов. 
Практика: 
- залить фигуры и контуры объектов используя библиотеки образцов и 

каталогов 
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- создать собственные каталоги образцов и каталогов цветов. 
- создать фигуры сложной формы используя палитру Pathfinder, 

выполнить заливку фигуры градиентом. 
- создать градиент и добавить его в библиотеку. 
- создать объект и залить его инструментом Gradient Mesh. 
- создать ряд объектов и применить к ним многочисленные заливки, 

обводки и эффекты. 
- создать собственные графические стили. 
- применить собственные графические стили к новым объектам. 
- применить различные эффекты к векторным объектам. 
- создать векторную иллюстрацию по приведенным образцам. 

 
КРАТКИЙ КОНСПЕКТ 

 
О выборе цветового режима для изображения говорилось неоднократно. 

Поэтому просто напомним, как происходит смена цветового режима в 
Иллюстрэйторе: File - Document Color Mode. И далее для электронных 
документов выбираем RGB, для печати CMYK.  

Цвета для заливки и обводки привычно быстро выбираются как через 
панель управления так и через панель инструментов. Отключить цвет 
заливки/обводки можно также. 

Вообще, в программе Illustrator цвета для иллюстрации можно выбирать 
с помощью разнообразных инструментов, палитр и диалоговых окон. Способ 
выбора цвета зависит от задачи. Например, если необходимо использовать 
конкретные цвета, утвержденные компанией, то приходится выбирать цвета 
из библиотеки цветов, утвержденной компанией. Если требуется согласовать 
цвета с цветами в другой иллюстрации, то можно воспользоваться пипеткой 
или окном «Палитра цветов» и ввести точные цветовые значения. 

Для выбора цвета можно использовать любые из следующих средств, 
многие из них вам уже знакомы из предыдущего курса Adobe Photoshop: 

• Палитра «Образцы» и палитры библиотеки цветов 
Предоставляют отдельные цвета и цветовые группы. Предусмотрена 

возможность выбирать из существующих образцов и библиотек или 
создавать собственные. Можно также импортировать библиотеки. 

• Палитра цветов 
Предоставляет спектр цветов, из которого можно выбирать цвета, 

руководствуясь визуальным восприятием, текстовые поля с цветовыми 
значениями для ввода определений цветов вручную, а также образцы цвета. 

• Инструмент «Пипетка» 
Обеспечивает выбор цветов из иллюстрации при щелчке на ней. 
• Палитра «Цвет» 
Предоставляет спектр цветов, отдельные ползунки для задания цветовых 

значений (например, ползунок «Голубой») и текстовые поля ввода цветовых 
значений. Предусмотрена возможность задавать цвета заливки и обводки в 
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палитре «Цвет». В меню палитры «Цвет» можно создать инверсные и 
комплементарные цвета для текущего цвета заливки или обводки, а также 
образец из выбранного цвета. 

• Палитра «Каталог цветов» 
Предоставляет несколько правил гармонии для создания цветовых групп 

с использованием выбранного основного цвета. Можно также создавать 
вариации цветов с использованием оттенков и полутонов, теплых и холодных 
или ярких и приглушенных цветов. Из этой палитры можно открыть 
цветовую группу в диалоговом окне «Редактировать цвета/Перекрасить 
графический объект». 

• Диалоговое окно «Редактировать цвета/Перекрасить графический 
объект» 

В одной части этого диалогового окна находятся инструменты для 
точного определения цветов или их настройки в рамках цветовой группы или 
иллюстрации. Вторая часть позволяет переопределять цвета иллюстрации 
при помощи цветов из цветовой группы, а также сокращать или 
преобразовывать цвета для вывода на печать. 

• Команда «Добавить выбранные цвета» или кнопка «Создать цветовую 
группу» 

Позволяет создать цветовую группу, содержащую цвета из выбранной 
иллюстрации. Эта команда и кнопка находятся в палитре «Образцы». 

•  Окно «Палитра цветов» позволяет выбрать цвет заливки или обводки 
объекта с помощью выбора из поля цвета и спектра, определения цветов в 
цифровой форме или щелчка на образце. 

Выбор цветов с помощью инструмента «Палитра цветов»: Щелкните 
или перетащите курсор внутри спектра цветов. Круговой маркер указывает 
положение цвета в спектре. Перетащите треугольники вдоль цветовой шкалы 
или щелкните внутри цветовой шкалы. Введите значения в любом из 
текстовых полей. Нажмите кнопку «Цветовые образцы», выберите образец и 
нажмите кнопку «ОК».  

Инструмент Быстрая заливка. Live Paint Bucket Tool. 
Клавиша быстрого вызова ‹K›. Предназначен для быстрого 

раскрашивания областей в заранее определенные цвета и заливки. 
Строго говоря, раскрашивание областей возможно только в так 

называемых группах с быстрой заливкой. Однако создание группы с быстрой 
заливкой происходит в момент применения инструмента Live Paint Bucket 
Tool. 

Итак, чтобы создать группу быстрой заливки выделите те объекты, 
из которых вы хотите ее создать и выберите Live Paint Bucket Tool в панели 
инструментов: 

При помощи клавиш «вправо» и «влево» выберите цвет, которым 
вы хотели бы залить области. Клавиши последовательно проходят 
по заливкам в панели Swatches, включая узорные заливки и градиенты 
в текущей группе. Переключаться между группами в панели Swatches можно 

67 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



припомощи клавиш «вверх» и «вниз». Текущий цвет — это цвет среднего 
квадратика рядом со значком курсора: 

Когда заливка будет выбрана – наведите на область, который хотите 
раскрасить, вид курсора изменится: 

После этого щелкните по нему: 
Для окрашивания нескольких смежных областей — протащите курсор 

с зажатой кнопкой мыши через них: 
Для раскрашивания Всех смежных областей, не назделенных обводкой, 

дважды щелкните по выделеной области: 
При тройном клике — окрасятся все области с одинаковой заливкой: 
Если группа быстрой заливки была уже создана ранее, то 

для применения инструмента ее заранее выделать не обязательно. 
Не смотря на то, что иллюстратор считает группу быстрой заливки 

единым объектом, который лежит на одном слое, внутри группы объекты 
можно перемещать.  

Выберите Select Tool (черная стрелочка) в панели инструментов 
и дважды щелкните по группе быстрой заливки, чтобы оказаться внутри 
группы. 

Перемещайте объекты, при этом будут меняться формы областей 
быстрой заливки. 

Для более точной настройки инструмента дважды щелкните по иконке 
Live Paint Bucket Tool в панели инструментов: 

Paint Fills — позволяет окрашивать внутреннюю часть областей группы 
быстрой заливки, 

Paint Strockes — позволяет окрашивать контуры, 
Cursor Swatch Preview — показывать образцы цвета рядом с курсором, 
Highlight — показывать подсветкой выделенную область, 
Color — выбор цвета подсветки, 
Width — ширина подсветки, 
Tips — кнопка вызова инструкции по использованию инструмента. 
Такая же инструкция будет показана, если вы щелкните инструментом 

по рабочей области, а не по группе объектов. 
Eyedropper Tool (Пипетка). Клавиша быстрого вызова ‹I›. Предназначен 

для копирования аттрибутов оформления с одного объекта на другой. 
Копирование аттрибутов при помощи Eyedropper Tool возможно двумя 
способами. 

Первый способ: 
Выберите объект или группу объектов, которым нужно присвоить 

аттрибуты другого объекта иллюстрации. Выберите инструмент Eyedropper 
Tool в панели инструментов или нажмите кнопку клавишу быстрого вызова 
‹I›. Щелкните по объекту с которого хотите скопировать аттрибуты. 

Второй способ: 
Убедитесь, что ни один объект в иллюстрации не выделен. Выберите 

инструмент Eyedropper Tool в панели инструментов или нажмите кнопку 
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клавишу быстрого вызова ‹I›. Щелкните по объекту с которого хотите 
скопировать аттрибуты. Зажмите клавишу ‹Alt› и щелкните по объекту, 
к которому нужно применить скопированные в буфер аттрибуты 
оформления. Если оформление нужно применить к нескольким объектам, 
не отпуская ‹Alt› щелкните по каждому из них. 

Если вам нужно скопировать только цвет заливки, а другие аттрибуты 
проигнорировать — при использовании инструмента держите зажатой 
клавишу ‹Shift› 

По-умолчанию настройки инструмента Eyedropper Tool таковы, что 
копируются все аттрибуты — заливка, обводка, прозрачность, стили 
параграфов и текста. Для настройки инструмента дважды щелкните 
по инструменту Eyedropper Tool левой кнопкой мыши, откроется окошко 
настроек: Снимите флажки с аттрибутов, которые не нужно копировать 
при следующем использовании инструмента Eyedropper Tool. 

Столбик Eyedropper Pick Up — для первого способа копирования. 
Столбик Eyedropper Applies — для второго. 
Поле Raster Sample Size — указание размера для усредненного цвета, 

при копировании цвета с растрового изображения. 
Инструмент пипетка дает возможность выбрать цвет заливки с любой 

точки экрана, даже на пределами документа Adobe Illustrator, например, 
с рабочего стола. 

Для этого выберите объект, которому планируете изменить цвет 
заливки, выберите инструмент Eyedropper Tool и в любом месте документа 
зажмите левую кнопку мыши. Не отпуская кнопки мыши, переместите 
курсор в область экрана, откуда хотите скопировать цвет и отпустите кнопку 
мыши. 

Градиентные заливки предназначены для создания переходов между 
цветами. Чаще всего их применяют для придания объема плоским векторным 
объектам, создавая света и тени.  

Adobe Illustrator имеет только два вида градиентных заливок. Это 
линейный и радиальный градиент. Радиальный градиент может быть 
трансформирован в эллиптический.  

Для управления градиентными заливками в Adobe Illustrator служат 
панель Gradient  (Window > Gradient) и инструмент Gradient Tool (G), 
который вы сможете найти на панели инструментов. 

Вы также можете управлять градиентом при помощи Gradient Annotator. 
Gradient Annotator становится активным только после выбора Gradient Tool 
(G). Для включения Gradient Annotator переходим View > Show > Gradient 
Annotator или используем комбинацию горячих клавиш Option / Ctrl + G. 

Итак, давайте посмотрим, как применить градиент и затем управлять им. 
Для того чтобы применить градиентную заливку к выделенному объекту, вам 
следует выбрать такой вид заливки на панеле Tools. 
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По умолчанию это заливка черно-белым линейным градиентом. Вы 
также можете использовать градиенты из панели Swatches или из ее 
многочисленных библиотек: 

  
Для изменения цветов градиента выделите один из его ползунков в 

панеле Gradient, затем выберите цветовую модель в панеле Colors и 
установите нужный цвет. Вы также можете перетаскивать цвета из панели 
Swatches на любой ползунок для замены его цвета или для создания нового 
ползунка.  

Для изменения цвета ползунка вы можете также использовать 
Eyedropper Tool (I). Выделяем один из ползунков, берем Eyedropper Tool (I) 
и, удерживая Shift, берем цвет с другого объекта, который имеет сплошную 
или градиентную заливку. Таким способом вы также можете брать цвета с 
растровых изображений или градиентных сеток. Для создания нового 
ползунка вам просто нужно кликнуть на свободном месте слайдера в панеле 
Gradient. Для удаления ползунка потяните его вниз или нажмите иконку 
Delete Stop. Перемещая ползунки и средние точки, вы можете добиться 
необходимого распределения цветов.   

На практике часто приходится работать со сложными градиентами, 
которые содержат большое количество ползунков. Для удобства работы с 
такими градиентами просто расширьте панель Gradient. В панеле Gradient  вы 
можете выбрать вид градиента, установить его угол, установить соотношение 
сторон для радиального градиента, что превратит его в эллиптический, 
уменьшить непрозрачность для ползунка  и точно установить положение для 
выделенного ползунка.  

Если взять Gradient Tool (G), то вы сможете управлять градиентом 
непосредственно на объекте при помощи Gradient Annotator. Вы можете 
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перемещать его, изменять угол и двигать ползунки. При помощи Gradient 
Tool (G) вы можете задавать угол, направление и длину градиента, используя 
метод: нажимаем и тащим.  

Если после создания радиального градиента кликнуть на каком-нибудь 
месте при помощи Gradient Tool (G), то центр градиента будет перемещен в 
это место, при этом мы получим эксцентричный радиальный градиент, как 
это показано на рисунке ниже. Кроме того, градиентные заливки мы можем 
применять к обводке. Такая заливка имеет три вида: gradient within stroke, 
gradient along stroke,  gradient across stroke. 

Mesh Tool (Градиентная сетка или Сетчатый градиент). Клавиша 
быстрого вызова ‹U›. Предназначен для создания градиентной сетки 
из объектов и ее раскраски.  

Градиентная сетка (меш) — это объект, состоящий из точек, каждая 
из которых может быть окрашена в свой цвет. При этом цветовой переход 
между точками происходит плавно, как при градиентной заливке. Плавность 
перехода в меше определяется длиной и перекрытием направляющих каждой 
точки. У каждой точки сетки есть от 2 до 4 направляющих в зависимости 
от местоположения. У угловых точек два направляющие, у боковых их три, у 
остальных - четыре. 

 Выделять, перемещать точки меша и изменять их направляющие можно 
как инструментом Mesh Tool, так и Direct Selection Tool (белая стрелочка). 
Для удаления иожно использовать клавишу Delete. 

Изменение цвета узлов градиентной сетки при помощи инструмента 
Mesh Tool. 

Самый простой способ изменить цвет узла – перетащить на него нужный 
образец цвета из палитры Swatches. Если пользуетесь для выделения 
инструментом Mesh Tool будьте очень аккуратны. Если «промахнетесь» 
мимо точки, то вы ее не выделите, а поставите новую. 

Можно выделить несколько точек градиентной сетки 
для одновременного изменения цвета. Для этого удерживайте при выделении 
Shift, либо обведите нужную группу точке инструментом Lasso Tool. 

Изменение прозрачности узлов градиентной сетки при помощи 
инструмента Mesh Tool. 

Для изменения прозрачности точек мешевой сетки выделите нужные 
точки любым способом и измените прозрачность при помощи палитры 
Transparency. 

 Если хотите изменить распределение цвета между точками, 
перемещайте маркеры на концах направляющих при помощи Mesh Tool 
или Direct Selection Tool. 
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ТЕМА 10. ВЕКТОРНАЯ ЖИВОПИСЬ В ИЛЛЮСТРАТИВНОЙ 
ГРАФИКЕ 

 
Инструмент Кисть. Применение кистей к обводкам. Типы кистей: 

дискретные, каллиграфические, из щетины, объектные, узорчатые. Палитра 
кистей. Параметры кистей. Создание и удаление кистей. Библиотека кистей. 
Палитра Символы. Библиотека символов. Создание и удаление символа. 
Замена образца символа. Отмена связи с символом. Инструменты работы с 
символами. 

 
Цель:  
- познакомиться с инструментом Brush. 
- узнать о различных типах кистей. 
- научиться применять кисти к обводкам объектов. 
- научиться создавать собственные кисти и добавлять их в библиотеку. 
- развить интерес к предмету. 
- воспитать дисциплинированность и целеустремленность. 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача домашних заданий 
Теория: 
-Инструмент Brush. Типы кистей.  
-Библиотека кистей. 
-Применение кисти к обводкам. 
-Создание собственных кистей. 
Практика: 
- создать контуры используй все типы кистей 
- создать и настроить собственные кисти 
- добавить пользовательские кисти в библиотеку 
- создать иллюстрацию при помощи инструмента Brush 
- создать векторную иллюстрацию по приведенным образцам. 
 

КРАТКИЙ КОНСПЕКТ 
 

Как и в любом другом графическом редакторе, кисти в Adobe Illustrator 
используются для создания самых разнообразных эффектов. С их помощью 
можно имитировать разные художественные техники, упрощать процесс 
рисования трудоемких объектов, состоящих из многократно повторяющихся 
одних и тех же элементов (трава, волосы, листья, шерсть и пр.), создавать 
уникальные узоры и т.п. 
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Для работы с кистями в панели Tools предусмотрен специальный 
инструмент Paintbrush (Кисть), однако можно применять и другие 
инструменты изображения, такие как Pen (Перо), Pensil (Карандаш), Ellipse 
(Эллипс), Rectangle (Прямоугольник) и т.п., в частности практически любому 
контуру можно придать эффект обводки кистью. 

Работа с кистями предполагает использование специализированной 
палитры Brushes (Кисти), в которой выбирают вид кисти и при 
необходимости корректируют ее параметры. Палитра Brushes может быть 
открыта или закрыта и вызывается из списка палитр, открывающегося при 
активизации команды Window (Окно). 

Illustrator поддерживает четыре типа кистей: 
 каллиграфические (Calligraphic) . Они напоминают кисти Photoshop, и с 

их помощью можно создавать изящные перьевые штрихи, являющиеся на 
самом деле удобными для редактирования контурами;  

дискретные (Scatter) .  Эти кисти размножают объект по заданному пути 
с указанными параметрами; художественные (Art). Они вытягивают 
заданный объект вдоль кривой с заданными параметрами; узорчатые 
(Pattern), которые рисуют узор по заданному пути и помогают закрашивать 
области внутри контуров. По умолчанию количество всех типов кистей, 
появляющихся в палитре Brushes, невелико. Существенно расширить их 
число можно, подгружая нужные кисти из библиотек встроенных кистей, 
открываемых командой Window=>Brush Libraries (Окно=>Библиотека 
кистей). Кроме того, можно включить в палитру кисти, созданные 
собственноручно или скачанные из Интернета. 

Для включения или отключения конкретной группы кистей нужно 
вызвать всплывающее меню палитры Brushes, щелкнув на треугольной 
кнопке в правом верхнем углу палитры и включив или выключив 
соответствующие флажки. По умолчанию открыты все четыре группы 
кистей, которые представлены в палитре Brushes последовательно друг за 
другом.  

Что касается непосредственно рисования кистью, то в программе 
Illustrator это происходит не совсем так, как, например, в Photoshop. В то же 
время основной принцип выбора кисти и перемещения ее по нужной 
траектории при нажатой левой клавише мыши, естественно, сохраняется. 
При этом особенности работы с кистью зависят от выбранной группы кистей, 
в частности для каллиграфических кистей они одни, а для дискретных — уже 
другие и т.д. 

Одинаковым образом настраиваются лишь основные параметры кисти, 
которые можно изменить после создания контура. Для этого на панели 
инструментов необходимо дважды щелкнуть левой кнопкой мыши по 
инструменту Paintbrush, появится диалоговое окно настройки параметров 
кисти.  

Наибольший интерес представляют параметры Fidelity (Точность), 
указывающий количество пикселов, на которое контур может отклоняться от 
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нарисованного пути при формировании кривой, и Smoothness (Сглаживание), 
который задает степень сглаживания контура (его увеличение обеспечивает 
создание более гладких кривых). Для восстановления параметров кисти по 
умолчанию в окне Paintbrush Tool Preferences (Настройка параметров кисти) 
достаточно щелкнуть на кнопке Reset. 

Рисование кистями 
Каллиграфические кисти 
Каллиграфические кисти, так же как кисти в растровых графических 

редакторах, применяются для создания рисунка от руки, поскольку 
напоминают штрихи, сделанные обычным пером. 

Для работы с каллиграфической кистью необходимо отказаться от 
заливки, активизировав на палитре инструментов квадратик Fill (Заливка) и 
щелкнув на кнопке None (Нет), а затем установить цвет рисования кистью, 
активизировав квадратик Stroke (Штрих) и определив цвет штриха. 

Затем следует выбрать привлекательную каллиграфическую кисть из 
палитры Brushes и можно начинать творить. Правда, стоит иметь в виду, что 
по умолчанию в палитре имеется всего пять каллиграфических кистей. При 
желании можно дополнить их другими кистями из библиотеки. Для этого 
воспользуйтесь командой Window=>Brush Libraries=>Calligraphic 
(Окно=>Библиотека кистей=>Каллиграфические) — в результате откроется 
окно кистей Calligraphic , из которого можно добавить нужные кисти в 
палитру Brushes одинарным щелчком по интересующей кисти или путем 
обычного перетаскивания. Можно перетащить несколько кистей за один 
прием, если предварительно выделить их при нажатой клавише Shift. 

Дискретные кисти 
Дискретные кисти представляют собой некие художественные 

изображения, которые рассеиваются вдоль проведенной траектории. Выбор 
дискретных кистей достаточно широк, так как наряду с кистями, 
загружаемыми по умолчанию, дискретные кисти можно найти в библиотеках 
Animal Sample, Arrow Sample, Floral Sample и Object Sample, загружаемых 
командой Window=>Brush Libraries=>… (Окно=>Библиотека кистей=>...), и 
перетащить в палитру Brushes . 

Для примера работы с дискретной кистью выберите инструмент Polygon 
и нарисуйте многоугольник понравившейся вам кистью (в данном случае 
выбрана кисть Sunflower) , обратите внимание, что в большинстве случаев 
размножаемые изображения окажутся размещенными случайным образом, а 
не будут распределены равномерно вокруг созданного контура. Поэтому 
далее скорректируйте параметры кисти подходящим образом, дважды 
щелкнув на кисти в палитре Brushes и изменив значения в открывшемся окне 
Scatter Brush Options (Параметры дискретных кистей. Щелкните на кнопке 
ОК, а затем на кнопке Apply to Strokes (Применить к штрихам).  

В окне Scatter Brush Options (Параметры дискретных кистей) можно 
настроить параметры: Size (Размер) - определяет размер кисти, Spacing 
(Промежуток) - указывает расстояние между отдельными изображениями, 
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Scatter (Рассеивание) - определяет степень отклонения отдельных 
изображений кисти от сформированного пути и Rotation (Вращение)  
отвечает за угол поворота изображений. Под настройкой подразумевается 
указание конкретных размеров или их границ для каждого из параметров и 
определение способа формирования значения параметра для каждого 
изображения: случайным образом - при выборе варианта Random 
(Случайный) или строго фиксированным — в случае варианта Fixed 
(Фиксированный). 

Кроме того, при настройке дискретной кисти представляет интерес 
параметр Colorization (Окраска), определяющий метод колоризации, с 
помощью которого осуществляется настройка цвета. По умолчанию 
установлен вариант None (Ни один) - в этом случае никаких настроек с 
цветом исходного изображения не производится, и изображения в контуре 
выглядят так же, как и кисть в палитре Brushes. При выборе метода Tints 
(Тона) цвет штриха отображается в оттенках заданного в квадратике Stroke 
палитры инструментов цвета. Установка метода Tints and Shades (Тона и 
Тени) приводит к тому, что цвет штриха отображается в оттенках и тенях 
цвета, определенного в Stroke. А при выборе метода Hue Shift (Сдвиг 
оттенка) все, что окрашено заданным цветом, приобретает цвет, заданный в 
Stroke, а другие цвета становятся дополнительными к нему. 

Художественные кисти 
При использовании художественных кистей краска равномерно 

распределяется вдоль траектории, заданной при движении кисти, а разные 
кисти имитируют различные графических средства: можно, например, 
рисовать мокрой (Watercolor) или сухой (Dry) кистью, карандашом (Pencil) 
или углем (Charcoal) и т.п. При этом удается создавать достаточно сложные 
изображения, не прибегая к раскрашиванию (то есть при выключенном 
параметре Fill), передавая в то же время все основные линии рисунка. 

Откройте полную библиотеку художественных кистей командой 
Window=>Brush Libraries=>Artistic Sample (Окно=>Библиотека 
кистей=>Художественные кисти) и перетащите кисть Water Color (Влажная 
кисть) в палитру Brushes.  

Узорчатые кисти 
С помощью узорчатых кистей, как и следует из их названия, создаются 

различные мозаичные узоры. 
Создайте новый документ и нарисуйте несколько многоугольников или 

звезд. Выделите все объекты инструментом Direct Selection при нажатой 
клавише Shift, откройте группу кистей Border Sample командой 
Window=>Brush Libraries=>Border Sample (Окно=>Библиотека 
кистей=>Образцы узоров) и выберите понравившуюся узорную кисть (в 
нашем примере взята кисть Pressed). А теперь поэкспериментируйте с 
настройками кисти, дважды щелкнув на кисти в палитре Brushes и настроив 
параметры. Самое главное, на что нужно обратить внимание в окне 
настройки параметров, — это возможность включения и выключения мозаик: 
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Side tile (Боковая мозаика), Outer Corner tile (Мозаика внешнего угла), Inner 
Coner tile (Мозаика внутреннего угла), Start tile (Начальная мозаика), End tile 
(Концевая мозаика). Манипуляции с мозаиками могут привести к самым 
неожиданным и интересным эффектам. 

При необходимости можно корректировать размер изображения кисти за 
счет определения значения параметра Scale (Масштаб), а между 
декоративными элементами включать пробелы, размер которых 
устанавливается в поле Spacing (Пробелы). Флажки Flip Along (Отражение по 
горизонтали) и Flip Across (Отражение по вертикали) обеспечивают 
зеркальное отображение. А если длина контура не вмещает целое число 
элементов узорной кисти, то можно поэкспериментировать с 
переключателями: Stretch to fit (Растянуть), который приводит к удлинению 
или к укорачиванию элемента с тем, чтобы полностью заполнить контур; Add 
space to fit (Вставить пробелы), обеспечивающим равномерное добавление 
пробелов, и Approximate path (Сместить), предназначенным для перемещения 
элементов таким образом, чтобы линия контура всегда вмещала целое число 
элементов. 

Как и в отношении других групп кистей, можно изменять методы 
колоризации, определяя значение параметра Colorization (Окраска), с 
помощью которого осуществляется настройка цвета.  

Создание новых кистей 
Палитра Brushes позволяет создавать и хранить любые новые кисти всех 

четырех типов. При этом можно использовать произвольные рисунки, правда 
удовлетворяющие определенным ограничениям. Например, изображение 
кисти не должно иметь узорной или градиентной заливки, не может иметь 
тени, не должно входить в группу промежуточных объектов (blend) и 
градиентной сетки (gradient mesh) и ряд других. 

После создания новая кисть автоматически попадает в палитру Brushes, 
однако при создании нового документа по умолчанию она в палитре не 
появится. Более того, чтобы воспользоваться созданной кистью в другом 
документе, ее нужно обязательно предварительно сохранить в файле *.ai в 
папке C:\Program Files\Adobe\Illustrator 10\Presets\Brushes. В этом случае для 
открытия палитры кистей с созданной кистью достаточно будет применить 
команду Window=>Brush Libraries=>Other Library (Окно=>Библиотека 
кистей=>Другие библиотеки) и выбрать файл с палитрой в папке C:\Program 
Files\Adobe\Illustrator 10\Presets\Brushes. 

Символы позволяют легко создавать повторяющиеся элементы дизайна. 
Прежде всего, Вам необходимо создать символ, который будет являться 
основой для копий. Новые копии, созданные Вами, будут привязаны к 
основному символу (по сути, они являются только ссылкой на Ваш 
первоначальный символ). Внеся изменения в основной символ, Вы 
автоматически внесете изменения во все остальные копии. 
Создаем новый символ 
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Нарисуйте свой графический элемент, затем выделите его и перетащите 
в палитру «Символы» (Symbols Palette). Она вызывается командой «Окно > 
Символы» (Window > Symbols). Нажмите OK для подтверждения операции. 

Инструмент «Распыление символов» (Symbol Sprayer Tool) 
Теперь выберите на палитре инструментов «Распыление символов» (Symbol 
Sprayer Tool). Нажмите на иконку два раза, чтобы вызвать окно с 
настройками. В настройках Вы можете изменить диаметр и интенсивность 
распыления. 

Инструментом «Распыление символов» (Symbol Sprayer Tool) кликните 
по рабочей области, и распыляйте символы, удерживая правую кнопку 
мышки. 

Есть еще несколько вещей, которые Вы можете сделать, используя этот 
инструмент. Переключитесь на функцию «Вращение символов» (Symbol 
Spinner) в настройках инструмента и меняйте направление копий символа. 
Стрелочки указывают направление вращения. 

Чтобы создать символы разных размеров, выберите функцию «Размер 
символов» (Symbol Sizer) и нажмите на символ для его увеличения. Если 
хотите уменьшить размер символа, проделайте туже операцию, но 
удерживайте при этом клавишу Alt. 

Разбираем символы на объекты 
Если Вам нужно разобрать символы, просто нажмите на палитре «Символы» 
значок «Удалить ссылку на символ» (Break Link to Symbol).  
Редактируем символы 

Чтобы сделать изменение в символе, перетащите копию символа на 
рабочую область. После двойного нажатия на символ выскочит 
предупреждение, что изменения будут применены ко всем копиям символа. 
Сделайте нужные Вам изменения, палитра «Символы» обновится 
автоматически. 

 
 

ТЕМА 11. ХУДОЖЕСТВЕННЫЕ ЭФФЕКТЫ В ГРАФИЧЕСКОМ 
РЕДАКТОРЕ 

 
Растровые и векторные эффекты. Эффекты группы 3D, искажения, 

деформации, обработки контуров, стилизации. Художественные эффекты 
Photoshop. Применение и редактирование эффекта. Атрибуты оформления. 
Палитра Оформление. Добавление стилей графики на основе атрибутов 
оформления. Создание многочисленных заливок и обводок. Динамические 
эффекты. Прозрачность и режимы наложения. Палитра Прозрачность. Маска 
непрозрачности. 

 
Цель:  
- познакомиться с меню Эффекты. 
- научиться работать с настройками эффектов.  
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- освоить основы применения эффектов. 
- научиться изменять эффекты. 
- познакомиться с типами эффектов: растровыми и векторными. 
- развить интерес к предмету. 
- воспитать дисциплинированность и целеустремленность. 
- изучить палитру Appearance, познакомиться с порядком следования 

атрибутов в палитре. 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
Теория: 
- Растровые эффекты 
 - векторные эффекты  
-  Трассировка растрового изображения  
- Настройка, виды трассировки  
- Палитра Связи   
- Палитра Appearance. Создание  и редактирование многочисленных 

обводок и заливок. Порядок следования.  
Практика: 
- Создание эффектов (искажения, деформации, обработки контуров, 

стилизации, группы 3D).  
- Настройка и редактирование объектов.  
- Использование художественных эффектов Photoshop.  
- Редактирование эффекта.  
- Создание векторной иллюстрации по теме. 

 
КРАТКИЙ КОНСПЕКТ 

 
При помощи эффектов в Adobe Illustrator можно достигать разных 

художественных целей. Эффекты находятся в пункте меню «Эффект», где 
есть две подгруппы: Illustrator эффекты и эффекты Photoshop, т.е. те же 
самые эффекты, которые есть в программе Photoshop. 

В чём же их отличие? 
Главное отличие заключается в том, что Illustrator эффекты 

применяются для векторных объектов, т.е. для объектов, которые создаются 
в программе Illustrator, а эффекты Photoshop могут применяться как для 
растровых, так и для векторных объектов. Итоговый результат после 
Photoshop эффекта будет растровый. Но так как растровые элементы не 
допустимы в векторных иллюстрациях для стоков, и мы уже прошли эти 
эффекты в курсе растровой графики, давайте разберем именно векторные 
эффекты, которые можно применять на практике при создании стоковых 
изображений. 
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Векторные эффекты Illustrator делятся на следующие группы: 
• Деформация (дуга, дуга вниз, дуга вверх, арка, выпуклость, панцирь 

вниз, панцирь вверх, флаг, волна, рыба, подъём, рыбий глаз, раздувание, 
сжатие, скручивание) — при выборе эффекта открывается панель 
«Параметры деформации». При включении режима просмотр можно видеть, 
как изменяется объект. 

• Исказить и трансформировать (втягивание и раздувание, зигзаг, 
огрубление, помарки, произвольное искажение, скручивать, 
трансформировать). Данные векторные эффекты Illustrator позволяют 
создавать интересные геометрические фигуры, которые впоследствии можно 
применить в узорах. Таким образом, можно создать целый набор звёздочек, 
снежинок, маркеров, элементов узоров. Это один из самых полезных 
фильтров. 

• Контур (контурный объект, преобразовать обводку в кривые, создать 
параллельный контур). С помощью данного инструмента производятся 
различные операции с контурами изображения, например, сдвиг контура 
относительно его изначального положения, преобразование текста в контур и 
т.д. 

• Метки обрезки применяются, если нужно установить точные границы 
печати объекта. Для этого необходимо создать объект, задать непрозрачный 
цвет. Затем выбрать эффект метки обрезки, при этом появляются серые 
метки, по которым можно картинку обрезать. 

• Обработка контуров — в ней содержится такая же палитра как в пункте 
меню окно обработка контуров. А именно такие как: добавить, пересечение, 
вычитание, минус нижний, разделение, обрезка, объединение, кадрировать, 
контур, жесткое смещение, нежесткое смещение, треппинг. 

• Объёмное изображение (вытягивание и скос, вращение, поворот). 
Эффекты позволяет создавать объёмные 3D объекты, такую же работу можно 
проделать и с текстом. 

• Преобразовать в фигуру — содержит в себе прямоугольник, 
прямоугольник со скруглёнными углами, эллипс. 

• Эффект растрирования. Если векторный объект нужно перенести в 
какую-то другую программу, то уместнее его растрировать, чтобы он не 
исказился. Для этого надо выделить объект, зайти в меню эффекты, выбрать 
растрировать. При этом всплывает окно настройки растрирования 
содержащий режим цвета, фон прозрачный или белый, разрешение. Чтобы 
объект окончательно стал растрирован, для этого необходимо зайти в меню 
объект и выбрать разобрать оформление. Проверить результат растрирования 
можно через окно связи. 

• Стилизация (внешнее свечение, внутреннее свечение, каракули, 
растушевка, скруглённые углы и тень). Эффект свечение применим к 
объектам располагающимся на тёмном фоне. Внутреннее свечение может 
применяться от края и по центру, в зависимости от того какого эффекта 
нужно достичь. Каракули этот фильтр позволяет создавать эффект 
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нарисованного объекта карандашом. Растушёвка позволяет создавать 
размытые объекты. Эффект тень достаточно часто используется в дизайне в 
программах Photoshop и Illustrator. Однако, применяя данный фильтр стоит 
помнить, что эффекты тени и свечения создаются как растровый объект, что 
недопустимо в векторной иллюстрации для стоков. 

• Фильтры SVG – это фильтры основанные на математике. Если в меню 
стилизация тень получается как растровый объект, то в фильтрах SVG тень 
это такой математический объект, который программа создаёт немного по-
другому и он не зависит от разрешения. SVG фильтры нужно применять 
только после применения всех основных эффектов. 

Все векторные эффекты Illustrator, которые применяются, отображаются 
в окне оформление, где можно удалять применённый эффект, изменять его и 
редактировать. 

 
 

ТЕМА 12. ОСНОВЫ ВЕБ-ГРАФИКИ 
 

Веб-графика: особенности и ограничения. Виды веб-графики: визуал, 
фоновая графика, навигационная, логотип, фовикон, банер. Форматы 
графических изображений в Интернет. Системы представления цвета в 
Интернет (Цветовые модели. Веб-цвета). Иконографика в Adobe Illustrator.  
Подготовка графических изображений для публикации в сети Интернет. 
Оптимизация размера графического файла. 

 
Цель:  
- ознакомиться с видами Веб-графики, уметь их отличать 
- познакомиться с символами 
- познакомиться с форматами графических изображений в Интернет 
- освоить системы представления цвета в Интернет 
- научиться оптимизировать графические файлы 
- развить интерес к предмету. 
- воспитать дисциплинированность и целеустремленность. 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача домашних заданий 
Теория: 
- Веб-графика: особенности и ограничения.  
- Виды веб-графики: визуал, фоновая графика, навигационная, логотип, 

фовикон, банер.  
- Форматы графических изображений в Интернет.  
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- Системы представления цвета в Интернет (Цветовые модели. Базовые 
цвета).  

- Веб-анимация. Флэш- и gif- технологии.  
Практика: 
- Создание иконок. 
- Подготовка графических изображений для публикации в сети 

Интернет.  
- Оптимизация размера графического файла.  
- Разрезание изображения.  
- Изображения-карты. 
- Создание веб-иллюстраций по приведенным образцам. 

 
КРАТКИЙ КОНСПЕКТ 

 
 

Графика на WEB_страницах 
Визуальное представление позволяет осуществлять наиболее быструю 

передачу информации, обеспечивая также быстрое её восприятие 
наблюдателем (читателем) как непосредственно, так и с использованием 
принятых в мировой культуре источников информации (книги, газеты, кино, 
телевидение, Интернет). Манипулируя цветом, контрастом и символами, 
можно за долю секунды вызвать у наблюдателя ощущение тепла либо 
холода, спокойствия или напряженности, а вместе с тем даже передать 
некоторые сведения. Важную роль в графической передаче информации 
играют ассоциации - определённые образы, всплывающие в сознании 
пользователя в моменты, когда он видит некоторые символы или систему 
графических объектов. 

Стиль Интернет-сайта определяется сочетанием текста, графики и 
активных элементов (формуляры, диалоговые окна, мультимедиа). 
Существенным является также подбор компонентов, их свойств (размер, 
цвет) и способов размещения на странице.  

Графика — вторая по важности и по значимости после текста материя, 
составляющая содержание сайтов. Исторически сложилось так, что первыми 
во Всемирной паутине прижились растровые графические форматы, 
но позже подтянулись и векторные. 

Веб графику можно поделить на два типа: статическую и динамическую. 
Статическая графика — это неподвижные изображения: фотографии, 
рисунки, схемы, различные элементы веб-страниц. Динамическая – это 
анимации, интерактивная графика и т.д. 

Цветовые модели (См. занятие 1) 
· RGB 
· HSL, HSB 
· CMY, CMYK 
Безопасная цветовая палитра 
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Безопасная цветовая палитра - это набор из 216 цветов, общих для всех 
инструментальных платформ. Картинки, отображаемые на мониторах 
компьютеров, способных правильно передать 256 цветов (8-битовая 
графика), отображаются правильно (и предсказуемо) и при условии 
применения 216 безопасных цветов. Остальные краски передаются как смесь 
компонентов из безопасной палитры. 

Вопрос адекватного отражения цветов имел большое значение 
несколько лет назад, когда в повсеместном использовании были компьютеры 
с 8-битовой графической картой. Хорошим тоном считалось применение на 
Web_страницах именно безопасного цветового набора. Теперь же мы все 
пользуемся 24-битовой графикой. Поэтому кажется более целесообразным 
использовать всю полноту возможностей, представляемых современными 
компьютерами, и применять на Web_страницах различные сочетания цветов, 
в том числе и тех, что выходят за рамки безопасной палитры. 

Типовые графические элементы Web_страниц: визуал, фоновая графика, 
навигационная, логотип, фовикон, баннер и т.д. 

· Фон 
Желая изменить применяемый по умолчанию фон HTML_документа 

или его фрагмента (например, ячеек таблицы), автор страницы может 
произвольно задать цвет фона или указать, какой графический файл был 
использован для «обивки» окна браузера. Файл фоновой графики не должен 
быть большим. Если предлагается однотонный фон, то лучше предусмотреть 
задание цвета фона в кодах HTML. Лучше всего выглядят страницы с фоном 
в пастельных тонах, элементы которого сливаются в однородно окрашенную 
поверхность. При использовании тёмного фона шрифт должен быть ярким. 

· Иллюстрационная графика 
Говоря о включении графики в Web_страницу, чаще всего имеют в виду 

размещение в документе Иллюстрации или фотоснимка. Картинки для 
включения в HTML_документ могут быть записаны в разных форматах, 
следовательно, могут иметь разные свойства. Ниже перечислены простые 
технологии, широко используемые для получения интересных эффектов на 
Web_страницах и полного использования свойств картинок: 

1) Размещение иллюстрации с прозрачным фоном. Изображение, 
«наложенное» на документ, выглядит значительно лучше. Иллюстрация 
отлично вписывается в документ независимо от изменения цвета фона 
Web_страницы. Фон страницы (цвет, рисунок) служит и фоном для 
размещённой картинки. 

2) Анимация на Web_страницах служит чаще всего для украшения. 
Иногда анимация применяется для поэтапного представления информации - 
в отдельных кадрах последовательно отображается слова какой-нибудь 
надписи или открывается все больший фрагмент изображения. Этот эффект 
привлекает и удерживает внимание наблюдателя. Типовым форматом записи 
анимации для Web_страниц является GIF. 
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3) Галерея миниатюр. Выводя на Web_страницу галерею фотоснимков, 
нужно предусмотреть наличие дополнительного документа, содержащего эти 
самые фотоснимки в уменьшенном размере или же фрагменты этих 
фотоснимков. Каждая миниатюра является ссылкой на файл, в котором 
записано данное изображение, и щелчок клавиши мыши над миниатюрой 
начинает загрузку фотоснимка в окон Интернет-браузера. Галереи миниатюр 
создаются с целью быстрого ознакомления пользователя со всеми 
картинками и облегчения выбора фотоснимка, предлагаемого к загрузке в 
оригинальном размере. 

4) Рассечение картинки. Часто получается так, что компрессия 
графических файлов приносит намного лучшие результаты (увеличение 
степени сжатия), если сжимать маленькие картинки, а не большие 
изображения. Большие изображения рекомендуется рассекать на меньшие 
фрагменты. Сохранение каждого фрагмента в своём файле иногда позволяет 
значительно уменьшить количество байтов, которые пользователь будет 
вынужден загружать с Web_сервере для просмотра картинки в оригинальном 
размере. Восстановление изображения, происходит по принципам загрузки 
отдельных фрагментов в ячейки таблицы. 

· Клавиша, кнопка 
Важным графическими элементами на Web_страницах являются 

клавиши навигации. Это небольшие картинки, представляющие собой 
ссылки к другим документам или сценариям (скриптам). Щелчок клавиши 
мыши на такой клавише обычно вызывает загрузку другого документа, 
пересылку содержимого формуляра или выполнение сценария. Интересный 
эффект при использовании клавиши навигации можно получить, 
предусмотрев изменения её графического вида при наведении курсора на 
клавишу и возврата изображения в начальное состояние при отведении 
курсора из области клавиши. Этот простой эффект реализуется с помощью 
операторов языка JavaScript. Документ, оснащённый таким механизмом, 
приобретает черты динамичности. 

Клавиши навигации являются графическими элементами, которые 
должны хорошо вписываться в фон страницы, и вместе с тем выделятся и 
облегчать навигацию в Интернете благодаря единообразию их 
интерпретации. 

· Рекламный баннер 
Прямоугольные картинки, содержащие рекламу или визитки Интернет-

сайтов, называются баннерами (banner - знамя, транспарант). Целью 
размещения баннеров на Web_страницах является приглашение интернавта 
посетить рекламируемую страницу. Очень часто баннеры насыщенны 
анимацией - ведь они «обязаны» бросаться в глаза. 

Чаще всего баннеры бываю следующих размеров: 400*50, 468*60 
пикселей, или более мелкие - 120*40 пикселей и т.д. Очень важно, чтобы 
размер файла, в котором записан баннер, не был большим. Считается, что 
хороший баннер (т.е. такой, который быстро загружается в браузер) не 
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должен быть больше 10-15 кбайт. На практике же строгих ограничений не 
существует. 

Favicon (сокр. от англ. FAVorite ICON — «значок для избранного») — 
значок веб-сайта или веб-страницы. Отображается браузером во вкладке 
перед названием страницы, а также в качестве картинки рядом с закладкой, 
во вкладках и в других элементах интерфейса. (favicon.by) 

Иконографика — особая форма коммуникации. Она дополняет 
визуальный язык бренда, поэтому пользовательский набор иконок гораздо 
выразительнее и привлекательнее стандартного. 

Главное в дизайне логотипов или иконок — это ничего не усложнять. 
Часто говорят, что иллюстрация стоит тысячи слов. Это особенно 
справедливо по отношению к иконкам. Замещая собой слова и целые 
предложения, они оптимизируют визуальное пространство, улучшают 
юзабилити и эстетическое восприятие. Умение создавать наборы простых и 
полезных иконок всегда пригодится. 

Анимация - это изменения в движении. Анимация на сайте может не 
только помочь произвести хорошее впечатление и заинтересовать 
посетителя, но и оживить вид сайта и изложить материал наиболее понятно. 
Это может быть разнообразные анимированные меню, заставки и шапки 
сайтов. C развитием html5 анимация на сайтах стала еще более 
увлекательной и интересной. 

Подготовка графических изображений для публикации в сети Интернет. 
Оптимизация размера графического файла.  

Графическая информация передается намного медленнее текстовой, а 
время загрузки изображений пропорционально размеру их графических 
файлов. Поэтому для быстрой загрузки Web-страниц требуется небольшой 
размер внедренных в них графических изображений, что достигается за счет 
их оптимизации. Под оптимизацией изображения понимают его 
преобразование, обеспечивающее минимальный размер файла при 
сохранении необходимого в данном конкретном случае качества 
изображения. В целом оптимизация достигается за счет уменьшения 
количества цветов в графических изображениях, использования сжатых и 
специальных форматов файлов и оптимизации параметров сжатия для 
отдельных фрагментов изображений. Основная задача оптимизации — найти 
удачный компромисс между скоростью загрузки страницы и качеством 
представленных на ней изображений. Более подробно вы познакомитесь с 
оптимизацией в курсе веб-дизайна. 

Разрезание изображения. Изображения-карты. 
Разрезание изображения на фрагменты с последующим их 

объединением в одну целую картинку — давний прием, вошедший в арсенал 
вёрстки веб-страниц. Предварительно подготовленный рисунок разрезают на 
части в графическом редакторе, сохраняют части как отдельные графические 
изображения, а затем соединяют их вместе с помощью таблицы. 

Плюсы разрезания изображений: 
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Создание ссылок 
Отдельные рисунки при необходимости можно превращать в ссылки, 

причём для них можно назначать своё описание (атрибут title) и 
альтернативный текст (атрибут alt), который виден при отключении показа 
картинок в браузере или при наведении курсора мыши на изображение.  

Эффект перекатывания 
Набор отдельных фрагментов позволяет создавать эффект 

перекатывания — динамическое изменение одного рисунка на другой при 
наведении на него курсора мыши, и обратно на прежний, когда курсор 
уводится прочь. 

Уменьшение объема файлов 
Отдельными частями изображения удобней манипулировать, подбирая 

для них графический формат и его параметры таким образом, чтобы объём 
файла был минимален при сохранении приемлемого качества изображения. В 
итоге набор графических файлов будет занимать меньше места, и 
загружаться быстрее, чем один файл, содержащий целый рисунок. 

Анимированный GIF 
Использование анимированного GIF-a для изображений большого 

размера чревато существенным увеличением объёма файла. Но можно пойти 
на хитрость и заменить лишь часть изображения анимацией, а остальные 
фрагменты оставить статичными. При этом общий объём нескольких файлов 
будет гораздо меньше, чем анимирование одного изображения. 

Особенности вёрстки 
Изображения на веб-странице по своей природе прямоугольны, но, 

разрезав один рисунок на составляющие элементы, получим конструктор, из 
которого можно сложить другую фигуру. Это напоминает детские кубики, на 
одну из сторон которых наклеена картинка. Складывать подобные фигуры на 
веб-странице требуется в силу разных причин, например, вместо фрагмента 
изображения требуется добавить текст. Кроме того, некоторые рисунки 
можно заменить их фоновым аналогом и тогда конечное изображения, 
сохраняя свою целостность, будет занимать всю доступную область 
документа. 

Психологический аспект 
Когда один рисунок состоит из множества фрагментов, то браузер 

скачивает их в несколько потоков и показывает те, которые загрузились в 
первую очередь. Поэтому изображение появляется как элементы мозаики. А 
это сразу привлекает внимание и кажется, что загрузка происходит быстрее. 
Так что с технической стороны один рисунок грузится быстрее, а с позиции 
человеческого восприятия кажется, что набор маленьких рисунков быстрее 
появляется. 

 
ТЕМА 13. ИНФОРМАЦИОННАЯ ГРАФИКА 

 Диаграммы и графики. Типы графиков и диаграмм. Создание объектов 
инфографики. Настройка и редактирование объектов. Использование 
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декоративных элементов. Представление о перспективе. Инструмент Сетка 
перспективы. Добавление и редактирование объектов и текста в перспективу.  

 
Цель:  
- познакомиться с группой инструментов Graph (Графики, Диаграммы). 
- научиться работать с 9-ю видами диаграмм.  
- освоить основы построения диаграмм и графиков. 
- научиться вводить данные в диаграмму. 
- познакомиться с типами диаграмм. 
- узнать о различных способах выделения элементов диаграммы. 
- научиться добавлять к диаграмме легенды и категории. 
- научиться использовать декоративные элементы в диаграммах. 
-освоить инструмент Сетка перспективы. 
- развить интерес к предмету. 
- воспитать дисциплинированность и целеустремленность. 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
- подведение итогов 
- выдача домашних заданий 
Теория: 
- Диаграммы и графики.  
- Типы графиков и диаграмм.  
- Представление о перспективе.  
- Инструмент Сетка перспективы.  
Практика: 
- Создание объектов инфографики.  
- Настройка и редактирование объектов.  
- Использование декоративных элементов. 
- Добавление и редактирование объектов и текста в перспективу.  
 
 

КРАТКИЙ КОНСПЕКТ 
 

Основы построения диаграмм 
Что такое диаграмма 
Диаграмма, созданная в программе Illustrator, представляет собой 

совокупность сгруппированных объектов, которые можно воспринимать как 
обычные векторные объекты. Это означает, что можно изменять, перемещать 
и трансформировать все доступные параметры объектов. Ничем не 
ограниченная возможность модификации диаграммы позволяет из 
первоначально созданного варианта (стоит признаться, что он не производит 
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особого впечатления) получить настоящий шедевр и добиться 
неповторимости результата. 

При этом следует иметь в виду, что после выполнения команды Ungroup 
(Разгруппировать) из меню Object (Объект) редактировать диаграммы как 
единое целое становится уже невозможным. Кроме того, при вводе новых 
исходных данных диаграмма автоматически перестраивается, и это зачастую 
вызывает нежелательные изменения во внешнем оформлении диаграммы. 
Поэтому и разгруппировку элементов диаграммы и работу над ее внешним 
видом следует осуществлять на самом последнем этапе. 

Типы диаграмм 
Для работы с диаграммами в программе Illustrator предусмотрена группа 

инструментов Graph Tool, внутри которой находятся инструменты для 
создания девяти типов диаграмм:  

• Column (Вертикальные полосы) — обычная гистограмма, 
отображающая значения различных параметров;  

• Stacked Column (Вертикальный стек) — гистограмма с накоплением, 
которая отражает вклад каждого параметра в общую сумму; 

• Bar (Горизонтальные полосы) — гистограмма, столбцы которой 
располагаются горизонтально;  

• Stacked Bar (Горизонтальный стек) — гистограмма с накоплением с 
горизонтальным расположением столбцов;  

• Line (Линейный график) — линейная диаграмма, задача которой — 
отобразить динамику изменения дискретных значений некоторого параметра 
в определенные интервалы времени;  

• Area (Аддитивный график) — диаграмма с областями накопления, 
отображающая изменение как общей суммы, так и влияние отдельных 
значений;  

• Scatter (Точечная диаграмма) — диаграмма рассеяния, которая может 
применяться для отображения данных, отклоняющихся от какого-либо 
значения; 

• Pie (Круговая диаграмма) — круговая диаграмма, отображающая 
процентное соотношение каждого значения по отношению к общей сумме;  

• Radar (Радар) — так называемая паутинная диаграмма, которая обычно 
применяется для отображения сравнительных значений во времени или по 
категориям.  

 Сначала может показаться, что девять типов диаграмм — это не 
слишком много, но это совсем не так — разнообразие диаграмм, которые 
можно построить на их основе, может удовлетворить самого взыскательного 
дизайнера. Количество же возможностей столь велико, что рассмотреть их в 
рамках статьи совершенно нереально, поэтому мы остановимся лишь на 
основных и наиболее интересных моментах. 

Создание диаграммы 
Технология создания простой диаграммы не отличается сложностью. 

Вначале необходимо выбрать соответствующий инструмент для построения 
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желаемого типа диаграммы на панели инструментов, затем очертить им 
прямоугольную область, которую предположительно должна занимать 
диаграмма, ввести данные (под данными подразумеваются не только 
числовые значения, но и метки, на основе которых создаются подписи) в 
открывшейся таблице (рис. 3) и щелкнуть на кнопке Apply (Применить). 

 Ввод данных 
Данные для диаграммы можно ввести непосредственно в программе 

Illustrator либо импортировать их или скопировать через буфер обмена. 
Следует иметь в виду, что у каждого типа диаграмм имеются свои 
особенности ввода меток и числовых значений:  

• у диаграмм Column и Stacked Column числовые данные вводят по 
вертикали, а метки — по горизонтали; у диаграмм Column возможно наличие 
как положительных, так и отрицательных значений, а у Stacked Column — 
только положительных или только отрицательных; 

• у диаграмм Bar и Stacked Bar числовые данные вводят по горизонтали, 
а метки — по вертикали; у диаграмм Bar возможно наличие как 
положительных, так и отрицательных значений; у Stacked Bar — только 
положительных или только отрицательных; 

• у диаграммы Line числовые данные (возможно сочетание 
положительных и отрицательных значений) вводят по вертикали, при этом 
каждая колонка данных будет интерпретирована как отдельная линия 
диаграммы; 

• для построения диаграммы Area требуется не менее двух строк данных 
— они могут быть как положительными, так и отрицательными; каждая 
строка данных интерпретируется как отдельная заполненная область;  

• у диаграммы Scatter значения по вертикали вводят в первый столбец, а 
значения по горизонтали — во второй. У этого типа диаграмм обе оси имеют 
«измерительный» характер, поэтому у нее нет категорий. Если первую 
колонку занимают метки, то она игнорируется, а данные из второй колонки 
интерпретируются как данные для оси Y;  

• у диаграммы Pie вводят только одну строку данных — только 
положительных или только отрицательных; при вводе большего числа строк 
для каждой строки формируется отдельная диаграмма меньшего размера;  

• при построении диаграммы Radar метки для осей вводят в первый 
столбец, а числовые данные — в следующие столбцы; каждая метка 
интерпретируется как отдельная ось, а каждое числовое значение отмечается 
на своей числовой оси и пересекается с другими, образуя своеобразную 
паутину.  

Прежде всего рассмотрим вариант ручного ввода данных и для примера 
попробуем построить диаграмму типа Column. На панели инструментов 
выберите данный тип диаграммы, очертите прямоугольную область для 
диаграммы, введите числовые данные для самих столбцов (рис. 4), щелкните 
на кнопке Apply (Применить) и закройте таблицу с данными. В итоге вы 
получите диаграмму без подписей и заголовка.  
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 Область диаграммы можно определять и по-другому — следует 
выбрать тип диаграммы на палитре инструментов, дважды щелкнуть на 
рабочей области и ввести значения Width (Ширина) и Height (Высота) в окне 
Graph (Диаграмма) Данные для диаграммы вводить вручную не обязательно 
— их можно скопировать из других программ, работающих с табличными 
данными, например из Excel, через буфер обмена или импортировать. 
Выделите всю диаграмму инструментом Selection (Выделение), вызовите 
таблицу данных при помощи команды Data (Данные) из меню Object=>Graph 
(Объект=>Диаграмма), переключитесь в имеющуюся таблицу с данными, 
скопируйте данные без заголовков в буфер обмена обычным образом, 
вернитесь обратно в программу Illustrator, установите курсор в таблице на 
первую ячейку первого столбца и вставьте данные из буфера обмена 
командой Edit=>Paste (Редактирование=>Вставить). Щелкните на кнопке 
Apply (Применить), и тогда диаграмма изменится, но совсем не так, как 
хотелось бы — вместо того, чтобы оказаться в легенде, подписи данных 
будут находиться под столбцами горизонтальной оси. Чтобы исправить 
положение, транспонируйте строки и столбцы, щелкнув на кнопке Transpose 
row/column (Транспозиция строк/столбцов), а затем вновь на кнопке Apply 
(Применить). 

Можно пойти и другим путем и импортировать данные. Но в этом 
случае придется предварительно сохранить их в текстовом файле с учетом 
определенных правил: значения каждой ячейки в строке должны быть 
разделены при помощи табуляции, каждая строка должна заканчиваться 
нажатием клавиши Enter, в качестве разделителя целой и дробной частей 
может использоваться только точка. Для импорта данных в диалоговом окне 
Graph Data (Данные диаграммы) щелкните на кнопке Import Data (Импорт 
данных) и в открывшемся диалоговом окне укажите файл с данными. 

Выделение элементов диаграммы 
Как уже было отмечено выше, построенная в программе Illustrator 

диаграмма представляет собой набор векторных объектов, к которым можно 
применять почти все действия, допустимые в отношении векторных 
контуров. Это позволяет добиться эффектного оформления диаграммы. 

Для изменения параметров элементов группы, например первой группы 
столбцов, они выделяются с помощью инструментов Group Selection 
(Групповое выделение в группе): один щелчок на любом из элементов 
группы выделяет данный элемент, а еще один щелчок — все элементы 
группы. Можно также выделять элементы инструментом Direct Selection 
(Частичное выделение) при нажатой клавише Shift, но это будет медленнее, 
так как щелкать придется по каждому элементу выделяемой группы.  

Добавление к диаграмме легенды и категорий 
Для ввода данных, которые должны отобраться в легенде или 

категориях (их называют метками), существуют определенные правила:  
1. Данные для легенды вводятся по горизонтали в самой верхней 

строке, а данные для категорий — по вертикали в первом столбце. 
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Исключение составляет диаграмма Scatter, в которой категории не 
используются. 

2. Если в диаграмме будут фигурировать и легенда, и категории, то 
левая верхняя ячейка таблицы не заполняется. 

3. Метки, состоящие только из цифр, заключаются в кавычки — 
иначе они будут восприниматься программой как числовые данные. Для 
меток, включающих буквы и цифры, кавычки не требуются.  

4. Для разбиения текста меток на несколько строк в месте деления 
строк необходимо ставить вертикальную черту «|».  

Вернемся к диаграмме на рис. 5 и попробуем придать ей более 
привлекательный вид с учетом вышеперечисленных правил. Вначале 
добавим к ней легенду, для чего нужно выделить всю диаграмму 
инструментом Selection, вызвать таблицу данных при помощи команды Data 
(Данные) из меню Object=>Graph (Объект=>Диаграмма), выделить мышью 
введенные ранее числовые значения, вырезать их в буфер обмена командой 
Edit=>Cut (Редактирование=>Вырезать), переместить маркер мыши в первый 
столбец второй строки и вставить данные посредством команды Edit=>Paste 
(Редактирование=>Вставить). 

 
ТЕМА 14. ИМПОРТ И ЭКСПОРТ ИЗОБРАЖЕНИЙ. ДОПЕЧАТНАЯ 

ПОДГОТОВКА 
Импорт векторных, растровых изображений. Работа с растровыми 

изображениями в Illustrrator. Способы переноса растровых рисунков. 
Связанные файлы. Палитра Связи.  Трассировка растрового изображения. 
Настройка, виды трассировки. Импорт текста. Экспорт из Adobe Illustrator. 
Сочетание графики Adobe Illustrator и Photoshop. Допечатная подготовка. 
Настройка параметров печати (цветовые модели, разрешение, форматы, 
обрезка, вывод, программная настройка принтеров). 

 
Цель:  
- научиться работать с растровыми и векторными файлами совместно. 
- узнать о различных способах экспорта и импорта изображений. 
- научиться трассировать растровое изображение. 
-освоить палитру Связи 
- освоить механизмы допечатной подготовки. 
- развить интерес к предмету. 
- воспитать дисциплинированность и целеустремленность. 
План: 
- организационный момент 
- сообщение темы и цели занятия 
- изучение материала 
- закрепление на практике 
Теория: 
- Экспорт файлов из Adobe Illustrator. 
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- Импорт файлов в Adobe Illustrator.  
- Сочетание графики Adobe Illustrator и Photoshop.  
- Трассировка растрового изображения.  
- Настройка, виды трассировки.  
- Палитра Связи.   
Практика: 
- Работа со связанными файлами 
-Допечатная подготовка. 
 

КРАТКИЙ КОНСПЕКТ 
Сочетание графики Adobe Illustrator и Photoshop. Связанные файлы. 
В Adobe Illustrator можно открывать или помещать файлы Photoshop, 

поэтому нет необходимости сохранять или экспортировать изображение 
Photoshop в другой формат файла. Помещая изображение в открытый файл 
Illustrator, можно встроить его как любой другой обычный элемент 
иллюстрации либо сохранить его связь с исходным файлом. Хотя Illustrator 
не редактирует связанное изображение, можно вернуться в Photoshop с 
помощью команды «Изменить исходный файл», чтобы внести изменения в 
оригинал. После сохранения изменений они отображаются в версии 
изображения, находящейся в Illustrator. 

1. Если файл изображения открыт в Photoshop, сохраните его как 
Photoshop (PSD) и закройте файл. 

2. В Adobe Illustrator выполните одно из следующих действий.  
o Чтобы открыть файл непосредственно в Illustrator, выберите 

«Файл» > «Открыть». Укажите путь к изображению в диалоговом окне 
«Открыть файл» и нажмите кнопку »Открыть». 

o Чтобы встроить изображение в существующий файл Illustrator, 
выберите «Файл» > «Поместить». Укажите путь к файлу в диалоговом окне 
«Поместить», убедитесь, что параметр «Связать» не выбран, и нажмите 
кнопку »Поместить». 

o Чтобы поместить изображение в файл с сохранением связи с 
оригиналом, выберите «Файл» > «Поместить». В диалоговом окне 
«Поместить» укажите путь к файлу, выберите параметр «Связать» и нажмите 
кнопку »Поместить». Illustrator размещает изображение по центру в открытой 
иллюстрации. Красный значок X, перечеркивающий изображение, указывает 
на то, что изображение связано с оригиналом и не может быть изменено. 

3. При открытии или помещении изображения без сохранения связи 
отображается диалоговое окно «Импорт Photoshop». Выберите 
соответствующий параметр, как показано ниже, и нажмите кнопку «ОК»:  

o «Преобразовать слои Photoshop в объекты» предназначен для 
преобразования слоев в объекты Illustrator. При выборе этого параметра 
сохраняются маски, режимы наложения слоев, прозрачность, а также 
(дополнительно) фрагменты и карты ссылок. Однако этот параметр не 
поддерживает корректирующие слои и слои-эффекты Photoshop. 
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o «Выполнить сведение слоев Photoshop в единое изображение», 
чтобы объединить все слои в один. При выборе этого параметра сохраняется 
внешний вид изображения, но отдельные слои редактированию уже не 
подлежат. 

 Экспорт и импорт файлов Adobe Illustrator. 
В создании, трансформировании и передаче графической информации 

рационально использовать изображения и тексты других программ и других 
форматов. Поэтому программа Adobe Illustrator располагает процедурами 
обмена информации — импортом (использование материалов, 
подготовленных другими средствами, например, программами точечной 
графики) и экспортом (подготовка материалов для программ другого класса, 
например, программ верстки).  

В качестве эквивалента для обмена служат стандартные форматы 
файлов, и программа Adobe Illustrator может работать практически со всеми 
популярными форматами, отчасти еще и потому, что фирма Adobe сама 
является «законодателем мод» в этой области.  

Программа Adobe Illustrator может работать с такими форматами, как 
EPS (Encapsulated PostScript), СОМ (Computer Graphics Metafile), WMF 
(Windows Metafile), CorelDraw 5/6, CMX, Amiga IFF, BMP, GIF89a, PCX, 
JPEG, PICT, TIFF, Acrobat PDF (Portable Document Format), PostScript, 
PhotoCD, MacPaint, PixelPaint, PNG и TGA.  

Буфер обмена Clipboard  
Простейшим средством обмена информации является буфер обмена 

Clipboard, который может вполне выполнять некоторые задачи: переносить 
тексты между программой Adobe Illustrator и практически всеми текстовыми 
редакторами и программами верстки, обеспечивать копирование контуров 
между программой Adobe Illustrator и программами Adobe Photoshop, Adobe 
Streamline, Adobe Dimensions и Adobe Premiere (с использованием описания 
языка PostScript), конвертировать векторные контуры в точечные 
изображения и передавать их в соответствующие программы.  

Технология «drag-and-drop»  
Технология «drag-and-drop» («перенести и бросить» — «буксировка») 

позволяет переносить информацию из одной программы в другую буквально 
вручную в следующих случаях: если векторный объект переносится из 
одного документа программы Adobe Illustrator в другой, если векторный 
объект переносится на поверхность «рабочего стола» операционной среды, 
откуда он может быть также «отбуксирован» в другую программу, если 
графическая информация обменивается между программами Adobe Illustrator 
и Adobe Photoshop 4.0.  

Для буксировки выделенного объекта программы Adobe Illustrator в 
программу Adobe Photoshop необходимо открыть в ней нужный документ и 
«перетащить» объект. Он будет размещен в центре документа на активном 
слое.  
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Для перемещения векторного объекта в программу Adobe Photoshop в 
качестве векторного необходимо при «буксировке» удерживать клавишу 
<Ctrl>.  

Команды Open... (Открыть...) и Place... (Поместить...)  
Помимо перемещения отдельных изображений или объектов с помощью 

буфера обмена Clipboard или простой буксировки с помощью технологии 
«drag-and-drop» в программе Adobe Illustrator обеспечивается возможность 
открытия или импортирования документов, созданных в других программах.  

Команда Open... (Открыть...) меню File (Файл) открывает документы, 
созданные другими программами, в качестве нового документа программы 
Adobe Illustrator, используя чаще всего установки по умолчанию.  

Она выводит на экран диалоговое окно Open (Открыть), в котором 
происходит навигация по иерархии файловой структуры и поиск нужной 
папки и файла.  

Команда Place... (Поместить...) импортирует документ в открытый 
активный документ программы Adobe Illustrator и делает это двумя 
способами: с установлением связи с исходным документом (в этом случае 
изображение в документ программы Adobe Illustrator не включается) и без 
установления такой связи (в этом случае изображение внедряется в документ 
программы Adobe Illustrator и увеличивает размер файла).  

Диалоговое окно Place (Поместить) отличается от диалогового окна 
Open (Открыть) только наличием флажка Link (Связать), который установлен 
по умолчанию.  

При размещении изображений в формате EPS этот флажок следует 
оставить установленным в том случае, если дальнейшего редактирования 
изображения не требуется (в документ помещается только условное 
изображение в виде прямоугольника с диагоналями), а если необходима 
работа как с векторным контуром, то этот флажок следует удалить. 

Редактирование связанных изображений  
Достоинством связанных изображений является возможность 

редактирования средствами исходной программы и автоматическое 
изменение в документе программы Adobe Illustrator при последующем 
открытии документа. Более того, при этом все трансформации, которые 
применялись к предыдущему варианту (масштабирование, вращение или 
сдвиг), сохраняются и в отношении нового варианта. Для того чтобы 
отредактировать связанное изображение, общий порядок таков: следует 
закрыть документ программы Adobe Illustrator, затем загрузить программу, в 
которой возможно редактирование данного изображения, выполнить 
редактирование и сохранить документ с тем же названием и в той же папке, а 
затем снова открыть документ программы Adobe Illustrator. Программа 
автоматически осуществит обновление изображения.  

К недостаткам связанных документов относится необходимость при 
передаче документа программы Adobe Illustrator на другой компьютер 
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«беспокоиться» о комплектности документов и возможных нестыковках 
адресов файлов.  

Экспорт изображений  
Для экспорта изображении в формат Illustrator EPS используются 

команды Save As... (Сохранить как...) или Save а Сору... (Сохранить копию...), 
а для остальных форматов — команда Export... (Экспортировать...) меню File 
(Файл).  

Сохранение документа в форматах предыдущих версий программы 
Adobe Illustrator  

Многие программы позволяют непосредственно импортировать 
документы программы Adobe Illustrator, но в результате «чехарды» версии 
может оказаться, что требуется документ в одной из предыдущих версий.  

Для сохранения документа в предыдущей версии следует использовать 
команду Save As... (Сохранить как...) меню File (Файл), которая после 
присвоения имени файла в одноименном диалоговом окне выводит на экран 
еще одно диалоговое окно Illustrator Format (Формат Illustrator), в котором 
можно выбрать формат одной из предыдущих версий программы.  

Если в документе содержатся элементы, которые не могут найти 
адекватного воплощения в формате предыдущей версии, на экран будет 
выведено общее предупреждение.  

Сохранение документа в формате EPS  
Формат EPS является самым универсальным форматом для обмена 

информацией с другими приложениями, поскольку практически все 
текстовые редакторы, программы верстки и графики могут его 
импортировать, при этом сохраняются все графические элементы и цветовые 
параметры. Для сохранения документа в формате EPS следует использовать 
команду Save As... (Сохранить как...) меню File (Файл), которая после 
присвоения имени файла в одноименном диалоговом окне выводит на экран 
еще одно диалоговое окно EPS Format (Формат EPS), в котором 
определяются некоторые параметры документа.  

В поле Compatibility (Совместимость) можно выбрать формат одной из 
предыдущих версий.  

В поле Options (Варианты) с помощью флажков определяются 
следующие функции.  

• Флажок Include Placed Files (Включить помещенные файлы) 
обеспечивает установление в EPS-файл изображений, которые были 
импортированы в исходный документ программы Adobe Illustrator, например, 
точечные изображения.  

• Флажок Include Document Thumbnails (Включить миниатюру) 
обеспечивает создание небольшого изображения, которое отображается в 
диалоговом окне Open (Открыть) и помогает пользователю быстрее находить 
нужные документы.  

• Флажок Use Japanese File Format (Сохранить в японском формате) 
используется для сохранения документа с японскими иероглифами.  
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• Флажок Include Document Fonts (Включить шрифты документа) 
обеспечивает сохранение документа вместе с необходимым набором 
шрифтов.  

Сохранение документа в формате JPEG  
Формат JPEG вполне пригоден для сохранения полноцветных 

изображений, особенно если они предназначаются только для отображения 
на экране монитора, например, такие изображения широко используются в 
сети Internet. В некоторых случаях, например, для передачи градиентных 
растяжек, этот формат экономнее формата GIF.  

Для сохранения документа в формате JPEG используется команда 
Export... (Экспортировать...) меню File (Файл), которая после присвоения 
имени файла в одноименном диалоговом окне выводит на экран еще одно 
диалоговое окно JPEG Options (Параметры файла JPEG), в котором 
определяются некоторые параметры документа.  

В поле Image (Изображение) определяется соотношение между объемом 
файла и качеством изображения: чем лучше требуется качество изображения, 
тем больший объем для него необходим и наоборот. Качество условно 
обозначается в числовом виде в диапазоне от 0 (низкое качество) до 10 
(максимально возможное качество).  

В поле Options (Варианты) с помощью переключателей выбирается 
способ сжатия информации: Baseline (Standard), Baseline Optimized, 
оптимизирующий цветопередачу, и Progressive, позволяющий создавать 
несколько изображений с различным разрешением, которые поочередно 
выводятся на экран (используются в сети). В поле Scans (Чередование строк) 
указывается количество таких изображений.  

При установлении флажка Imagemap (Карта изображения) становятся 
доступными переключатели, позволяющие оформить документ, пригодный 
для Web-страниц (или для программ, которые их создают).  

Переключатель Client-side (.html) (Для клиентов) обеспечивает создание 
изображения, которое может использоваться в программах, создающих Web-
страницы. В этом случае создаются два файла: один в формате .GIF (он 
содержит изображение) и другой в формате .HTML (он содержит ссылку на 
файл с изображением). Необходимо, чтобы эти файлы располагались в одной 
и той же папке. Название файла в формате .HTML может быть изменено в 
поле Anchor (Привязка).  

Переключатель Server-side (.map) (Для сервера) обеспечивает создание 
изображения, которое загружается на Web-сервере.  

Другие форматы файлов Формат TIFF  
Формат TIFF (Tagged Image File Format) был создан в качестве 

универсального формата для изображений с цветовыми каналами (файл с 
расширением .TIF). Важным достоинством этого формата является его 
переносимость на разные платформы (при сохранении вы можете создать 
документ, доступный для чтения на компьютерах, совместимых с IBM PC 
или Macintosh), он импортируется во всех программах настольных 
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издательских систем, его можно открыть и с ним работать практически в 
любой программе точечной графики.  

Этот формат имеет самый широкий диапазон передачи цветов: от 
монохромного до 24-битовой модели RGB (True Color) и 32-битовой 
цветоделенной модели CMYK.  

Кроме того, формат может включать и схемы сжатия для уменьшения 
размера файла (при сохранении доступна опция LZW Compression 
(Уплотнение LZW)), что является немаловажным параметром для работы с 
полноцветными изображениями большого размера.  

Этот формат имеет открытую архитектуру, это значит, что в формате 
предусмотрена возможность в заголовке объявлять информацию о типе 
изображения, а значит и записывать можно будет то, что сейчас еще не 
известно. (Как нотная тетрадь не знает, что на ней будет записано).  

К примеру, в формате TIFF могут сохраняться сопроводительные 
подписи, стандарт которых разработан Ассоциацией Газет Америки (NAA) и 
Международным Советом Телекоммуникаций Прессы (IPTC) для 
идентификации передаваемых текстов и изображений.  

На эту возможность следует обратить внимание: при передаче 
изображений заказчикам, в издательства, «в другие руки» неплохо 
сопровождать их достаточной информацией о содержании, необходимой 
обработке, авторских правах и так далее.  

К сожалению, достоинства, как правило, — основа для недостатков: 
универсальность, гибкость и открытость формата TIFF приводит к 
неограниченному разнообразию вариантов формата. Поэтому лучше всего 
сначала проверить совместимость на простых файлах.  

Формат PCX  
Формат, разработанный фирмой Z-Soft для программы PC PaintBrush, 

является одним из самых известных, и практически любое приложение, 
работающее с графикой, легко импортирует его. Формат неплох для 
штриховых изображений и изображений с индексированными цветами, 
поскольку несколько упрощен по сравнению с TIFF. Он содержит только 
один канал. Есть и другие недостатки, которые препятствуют использованию 
этого формата для профессиональной работы с цветом.  

Формат BMP  
Формат предназначен для Windows, и поэтому поддерживается всеми 

приложениями, работающими в этой среде. Он использует только 
индексированные цвета, независим от платформы, не поддерживает каналы. 
Применяется в основном для создания значков и пиктограмм, которые 
отображаются в диалоговых окнах приложений. Для профессиональной 
работы с цветом мало пригоден.  

Формат PDF  
Формат PDF (Portable Document Format) также является разработкой 

фирмы Adobe как средство электронного распространения документов на 
платформах Macintosh, Windows, Unix и DOS. Файлы в этом формате 
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создаются, редактируются и просматриваются с помощью пакета программ 
Adobe Acrobat.  

Формат PDF, в основе которого положен язык PostScript Level 2, может 
использоваться для представления как векторных, так и точечных 
изображений. Преимущество PDF-файлов заключается в том, что они могут 
содержать элементы, обеспечивающие поиск и просмотр электронных 
документов, в частности, гипертекстовые ссылки и электронное оглавление. 

Трассировка растрового изображения. Настройка, виды трассировки.  
Порядок действий 
Открываем наше растровое изображение в Adobe Illustrator.  
На панели инструментов выделяем инструмент «Выделение» (черная 

стрелочка) и этой стрелочкой щелкаем на нашем изображении. При этом 
рисунок должен выделиться. Чтобы проверить это, можете попробовать 
немного переместить его, зажав левую кнопку мыши, когда курсор находится 
над рисунком (по принципу drag-and-drop). 

Над рабочей областью находим кнопку «Быстрая трассировка» и 
щелкаем на расположенную рядом стрелочку. Она показывает все доступные 
для этого действия опции. Нам нужен пункт «Параметры трассировки…«. 
Когда мы на него кликаем, открывается окно с параметрами. 

В правой части окна параметров выбрать пункт «Просмотр«. Это 
поможет получить более хороший результат и разобраться, за что отвечает 
каждый из параметров.  

Когда картинка уже похожа на истину, в окне параметров трассировки 
нажимаем «Трассировка» и в меню над рабочей областью кнопку 
«Разобрать«. Таким образом, мы получаем первоначальное изображение, но 
уже в кривых. 

Если же вас не устраивает полученный результат, его можно доработать. 
Для этого с помощью инструмента «Выделение» необходимо выбрать все 
созданные кривые (нажать левую кнопку мыши и, удерживая ее, обвести весь 
рисунок целиком). Идем в пункт меню «Объект» > «Трансформирование» > 
«Масштабирование» и меняем размер изображения таким образом, чтобы 
оно было достаточно большим для удобства редактирования. Затем 
выбираем инструмент «Прямое выделение». Этой белой стрелкой 
поочередно кликаем в каждый узел и выравниваем сплайны так, как это 
необходимо: при выделении вершины рядом появляются усы, потянув за 
которые можно изменять кривизну сплайна. 

Также более хороший результат можно получить, если изначально брать 
крупное изображение хорошего качества. Поэтому, используйте 
качественные изображения в качестве сырья для трассировки. 
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ПРАКТИЧЕСКИЙ РАЗДЕЛ 
 

ТЕМА 3. ВЕКТОРНАЯ ГРАФИКА В ГРАФИЧЕСКОМ ДИЗАЙНЕ 
Лабораторная работа 1. Для закрепления практических навыков по теме 

3 научиться создавать новые документы, изменять их параметры, 
ознакомится с интерфейсом программы; в приложенных файлах произвести 
изменения размеров монтажной области, ориентацию, сохранить файлы под 
новым именем. 

 
ТЕМА 4. ПОСТРОЕНИЕ ДВУМЕРНЫХ ПРИМИТИВОВ. 

ИНСТРУМЕНТЫ ВЫДЕЛЕНИЯ. ОСНОВЫ КОМБИНИРОВАНИЯ 
ИЗОБРАЖЕНИЙ 

Лабораторная работа 2. Создание векторной иллюстрации для 
закрепления практических навыков по теме 4: «Рисуем мишку». 

берём инструмент "Эллипс"(L) и рисуем овал для головы медведя. 
-также эллипсом рисуем основные части головы(глаза, нос, щёки, блеск на 
блеск на лбу). 

 
2: 
-теперь дорисовываем нос. Для этого рисуем 2 овала как на рисунке снизу. 

-открываем Окно>Обработка контуров. 
-выделяем эти овалы(Shift) 
-в окне обработка контуров жмем "Исключить область пересечения 

фигур 
-разгруппировывыем объекты(в окне Обработка контуров или 

Обьект>Разобрать оформление. 
-лишний обьект удаляем(Delete) 

 
3: 
-теперь рисуем остальные части тела эллипсом и инструментом "перо" 
-регулируем положение фигур с помощью монтажа(Обьект>Монтаж) 
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4: 
-теперь придаем мишане форму, тени ,красивый вид. 
-копируем овал головы(Редактирование>Скопировать) 
-и вставляем на передний план 2 раза(Редактирование>Вклеить на передний 
план) 
-верхний овал смещаем и к нему выделяем тот что остался наместе. 
-теперь делаем как с носом. 

 
-Осталось всего лишь сделать то же, что и с головой, с другим частями тела, 
как на рисунке внизу. 

 
финал: 
-теперь можна включить фантазию  

 
 

 
ТЕМА 5. РАБОТА С КРИВЫМИ БЕЗЬЕ В ВЕКТОРНОМ РЕДАКТОРЕ 

Лабораторная работа 3. Создание векторной иллюстрации для 
закрепления практических навыков по теме 5: рисование контуров, прямых и 
изогнутых, работа с опорными точками, работа с инструментами карандаш, 
перо, сглаживание, стирка, ножницы, нож. Нарисовать  «Логотип в виде 
животного».  

Результат урока: 
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В этом уроке вы, используя основные фигуры, нарисуете ежика. В 

процессе мы также используем линии с заостренными концами, случайное 
рассеивание объектов и манипуляции с формой фигур. 

1. Рисуем тело 
Шаг 1 
Активируйте инструмент Polygon, выберите режим «Star», этим 

инструментом просто щелкнике по листу, в появившемся окне измените 
количество углов на 15 и залейте этот объект коричневым цветом

 
Инструменотом Работы с узлами, измените остроту лучей вашей фигуры 

 
 
Шаг 2 
Измените размеры многоугольника на 410×465. 

 
Шаг 3 
Продублируйте многоугольник (Ctrl+C ,Ctrl+F) и измените цвет копии 

на чуть более темный. 

 
Шаг 4 
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Поскольку эти два многоугольника будут перекрывать друг друга, 
давайте увеличим размеры одного из них, а именно более темной копии.  

Выделите оба объекта, откройте панель выравнивания  

 
Шаг 6 
Теперь нарисуем тело ежика. Вооружитесь инструментом Ellipse (E) и 

нарисуйте круг, удерживая для этого Shift.  Измените цвет заливки этой 
фигуры на телесный.Цвет обводки можно выбрать такой же, а можно 
избавиться от контура, разделив фигуру Object-Expand, удалить контур, 

выделив его инструментом  

 
Шаг 7Измените форму круга примерно так, как показано ниже. 

 
2. Рисуем глаза 
Шаг 1 
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Инструментом рисуем треугольник, , окрашиваем или 

аналогично удаляем контур,меняем его форму

 
Шаг 3 
Измените положение опорных точек примерно так, как показано ниже, 

чтобы сделать форму глаза более реалистичной. Заметьте, что здесь фигура 
уже располагается на фоне тела, чтобы лучше представлять размеры и 
собственно форму. 

 
Шаг 4 
Зрачок обозначит еще один круг темно-серого цвета. 

 
Шаг 5 
Двумя меньшими кругами добавьте блики белого цвета. 

 
Шаг 6 
Когда одни глаз готов, сделайте копию всех его элементов и отразите их 

по горизонтали, за исключением бликов – потому что иначе получится, что 
свет падает с двух сторон 
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3. Рисуем нос 
Шаг 1 
Здесь производим уже знакомые действия: нарисуйте эллипс, 

преобразуйте его в фигуру без контура и отредактируйте опорные точки так, 
чтобы было похоже на показанное ниже. 

 
Шаг 2 
Добавьте по центру носа овал темного цвета, обозначающий его кончик 

и еще один белый овал-блик белого цвета.Можно позаимствовать их у глаза 
Ctrl+C,Ctrl+F. 

 
Сейчас ваш ежик должен выглядеть примерно так: 

 
4. Рисуем уши 
Шаг 1 
Для ускорения процесса и избавления от лишних действий, 

продублируйте коричную фигуру глаза. Ctrl+C,Ctrl+F.Переместите копию 
влево и измените форму фигуры так, чтобы она стала похожа на ухо. 
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Шаг 2 
Добавьте фигуре уха обводку толщиной 12 пикселей. Измените значения 

цветов обводки и заливки указанным ниже образом. Затем командой Object> 
Lower (PageDown) отправьте ухо «за» тело. 

 
Шаг 3 
Не забудьте сделать копию этой фигуры для другой стороны.

 
Кистью нарисуйте ручки 

 
6. Рисуем ноги 
Шаг 1 
Можно сделать это так же карандашом, но быстрее скопировать одну из 

рук и повернуть и немного изменить ее форму с последующим 
расположением на надлежащем месте. Пространство «внутри» контура 
необходимо залить телесным цветом. Сейчас мы этим займемся. 

 
Шаг 2 
Продублируйте обе фигуры ноги. 

 
7. Добавляем тени 
Шаг 1 
Добавим иллюстрации немного глубины. Продублируйте фигуру тела. 

Измените цвет заливки копии на темно-коричневый. 
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Шаг 2 
Не снимая выделения с этого дубликата, опустите его примерно на 10 

пикселей вниз и вправо Правой кнопкой мыши ищем 

команду размещения в стопке слоев  
Шаг 3 
Теперь сделайте копию большого многоугольника. Измените цвет ее 

заливки на черный, уменьшите его непрозрачность, задав 50%. 

 
Шаг 4 
Отправьте полупрозрачный многоугольник на самый задний план 

 
Шаг 5 
Теперь нарисуйте прямоугольник, центруйте его и залейте фигуру 

зеленым цветом. 

 
8. Рисуем листья 
Шаг 1 
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Рисуем эллипс, выделяем инструментом Direct Tool, конвертируем 

верхний узел в острый.  
Шаг2 
задам ему оранжевый цвет заливки. Инструментом дуга, кисть или 

карандашом рисуем прожилки  

 
Шаг 4 
Карандашом или кистью дорисуйте черенок. Обратите внимание на 

параметры обводки, показанные ниже. Цвет этого контура будет темно-
серым. Не забудьте также отправить его «за» лист. 

 
Шаг 5 
Один цвет для листьев неинтересен. Поэтому продублируйте уже 

имеющийся лист пару раз и измените цвет заливки основной фигуры на 
указанные ниже. Когда вы сделаете это, сгруппируйте каждый лист. 

 
9. «Разбрасываем» листья 
Шаг 1 
Выделите первый нарисованный нами лист, поверните его, измените 

размер. Так же поступите и с другими листьями. Сгрупируйте все листочки. 
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Включите панель символов и 

перетяните туда группу листьев. Теперь работайте 
инструментом как кистью, «разбрасывая» листья по изображению.

Шаг 4  
Наконец, отправьте группу листьев на самый задний план, а потом 

поднимите на один вверх, чтобы группа была выше фона.  
 
 

ТЕМА 6. ТИПОГРАФИКА. ШРИФТЫ. РАБОТА С ТЕКСТОВОЙ 
ИНФОРМАЦИЕЙ 

Лабораторная работа 4. Для закрепления практических навыков по теме 
6 научиться: набору заголовочного текста, набору блочного текста,  
создавать связанные текстовые блоки, работать с избыточным текстом,  
отрисовывать леттеринги (работа с типографикой). 

Самостоятельная работа: 
1.Создать макет визитки 
2.Промежуточный тест 
 
Отрисовка леттеринга в векторе. 
Импортируем рисунок, закрепим слой, создадим новый слой, возьмем 

инструмент «Перо» (P). 
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Начнем постепенно отрисовывать части, объединяя их потом при 

помощи панели Pathfinder  

                             
Можно выбрать кисть и немного изменить стиль написания. 

 
 
3. Практическая работа «Рисуем Старый Ключ» 
После изучение основ работы инструмента Pen (Перо), применим наши 

знания на практике, нарисовав форму старого ключа. Для правильных углов, 
зажмите Shift, перед тем, как добавлять ключевые точки, чтобы 
придерживаться 90 градусов. 

Финальная Иллюстрация  
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4. Практическая работа «Упражнения с инструментом Pen» 
 

 
 
 
 

 
 
 
 
Самостоятельная работа: создание визитки 

 
 
Создание визитки в Adobe Illustrator  

 
Визитная карточка — аксессуар необходимый для делового человека, 

она говорит о его статусе, по ее виду судят о владельце. Ваша визитная 
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карточка может многое сказать о вашем бизнесе и роде деятельности, она 
придаст вам солидность и завершенный образ. Предлагаю рассмотреть урок - 
как разработать самому визитку в программе Adobe Illustrator. 

 1. Стандартный размер визитки 90х50 мм, но нам нужен дообрезной 
формат, для этого добавляем по 4 мм, размер визитки  будет 94х54 мм. 
Откройте Adobe Illustrator CS5 (можно более ранюю или позднюю версию - 
это не важно). Заходим File-New и ставим: Width (Ширина)-94мм, Height 
(Высота)-54 мм, Units (Единица) выбираем миллиметры. Жмем ОК. 

  
  
Должно появиться вот такое рабочее пространство: 

   
  
2. Нам нужно работать только со CMYK цветами, нажмите F6, выйдет 

палитра Сolor, там есть маленький черный треугольник, нажмите на него и 
выберите CMYK. 

  

 
  
3. Переходим в само рабочее поле и приступаем к созданию визитки. 

Выберите на панели инструментов Restangle Tool (Прямоугольник) 
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...и начертите прямоугольник, он должен соответствовать размеру 

визитки. 

 
Чтобы проконтролировать размер, нажмите Shift+F8 выйдет палитра 

Transform, введите в поле W - 94мм, в поле H - 54мм 

 
4. Теперь нам надо выровнять прямоугольник по рабочей области, 

нажмите Shift+F7 и в палитре Align (Выравнивание) нажмите на нижний 
треугольник, выберите Align to Crop Area (Выравнивание по площади). Затем 
выровняйте по верхнему и левому краю прямоугольник, не забыв его 
предварительно перед этим выделить. Кстати, если у вас не получилось 
открыть какую нибудь палитру с помощью горячих клавиш, вы сможете их 
найти в меню Window. 
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5. Далее выберите инструмент Text, 

 
...введите Ф.И.О. владельца визитки, если он встал на задний план, 

нажмите Shift+Ctrl+} или зайдите Object (Объект) - Arrange (Расположение) - 
Bring to Front (На передний план). 

Нажмите Ctrl+T, выйдет палитра Character (Символ), подберите нужный 
вам размер и кегль шрифта. 

Оформите по своему вкусу и желанию, насколько хватит вам творческой 
фантазии))) Не забудьте про должность и реквизиты. Если нужно, вставьте 
логотип вашей организации. Изменять цвета можете с помощью палитры 
Color (Цвет), горячая клавиша F6.  

После окончания работы выберите File (Файл) - Save As (Сохранить как) 
и сохраните свой проект. 

 
 
 
 

ТЕМА 7. ГРУППИРОВКА И УПОРЯДОЧИВАНИЕ ГРАФИЧЕСКИХ 
ОБЪЕКТОВ. ВЫРАВНИВАНИЕ И РАСПРЕДЕЛЕНИЕ ОБЪЕКТОВ 
 

 
Лабораторная работа 5. Для закрепления практических навыков по теме 

7 научиться работать с группами объектов, в режиме изоляции объекта, 
освоить операции скрытия и закрепления объектов. Закрепить практические 
навыки в творческой работе «Создание городского пейзажа». 
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Как создать городской пейзаж в Adobe Illustrator 

 
1.  Создать первый тип зданий 
Шаг 1 
Начнем с нижних зданий. Использование  прямоугольника - Rectangle 

Tool (M).  
Используйте   панель Stroke,  нажмите на  Align Stroke. 

 
Шаг 2 
Для дверей рисуем еще один прямоугольник. Возьмите Pen Tool (P) и 

нарисуйте линии, как на рисунке. Чтобы убедиться, что линии точно в 
середине, используйте  панель Align (Выровнять). Нажмите 
на  горизонтальной Align Center. 

 
Шаг 3 
 CTRL+G, чтобы сделать группу. Теперь вы можете дублировать окна, 

удерживая  клавишу Alt и перетаскивая мышью. Чтобы убедиться, что окна 
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выравниваются по центру здания, повторите те же действия, что и для окна, 
используя только здание как объект для выравнивания ваших окон. Также 
убедитесь, что вы выбрали  Выровнять по выделенному. Например, если вы 
хотите выровнять по монтажной области, выберите Выровнять по монтажной 
области - ваш рисунок будет всегда в центре композиции. 

 
Шаг 4 
Создадим окно на крыше с помощью 

прямоугольника. Используем инструмент Перо:  Add Anchor Point 
Tool (+),  нажмите в середине верхней строке прямоугольника и 
удерживая  сдвиг  нажмите  стрелку вверх на клавиатуре. Результат должен 
выглядеть следующим образом: 

Шаг 5 
Затем, используя Pen Tool (P),  создайте окно. Для создания цветов, 

используя Ellipse Tool (L)  создать небольшие круги (нажмите Shift, чтобы 
сделать их идеальными кругами!) И в панели Pathfinder (обработка 
контуров)  нажмите на Unite (объединить). 

 
Шаг 6 
Создайте два белых прямоугольника: один под цветы и один на 

нижней части здания. Создать флаг на левой стороне, путем 
создания   прямоугольника, Pen Tool (P) и Ellipse Tool (L), чтобы 

создать флагшток.  
2.  Создадим второй тип зданий 

Шаг 1 
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Снова создаем два прямоугольника Для окон используем ту же тактику, 
что и раньше. Результат должен выглядеть следующим образом. 

 
Шаг 2 
Для двери использовать Ellipse Tool (L), потом возьмите инструмент 

Direct Selection Tool (A) или белую стрелочку, выберите нижнюю точку круга 
и нажмите Удалить. Используйте Pen Tool (P),  чтобы нарисовать остальные 

двери.  
Шаг 3 
Создать  прямоугольник окна на крыше. Как и прежде, 

использовать  Add Anchor Point Tool (+), чтобы создать верхнюю и удалите 
нижнюю линию. Используйте Pen Tool (P), чтобы добавить нужные 
элементы кровли   

 
Шаг 4. Чтобы создать тень, с инструмент Direct Selection Tool 

(A),  выберите форму стены и перетащите его на стороне. Теперь 
возьмите инструмент Pen Tool и нарисуйте форму, как на рисунке 
ниже. Удалить контур с обеих форм и в Pathfinder панели нажмите на Divide 
(разобрать). 
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Выберите разделенную форму и перетащите его на 

стену. Выключите непрозрачность до 30%. Теперь у нас есть второе здание! 

 
3.  Дублировать Здания 
Нажмите и, удерживая клавишу Alt, перетащите его в сторону второго 

здания. Изменить цвет стены и дверей. И т.д. как на картинке 

 

 
4.  Создаем  Деревья 
Шаг 1 
Для создания деревьев, давайте использовать тот же метод, что и для 

цветов. Создать три круга: Поместите их все, как показано на рисунке, и с 
помощью панели Pathfinder  объединяем. 
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Создать стволы и разместить деревья, как на рисунке. 

 
5.  Создадим башню 
Использовать ту же тактику, что и для зданий и для дверей, которые мы 

создали ранее. Используйте Pen Tool для линий, и не забудьте выровнять все. 

 
Шаг 2 
Создать тень, как раньше. Для крыши, создать  круг. С помощью Direct 

Selection Tool (A) выберите нижнюю точку и удалите его, и 
использовать  Pen Tool, чтобы дорисовать. 

 
С помощью Rectangle Tool (M)   прямоугольник и выровнять его, далее 

уже известные вам операции в панели Pathfinder 

 
Шаг 3 
Для верхней части, вам нужно будет немного попрактиковаться в 

использовании инструмента Pen Tool. Используйте клавишу Shift, чтобы 
создать более совершенные линии и создать форму, как эта. 

 
Выберите форму, щелкните правой кнопкой мыши>  Transform> 

Reflect и нажмите COPY (Копировать). 

 
Соедините обе формы вместеДорисуйте шпиль с помощью Pen Tool (P). 
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6.  Добавить детали 
Шаг 1 
Для корзины, создать  прямоугольник. С помощью Direct Selection Tool 

(P) выделите нижние точки и перетащите маленькие круги, чтобы создать 
круглые углы. 

 
Создать линии, используя  Pen Tool (P)  и создайте небольшие круги (те 

же цвета, как за деревьями) для кустарников, с белыми штрихами для света. 
Добавить несколько строк, чтобы определить улицу. 

 
Шаг 2 
Для облаков использовать ту же технику, что и для деревьев и цветов 

создать круги и использовать  панель Pathfinder  Удалить точки, выбрав их 
с  помощью Direct Selection Tool (A) и добавьте строки с помощью Pen Tool 
(P). 
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ТЕМА 8. СОЗДАНИЕ СЛОЖНЫХ ФОРМ ИЗ ПРОСТЫХ. 

ИНСТРУМЕНТЫ ДЕФОРМАЦИИ. ТРАНСФОРМАЦИЯ ОБЪЕКТОВ 
 

Лабораторная работа 6. Для закрепления практических навыков по теме 
8 научиться создавать фигуры сложной формы используя палитру Pathfinder,  
создавать аналогичные фигуры используя инструмент Shape Builder,  
получить промежуточную форму объектов при помощи инструмента Blend, 
деформировать полученные объекты инструментами деформации, 
трансформировать объекты через палитру Трансформирование и через меню 
Объект – Трансформирование. 

 
Лабораторная работа «Паттерн из набора животных» 

В этом уроке мы создадим в программе Adobe Illustrator CC набор 
животных в плоском стиле, сделанных из простых форм. Используя 
прямоугольники, треугольники, круги, Live Corners и несколько волнистых 
линий, мы создадим целый зоопарк существ, из которых с помощью панели 
Pattern Options создадим паттерн-узор, который можно использовать в 
дальнейшем для разнообразной печатной продукции. Давайте начнем! 
Прим.переводчика: этот урок можно выполнить и в более ранних версиях 
программы. Если в программе нет возможности использовать Live Corners, то 
можно использовать инструмент Direct Selection Tool (А) для перемещения 
опорных точек и регулировать направляющие опорных точек, чтобы 
получить требуемый изгиб. 

1. Жираф 
Шаг 1. Создайте в программе Adobe Illustrator CC новый документ. 
Используйте инструмент Rectangle Tool (M) (прямоугольник), чтобы 
нарисовать ярко-желтый прямоугольник. Затем нарисуйте длинный, узкий, 
вертикальный прямоугольник с правой стороны первого прямоугольника. 
Для головы жирафа нарисуйте маленький прямоугольник наверху длинной 
шеи. 
Прим. переводчика: если вы выполняете урок в более ранних версиях 
программы, где нет возможности скруглять углы с помощью Live Corners, то 
удобнее для головы жирафа нарисовать не обычный прямоугольник, а 
прямоугольник со скругленными углами. 

 
Шаг 2. Нарисуйте четыре одинаковых прямоугольника для небольших ножек 
жирафа. Посмотрите как они идут! Выделите все четыре ноги, и на панели 
Align нажмите Vertical Align Bottom (Вертикальное выравнивание по низу), 
чтобы выровнять эти элементы по нижнему краю, в результате все ноги 
получатся стоящими на одной линии. 
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Шаг 3. Выделите прямоугольник-голову. С помощью инструмента Direct 
Selection Tool (A), выберите нижнюю правую опорную точку и потяните Live 
Corner к центру, чтобы скруглить этот угол. Выберите верхнюю правую 
опорную точку и слегка потяните Live Corner, чтобы сделать и этот угол 
немного закругленным. 
Закруглите верхний левый угол прямоугольника-тела так же, как мы это 
сделали с головой: потянув внутрь за Live Corner для этого узла. 
Прим. переводчика: здесь и в шагах далее, при выполнении операций по 
скруглению углов в более ранних версиях программы, воспользуйтесь 
инструментом Direct Selection Tool для перемещения опорных точек и 
отрегулируйте их направляющие так, чтобы получить требуемый изгиб. 

 
Шаг 4. Обратите внимание, что часть левой ноги торчит вверху из тела. 
Выберите прямоугольник-тело и две задние ноги жирафа (ноги слева). 
Используйте инструмент Shape Builder Tool (Shift-M), выберите лишнюю 
выступающую часть левой ноги. Снимите выделение и удалите этот объект, 
так жираф получит гладкую спину. 
Прим.переводчика: если у второй ноги нет частей, выступающих вверх из 
тела, которые тоже нужно удалить, то выделять эту ногу не обязательно. 
Также можно просто выделить левую ногу и выполнить ее трансформацию: 
переместите верхнюю границу этого прямоугольника на уровень низа 
прямоугольника-тела. Не перестарайтесь, следите за тем, чтобы границы 
прямоугольников совпадали, иначе нога «оторвется» от тела.  

 
Шаг 5. Рожки жирафа созданы из двух маленьких прямоугольников и двух 
кругов, нарисованных инструментом «эллипс» Ellipse Tool (L). Поместите их 
в верхней левой части головы жирафа. 

 
Шаг 6. Добавьте с помощью инструмента Rectangle Tool небольшой хвост 
слева, в нижней части тела жирафа. Объедините все желтые объекты в 
панели Pathfinder, воспользовавшись Unite. Используйте инструмент Ellipse 
Tool, чтобы нарисовать коричневый эллипс для глаза жирафа. Затем 
нарисуйте серию кругов по всему телу жирафа и на шее, чтобы 
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сформировать простой узор. Используйте инструмент Shape Builder Tool , 
чтобы удалить выходящие за пределы жирафа части кругов, как мы делали 
это ранее для ног. Сгруппируйте все компоненты вместе с помощью Group 
(Control-G), и ваш первый элемент паттерна готов. 

 
2. Кит. Шаг 1. Как и при создании жирафа, начнем рисовать кита с 
прямоугольника. Нарисуйте большой синий прямоугольник с помощью 
инструмента Rectangle Tool. Выделите нижнюю левую точку прямоугольника 
и потяните Live Corner внутрь, чтобы закруглить левый угол 
прямоугольника. 

 
Шаг 2. Для хвоста нарисуйте треугольник с помощью инструмента Pen Tool 
(P) или инструмента Polygon Tool. Потяните Live Corner для нижней левой 
опорной точки внутрь. Скопируйте Copy (Ctrl + C) и вставьте Paste (Ctrl + V) 
этот элемент, и поверните копию Rotate ® влево. Разместите оба элемента 
хвоста в правом верхнем углу тела кита. 

 
Шаг 3. Чтобы нарисовать киту горло - нарисуйте большой голубой круг с 
частичным наложением на левую сторону тела кита. Воспользуйтесь 
инструментом Shape Builder Tool, чтобы удалить часть круга, выходящую за 
пределы тела. Также в этом шаге я закруглила правый нижний угол 
прямоугольника тела кита.  

 
Шаг 4. Для вертикальных «углублений» на горле кита я использовала 
инструмент Pen Tool, чтобы нарисовать простую изогнутую линию; в панели 
Stroke задайте толщину обводки (контура) примерно 2-5 пункта (2–5 pt) (эта 
величина зависит от размера вашего объекта и того, насколько толстыми Вы 
хотите сделать «углубления»). Сделайте несколько копий этой гладкой линии 
с помощью Copy и Paste и поместите их на форму горла кита (как показано 
на рисунке ниже). Разверните и если нужно измените размер линий так, 
чтобы их концы выходили за пределы формы горла, выполните Expand 
(чтобы превратить линии в объекты с заливкой), а затем используйте 
инструмент Shape Builder Tool, чтобы удалить участки линий, выходящие за 
пределы формы горла (прим.переводчика – не забудьте перед этим выделить 
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как линии, так и форму горла кита), таким образом, у вас на рисунке 
останутся только изогнутые полосы для горла кита. 

 
Шаг 5. Нарисуйте несколько голубых кругов для водяного облака, 
выпускаемого китом. Объедините их, используя Unite в панели Pathfinder. 
Затем нарисуйте три или четыре тонких вертикальных прямоугольника, 
соединяющие тело кита с водяным облаком. 
Нарисуйте темно-коричневый эллипс для глаза кита, затем создайте 
округлый треугольник плавника на теле кита (так же, как делали для 
плавников хвоста) и измените цвет заливки «углублений» горла на синий 
цвет (такой же, как у тела кита), чтобы завершить работу над дизайном кита. 
Сгруппируйте (Group) все элементы вместе. 

 
3. Тигр. Шаг 1. Вначале с помощью инструмента Rectangle Tool нарисуйте 
оранжевый прямоугольник, как на рисунке ниже. Затем используйте 
инструмент Direct Selection Tool, чтобы выбрать обе нижних опорных точек и 
потяните Live Corners внутрь, чтобы закруглить низ головы тигра. 

 
Шаг 2 

Теперь таким же образом, как сделали голову, мы создадим ухо тигра 
(прямоугольник с закругленными углами), но также немного закруглим и 
верхние углы, чтобы на этой фигуре нигде не было острых углов. Поверните 
немного ухо и разместите его на одном из верхних углов головы. Сделайте 
такое же ухо на голове с другой стороны. Затем нарисуйте яркий розовый 
прямоугольник для носа, мы продолжим с ним работать в следующем шаге. 

 
 
Шаг 3 

Внутренние части ушей тигра - округлые прямоугольники с ярко-
розовым цветом заливки. Решите, какой нос вы хотите сделать тигру – в виде 
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скругленного прямоугольника или скругленного треугольник (см. рисунок 
ниже). Я выбрала скругленный треугольник. 
Нарисуйте два темно-коричневых эллипса для глаз и рот в форме 
перевернутой буквы "V" (прим. пер. - например используйте инструмент 
перо, и задайте получившемуся пути обводку темно-коричневого цвета). В 
панели Stroke установите округлые (Rounded) перегибы и концы линий. 

 
Шаг 4 

Нарисуйте серию треугольников вокруг головы тигра, это будущие 
«полоски». Также как при создании узора из кругов на жирафе, используйте 
инструмент Shape Builder Tool, чтобы удалить части треугольников, 
выходящие за пределы формы головы тигра, а затем сгруппируйте (Group) 
все компоненты тигра вместе. 

 
4. Лев 

Шаг 1 
Скопируйте (Copy) и вставьте (Paste) нарисованного ранее тигра. 

Удалите его полоски и измените цвет заливки с оранжевого на ярко-желтый. 
Я также изменила форму глаз, сделав их круглыми, а не в виде эллипсов как 
у тигра, просто чтобы сделать эти мордочки менее похожими. 

 
Шаг 2 

Чтобы сделать гриву льва, нарисуйте оранжевый круг чуть больше 
мордочки льва (так вы получите общее представление о размерах). 
Перейдите в Effect> Distort & Transform> Zig Zag и введите следующие 
параметры (или те, которые дадут вам подобный эффект): 

• Size: 0.1 in 
• Absolute 
• Ridges per Segment: 11 
• Points: Corner 
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Шаг 3 

Примените Expand к гриве, измените ее размер как вам требуется и 
поместите ее позади головы льва. Сгруппируйте вместе (Group) все 
компоненты льва. 
 

 
5. Муравьед 

Шаг 1 
Начнем с головы муравьеда, для этого нарисуйте треугольник. Выберите 
верхнюю опорную точку и потяните ее Live Corners к центру, чтобы 
закруглить этот угол треугольника. Повторите тоже самое для левой опорной 
точки, чтобы закруглить левый угол треугольника. 

 
Шаг 2 

Для маленьких ушей муравьеда нарисуйте два маленьких треугольника 
и закруглите у каждого треугольника верхний и правый углы. Поместите оба 
уха в верхней части головы муравьеда. 
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Шаг 3 

Тело и хвост муравьеда сделаем из двух прямоугольников. Скруглите 
левый нижний угол прямоугольника-тела и правый нижний угол 
прямоугольника-хвоста. Используйте инструмент Перо (Pen Tool) или 
инструмент Карандаш (Pencil Tool) (клавиша N), чтобы нарисовать 
волнистый розовый путь-язык. Убедитесь в панели Stroke, что концы для 
линии пути (cap) и углы (corner) установлены как Rounded (округлые). 

 
Шаг 4 

Нарисуйте маленькие прямоугольники для ножек муравьеда, кремовый 
эллипс будет глазом, а прямоугольник с закругленными углами станет 
узором на спине муравьеда. Сгруппируйте (Group) все компоненты 
муравьеда вместе. 

 
6. Черепаха 

Шаг 1 
Нарисуйте зеленый прямоугольник и потяните Live Corners внутрь, 

чтобы создать верх панциря черепахи. Выделите эту фигуру и измените 
размер нижней части закругленного прямоугольника так, чтобы общая 
высота фигуры получилась чуть больше, чем высота половинки круга 
верхней части панциря. 
Голова черепахи - это прямоугольник, закругленный с левой стороны, 
который помещен под фигуру-панцирь. Хвост – это треугольник, а ноги - 
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четыре маленьких прямоугольника. Сделайте цвет заливки панциря темно-
зеленым, более темным, чем цвет заливки головы, хвоста и ног. 

 
Шаг 2 

Используйте инструмент рисования многоугольников (Polygon Tool), 
чтобы нарисовать простой узор из соприкасающихся шестиугольников. Я 
решила, что, чтобы получить большой узор, проще копировать (Copy) и 
вставлять (Paste) участки из шестиугольников. Варьируйте оттенки и тона 
зеленого цвета, используемые для заливок шестиугольников. Сгруппируйте 
(Group) все шестиугольники вместе. Поместите форму панциря над узором из 
шестиугольников и создайте маску, выполнив Clipping Mask (Ctrl-7). 

 
Шаг 3 

Нарисуйте маленький коричневый эллипс для глаз черепахи и 
сгруппируйте (Group ) вместе все компоненты черепахи. 

 
 
7. Осьминог 

Шаг 1 
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Последним животным для нашего узора будет яркий красно-оранжевый 
осьминог. Также как мы делали раньше, начнем с прямоугольника. Он 
должен быть вертикальным. Выберите две верхние опорные точки в углах 
прямоугольника с помощью Direct Selection Tool и потяните их Live Corners 
внутрь, чтобы полностью скруглить верхнюю часть прямоугольника. 

 
Шаг 2 

Используя инструмент Перо (Pen Tool), нарисуйте слева волнистую 
линию, идущую от низа тела осьминога. Установите в панели Stroke толщину 
обводки, задайте этой линии закругленные (Rounded) углы и концы. Этим же 
способом продолжайте рисовать другие щупальца осьминога. 

 
Шаг 3 

Нарисуйте четыре щупальца на левой стороне. Примените к ним Expand 
(превратив их в объекты с заливкой), сгруппируйте их (Group), а затем 
скопируйте (Copy) и вставьте (Paste), получив щупальца для правой стороны. 
Отзеркальте их (Reflect) относительно вертикальной оси (Vertical Axis) и 
разместите на правой стороне осьминога. Я добавила коричневые эллипсы 
для глаз и несколько светло-красных кругов для узора в левом верхнем углу 
тела осьминога. Сгруппируйте (Group) все элементы вместе. 

 
8. Создание узора-паттерна 
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Шаг 1 
Откройте панель Библиотеки (Libraries) и внизу выберите опцию 

Создать новую библиотеку (Create New Library). Выделите и перетащите 
группу каждого животного в библиотеку и дайте новой библиотеке имя, 
например «животные» (animals). Это позволит далее легко создать свой узор. 

 
Шаг 2 

Поместите трех ваших животных на небольшой площади, например как 
на рисунке ниже. Масштабируйте (изменяйте размер) и поворачивайте 
(Rotate) элементы как вам требуется. 

 
Шаг 3 

Выберите все три объекта-животных и откройте панель Pattern Options. 
Нажмите Make Pattern в настройках панели. Выберите в поле Tile Type в 
качестве типа узора Brick by Column. С помощью также открытой панели 
Libraries, перетащите других животных на узор, чтобы они частично 
выходили за границы рамки, так вы создадите бесшовную модель узора-
паттерна. 

Поворачивайте (Rotate), изменяйте размер и переставляйте элементы 
при необходимости. Когда будете довольны своим рисунком - нажмите Done. 
Вы найдете только что созданный паттерн готовым к использованию в 
панели Swatches. 
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ТЕМА 9. РАБОТА С ЦВЕТОМ. ЦВЕТОВЫЕ АТРИБУТЫ 
 

Лабораторная работа 7. Для закрепления практических навыков по теме 
9 научиться: заливать фигуры и контуры объектов используя библиотеки 
образцов и каталогов, создавать собственные каталоги образцов и цветов, 
выполнять заливку фигуры градиентом, создавать градиент и добавлять его в 
библиотеку, создавать объект и заливать его инструментом Gradient Mesh, 
создавать собственные графические стили. Создать векторную иллюстрацию 
по приведенным образцам. 
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ТЕМА 10. ВЕКТОРНАЯ ЖИВОПИСЬ В ИЛЛЮСТРАТИВНОЙ 

ГРАФИКЕ  
 

Лабораторная работа 8. Для закрепления практических навыков по теме 
10 научиться: создавать контуры используй все типы кистей, создавать и 
настраивать собственные кисти, добавлять пользовательские кисти в 
библиотеку, создавать иллюстрации при помощи инструмента Brush. Создать 
векторную иллюстрацию по приведенным образцам. 

Рисуем птичек в Иллюстраторе. 
 Шаг 1. Нарисуем круг с помощью Инструмента Эллипс (Ellipse Tool) и 

закрасим его желто-белым радиальным градиентом (см. рисунок). 

 

 
Шаг 2. Выделяем наш круг и выбираем 

Эффекты>Стилизация>Растушевка (Effect>Stylize>Feather). Пусть радиус 
растушевки будет равен 10px. 

 

 
Шаг 3. Нарисуйте маленький круг с белой заливкой и желтой обводкой; 

затем другой со светлоголубой заливкой и без обводки; затем еще один с 
черной заливкой и обводкой и, наконец, крошечный белый круг. Разместите 
их, как на рисунке внизу. 

 
Шаг 4. С помощью Инструмента Карандаш (Pencil Tool) нарисуйте клюв 

и залейте его оранжевым цветом без заливки. Затем выделите его и выберите 
Эффект>Стилизация>Внутреннее свечение (Effect>Stylize>Inner Glow). 
Введите значения, как на рисунке внизу и нажмите Ok. 
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Шаг 5. Опять выбираем Инструмент Карандаш (Pencil Tool) и рисуем 
тело нашей пташки, после этого заливаем его также, как и голову. 

 
Шаг 6. Рисуем другое крыло и также заливаем. 
Шаг 7. Для полноты картины рисуем еще две птички любого 

понравившегося цвета. 

 
 

 
ТЕМА 11. ХУДОЖЕСТВЕННЫЕ ЭФФЕКТЫ В ГРАФИЧЕСКОМ 

РЕДАКТОРЕ 
 

Лабораторная работа 9. Для закрепления практических навыков по теме 
11 научиться: создавать и применять эффекты  (искажения, деформации, 
обработки контуров, стилизации, группы 3D). Использовать 
художественныхе эффекты Photoshop, редактировать эффекты.  

Создание векторной иллюстрации по теме. 
Практическая работа «Как нарисовать цветы» 

 
Начнём с голубого цветка. Сначала, с помощью инструмента 

нарисуем один листик, затем скопируем его несколько раз. Затем, с помощью 
стрелки , используя опорные точки, изменим их контуры, чтобы листья 
были разными. Отразим один с помощью инструмента и проделаем то же 
самое для левой части цветка. Соберём все листья в бутон и с помощью 
стрелки откорректируем их форму. 
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Теперь с помощью того же пера нарисуем тычинки. С помощью 

инструмента нарисуем овал, и поместим по одному овалу, на конец 
каждой тычинки. Теперь сделаем так, чтобы цветок немного “светился”. 
Подберём достаточно яркий цвет для бутона, цвет тычинок сделаем светло-
голубым, а овалы пусть будут светло-зелёными. Цвет обводки для бутона 
сделаем белым и установим ему толщину в один пункт. Теперь выделим 
лепестки и в главном меню иллюстратора выберем Effect / Stylize / 
InnerGlow. Установим следующие параметры: 

Mode: Screen 
Opacity: 66% 
Blur: 15.17 Edge 

 
Теперь выделим овалы и выберем Effect / Blur / Gaussian Blur. 

Установим Radius 10 пикселей. 
Бутон готов, теперь займёмся стеблем. Инструментом рисуем линию 

от бутона, цвет линии зададим зелёным. Выделим получившийся стебель и 
из главного меню выберем Object / Path / Outline Stroke. Стебель из линии 
превратится в замкнутый контур, выделим его и выберем Effect / Stylize / 
Outer Glow 

Mode: Screen 
Opacity: 75% 
Blur: 1.76 mm 

 
Стебель “засветился”, чтобы он не выглядел совсем размытым, зададим 

для него цвет контура чуть более тёмный, чем цвет заливки. 

 
Теперь добавим к стеблю листок, с помощью пера нарисуем замкнутый 

контур листа. Покрасим лист в зелёный цвет, контур листа зададим чёрным, 
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толщиной 0.5 пунктов. На листе с помощью пера нарисуем прожилки, так, 
чтобы все они имели общие точки, далее переведём их в кривые (Object / Path 
/ Outline Stroke) и объединим в один контур, для этого откроем палитру 
“Pathfinder”. 

  
Заострим кончик каждой прожилки, удалив одну опорную точку с 

помощью инструмента . 
Выделим все прожилки на листе, затем нажмём кнопку и кнопку 

“Еxpand”. 
Зададим прожилкам цвет, чуть темнее цвета листа, далее зададим для 

прожилок эффект Effect / Blur / Gaussian Blur, Radius 12 пикселей. Приделаем 
листик к стеблю. 

 
Следующим цветком будет роза. Сначала с помощью пера или 

карандаша нарисуем фигуру напоминающую бутон розы. Выделяем 
контур, два раза щёлкаем по инструменту , устанавливаем масштаб 
примерно 80-85 процентов и нажимаем кнопку “Copy”.  

 
Повторяем несколько раз, получаем набор фигур разного размера, 

немного поворачиваем каждую из них и, с помощью стрелки немного 
изменяем форму, чтобы фигуры не выглядели однотипными. 

Внутри вручную дорисовываем несколько маленьких фигур. Теперь 
выделяем их все вместе, задаём красный цвет заливки и контура, затем из 
главного меню выбираем команду Effect / Stylize / Inner Glow. Задаём такие 
параметры: 

Mode: Screen 
Opacity: 93% 
Blur: 11, Center 
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Теперь нарисуем листья, листья рисуются так же, как и у первого цветка, 

двух листьев будет достаточно, далее собираем их с верхней частью бутона. 
Чтобы создать переход от бутона к стеблю, зададим градиент для листьев. 
Направление градиента зададим с помощью инструмента от верхушки 
бутона, к стеблю. Чтобы настроить цвета откроем палитру “Gradient” и 
палитру “Swatches”. 

 
Нужные цвета из палитры “Swatches” в палитру “Gradient” можно 

перетаскивать мышью. Зададим переход от красного сначала, в оранжевый 
затем, в зелёный. Для листьев зададим эффект: Effect / Stylize / Outer Glow 

Mode: Screen 
Opacity: 75% 
Blur: 6 mm 

 
Стебель выполним как и у первого цветка, только листья сделаем более 

круглыми, и цвет более тёмный. Два цветка выглядят как-то печально, 
поэтому дорисуем третий. 

Нарисуем лист, цвет заливки будет розовый, цвет контура более 
светлый, можно сразу задать для него эффект. Effect / Stylize / Inner Glow. 

Mode: Screen 
Opacity: 70% 
Blur: 10, Center 
Теперь, на основе этого листика сделаем бутон. Выделим 

листок, выберем инструмент , далее, указываем точку, вокруг которой 
будем его разворачивать (будущий центр бутона) и удерживая нажатой, 
клавишу “Control” поворачиваем листок. 

После этого несколько раз нажимаем “Control+D”. Получим одинаковые 
лепестки, расположенные по кругу. Используя стрелки и , меняем 
форму и угол поворота каждого лепестка, чтобы они выглядели по-разному. 

Так же создаём второй слой лепестков. Добавим сердцевину. В центре 
цветка нарисуем фигуру овальной, или круглой формы, заливку сделаем, 
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контур - розовый и зададим эффект: Effect / Blur / Gaussian Blur, Radius 10 
пикселов. 

 
Стебель нарисуем так же, как и у первых двух. Цветок готов, поместим 

его в букет. 
 

Лабораторная работа «Рождественские колокольчики в Illustrator» 
 
Шаг 1. Начнем с рисования контура будущего колокольчика, используя 

инструмент Перо (Pen Tool). Ширину обводки зададим 5 пикселей, цвет - 
красный (цвет можно будет всегда изменить потом).  

 
Шаг 2. Выделяем нашу линию и выбираем Эффекты->3D->Вращение 

(Effect->3D->Revolve). 

 
Шаг 3. В открывшемся окне вы можете выбрать любые параметры и, 

включив режим Preview, посмотреть на получающиеся фигуры.  

 
 
Шаг 4. Добившись нужного результата, нажимаем Ок. Обратите 

внимание на Панель Слоев и на то, как там отображается наш колокольчик.  
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Шаг 5. Создадим копию нашего колокольчика непосредственно позади 

него, нажав для этого Ctrl+С для копирования и Сtr+B для вставки позади 
объекта. Вставленный объект будет автоматически выделен. Изменим его 
цвет на зеленый. Обратите внимание на Панель Слоев. Теперь там два 
колокольчика. Красный наверху, зеленый - внизу.  

 
Шаг 6. Подвинем зеленый колокольчик вправо и немного вниз, как 

показано на рисунке. Для того чтобы внести изменения, откроем панель 
Аттрибуты (Appearance) и, например, повернем зеленый колокольчик.  

 
Конечное изображение  

 
 
Revolve Effect 
Этот эффект предназначен для создания поверхностей вращения. 

Примером такого объекта может послужить винный бокал. Создадим при 
помощи инструмента иллюстратора - Pen Tool (P) половину формы бокала во 
фронтальной плоскости. 

137 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
Выделяем созданный путь, затем переходим Effect > 3D > Revolve…, что 

приведет к открытию диалогового окна с параметрами эффекта. Все 3D 
эффекты имеют похожие опции, поэтому рассмотрим их подробно на 
примере эффекта Revolve. Отметим опцию предварительного просмотра для 
того, чтобы наблюдать за происходящими изменениями. 

 
Для управления положением объекта в пространстве служат числовые 

поля, в которые вводятся углы поворота вокруг осей X,Y и Z. Вы также 
можете управлять положением объекта, поворачивая куб в диалоговом окне. 

 
Для тех же целей вы можете воспользоваться одним из пресетов из 

выпадающего списка Position. 
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Для применения к объекту эффекта линейной перспективы управляйте 

параметром Perspective. 

 
У вас есть возможность вырезать части объекта. Для этих целей служит 

параметр – Revolve Angel. Такая функция может пригодиться для создания 
технических иллюстраций. 

 
Очень важно, в какую сторону будет происходить вращение. Для 

управление этим параметром предназначены опции Left Edge и Right Edge. 
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Вы можете выбирать материал поверхности модели, выбирая 

подходящий пресет из списка Surface. 

 
Это конечно не то, что нам могут предложить специальные программы 

для 3D моделирования, однако это очень важный параметр для процесса в 
Adobe Illustrator и мы к нему еще вернемся немного позже. 

Если 3D модель будет являться конечным продуктом, то вы можете 
настроить дополнительные параметры, которые открываются в диалоговом 
окне после нажатия на кнопку More Options. 

 
Теперь вы можете управлять положением источника света, добавлять 

новые источники света и перемещать их для создания рефлексов от 
окружающих объектов.  
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Мы можем управлять параметрами источника света, такими как 

интенсивность и размер. 

 
Для создания более гладкого перехода между цветами увеличьте 

значение Blend Steps. 

141 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
Здесь я хочу предупредить вас, что слишком большие значения этого 

параметра сильно увеличивают размер файла и ведут к замедлению работы 
приложения. И наконец, вы можете выбирать Shading Color. 

 
Когда эффект настроен, нажимаем на кнопку OK. На практике часто 

бывает необходимо изменить параметры эффекта после его применения. Для 
повторного открытия диалогового окна кликаем по названию эффекта в 
панели Appearance (Window > Appearance) (при этом 3D модель, конечно, 
должна быть выделена). 

 
Теперь мы можем внести необходимые изменения. 
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ТЕМА 12. ОСНОВЫ ВЕБ-ГРАФИКИ 

 
Лабораторная работа 10. Для закрепления практических навыков по теме 

12 научиться: подготовке графических изображений для публикации в сети 
Интернет, оптимизировать размер графического файла, разрезать 
изображения, познакомиться с изображениями-картами. Создание веб-
иконок. 

Лабораторная работа «Иконографика» 
1. Создаем новый файл. «Горячие» клавиши Ctrl+N.  
2. Задаем имя документа- Погода, а так же высоту и ширину- 300 

mm. Остальное оставляем без изменений. 

 
3. Рисуем «эллипс» голубого цвета. Для этого выбираем 

соответствующий инструмент из левой панели. Важно! Что бы вышел 
идеальный круг зажмите клавишу Shift. 

 
4. Создаем новый слой. На правой панели кликаем по 

соответствующему значку. 
5. Рисуем будущее облако. Для этого выбираем инструмент 

«Эллипс» и рисуем 3 различных по размеру КРУГА (не овала).  Цвет- белый. 
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Важно!!! Сделать откат изменений, можно нажав клавиши CTRL+Z. 
6. Выбираем инструмент «прямоугольник со скругленными 

углами» (находится там же, где и «эллипс») и рисуем небольшой 
прямоугольник. Суть в том, что бы сделать ровный край у «Облака» 

 
Удаляем черный контур.  Удерживая клавишу Shift- кликаем по 

«облаку» выделяя его.  

 
Рядом с палитрой цвета (вверху справа) есть палитра контуров. В ней 

мы отменяем контур. (Внимательно смотреть скриншоты! Что не расписано, 
то показано на картинке.) 
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7. Далее мы соединяем все круги в одну фигуру. 

 
8. Создаем новый слой и копируем «Облако» на 

новый слой. Ctrl+C- скопировать, Ctrl+V вставить. Красим его светло серым 
цветом. Далее «отрезаем» половину- Рисуем прямоугольник, который делит 
«облако» пополамвыделяем 2 фигуры  

 
жмем кнопку указанную в скриншоте. Наше «облако» стало двуцветное.  
9. Рисуем солнце- эллипс красим в желтый цвет и делим его по 

тому же принципу как и «облако». Важно!!! Каждый эллемент должен 
находиться на отдельном слое.  
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Перемещаем слои с «Солнцем» под слои с облаками. А дальше- полет 

фантазии. 
 
https://sites.google.com/site/bacurinatv/ - Материалы Бачуриной Т.В. 
 
ОБЪЕМНАЯ ИКОНКА 

ОРГАНИЗАЦИЯ СЛОЕВ 
Откройте Adobe Illustrator и создайте новый документ с размерами 

800×600 пикселей, 72dpi и режиме RGB. Размеры в пикселях, фон белый. 
При открытом документе откройте панель слоев, которую можно найти 

в Window > Layers, если она у вас не открыта. Далее создайте там 4 новых 
слоя. Назовите их “base” (основа), “icon” (иконки), “light” (свет) и “overlay” 
(лого). Overlay — наложение, графика, которая будет накладываться 
поверх. 

 
СОЗДАЕМ ОСНОВУ 
Для создания основы иконки нарисуйте 

прямоугольник с овальными краями 
инструментом Rounded Rectangle Tool. 
Сделать это нужно на слое “base”, залейте 
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фигуру серым цветом. Чтобы нарисовать такую фигуру кликните этим 
инструментом по рабочей области. В диалоговом окне введите 42px по 

высоте и ширине, радиус угла 10px. 
 
КОНТУР ВНУТРЕННЕГО СВЕТА 
Переключитесь на слой света “light”, 

выберите инструмент Rounded Rectangle Tool. Цвет 
темно серый и кликните по рабочей области. 
Размеры на этот раз будут меньше на 4 пикселя. 
Ширина и высота 38px, радиус углов 8px. Кликаем 
ОК 

 
Оставайтесь на слое свет “light” , выберите Rounded Rectangle Tool, 

создайте новую фигуру с размерами 34 на 34px и радиусом угла 6px. 
Нажимте ОК. 

 
Зажмите SHIFT и кликните по двум 

внутренним фигурам, чтобы выделить обе. Не 
теряя выделение зайдите в панель Pathfinder. 
Если у вас её нет, откройте Window > 
Pathfinder. На этой панели выберите функцию 
Minus Front, чтобы получить ободок от двух 
фигур. 

 
Выберите оставшуюся деталь и откройте панель градиента Gradient 

palette (Window > Gradient). На этой панели выберите линейный градиент, от 
белого к белому. Установите 90 градусов. Один из якорей градиента сведите 
до 0% невидимости. Другой к 80% невидимости. После откройте другую 
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панель Transparency palette (Window > Transparency) и поставьте 
режим наложения Soft Light 

 
РИСУЕМ БЛИК СВЕТА 
Переключитесь на слой “overlay”, 

выберите любой цвет и создаете ещё один 
прямоугольник с овальными краями при 
настройках 38 пикселей по ширине и высоте. 
Радиус 8 пикселей. Затем выберите 
инструмент эллипс Elipse tool, рисуйте 
окружность и расположите её поверх 

прямоугольника. 
 
Нажмите SHIFT и кликните по окружности и 

прямоугольнику чтобы выделить оба. Откройте 
окно Pathfinder и кликните по кнопке Minus Front. 
Это отсечет одну фигуру от другой. 

 
РИСУЕМ КОНТУР БЛИКА 
С выделенной фигурой блика, кликните по 

панели градиентов Gradient  и выберите линейный 
градиент от белого к белому, с радиусом 0. Левый якорь установите на 25% 
невидимости, а правый на 0%. Затем измените режим наложения фигуры на 
“Soft Light”. 

Хотите верьте, хотите нет, но основу иконки мы закончили. Осталось 
лишь поиграть с цветами. 

 
СОЗДАЕМ ИКОНКУ ДЛЯ VIMEO 
После того как мы закончили основу иконки, можно 

начать создавать индивидуальный дизайн. Для примера я 
создам иконку для хипстерского видео сервиса Vimeo. 
Смысл этого урока в том, чтобы показать как просто 
создавать различные виды иконок, если мы создали 

правильную основу. 
Создайте две новых краски на панели Swatches . Клик по иконке New 

Swatch. Если у вас нет этой панели, откройте её в Window > Swatches 
Новым краскам задайте параметры R “31″, G “117″, B “196″ и R “113″, G 

“188″, B “237″ 
 
ПРИМЕНЯЕМ ГРАДИЕНТ 
Вернитесь на базовый слой “base” и 

выберите основу — прямоугольник и добавьте 
градиент из двух новых красок. В работе с 
градиентами вам поможет статья  

148 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И

http://hronofag.ru/wp-content/uploads/2012/08/image-light4.jpg
http://hronofag.ru/wp-content/uploads/2012/08/image-overlay.jpg
http://hronofag.ru/wp-content/uploads/2012/08/image-overlay2.jpg
http://hronofag.ru/wp-content/uploads/2012/08/image-overlay3.jpg
http://hronofag.ru/wp-content/uploads/2012/08/image-swatch.jpg


 
СОЗДАЕМ ЛОГОТИП 
К счастью Вимео создало свой логотип на основе шрифта Black Rose 

font. Загрузите его и напечатайте букву “V”. Я напечатал текст с размером 
 55pt и очень светло-серым цветом. Конвертируйте текст в кривые Type > 
Create Outlines и разместите букву по центру прямоугольника. 

СОЗДАЕМ ТЕНЬ DROP SHADOW 
Выделите логотип и нажмите CTRL+C чтобы скопировать фигуру. 

Нажмите CTRL+B чтобы скопированная фигуру появилась позади прежней. 
Не теряя выделение нажмите ENTER и настройте координаты фигуры. 
Поставьте 0,5px по горизонтали и -0,5px по вертикали. Кликните ОК. 

 
Меняем цвет скопированной фигуры и 

устанавливаем режим наложения Soft Light. 
Поставьте при этом невидимость около 50% 

 
ДОБАВЛЯЕМ ТЕНЬ ПОД ИКОНКОЙ 
По желанию можно создать тень под иконкой. 

Работайте с основным слоем “base”. Создайте 
небольшую окружность под иконкой. Залейте её 

радиальным градиентом, от черного к черному. Для левого якоря поставьте 
невидимость 60% а для правого 0%. aspect ratio 8% и расположение 60% 
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ТЕМА 13. ИНФОРМАЦИОННАЯ ГРАФИКА 

 
Лабораторная работа 11. Для закрепления практических навыков по теме 

13 научиться: создавать объекты инфографики, настраивать и редактировать 
их, использовать декоративные элементы, добавлять текст в перспективу.  

 
Инфографика в Adobe illustrator 

В этом уроке мы научимся рисовать инфографику, используя 
стандартные инструменты Adobe Illustrator. Также я покажу вам несколько 
способов изменения внешнего вида графика, сохраняя его динамические 
функции, т.е. у нас будет возможность редактировать данные графиков после 
всех преобразований. Давайте начнем! 

Шаг 1. 
Первый этап работы при рисовании инфографики заключается в поиске 

информации и обработке данных. В данном уроке мы использовали 
статистику, взятую с интернета. 

Первый график, который мы построим, будет показывать количество 
пользователей сетью Интернет, социальными сетями, мобильными 
устройствами и общую численность населения. Все перечисленное выше 
называется категориями, а номера, которые будут соответствоват 
категориям, - данными. 

Откройте Adobe Illustrator, выберите инструмент Bar Graph Tool или 
клавиша J («Вертикальные полосы»). Следует выбрать инструмент 
«Горизонтальные полосы». 
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Кликните мышкой на пустой странице нового документа и впишите 

желаемый размер графика (потом вы его сможете изменить). После нажатия 
«Ок» перед вами появится окно с табличкой, которую мы и будем заполнять 
статистическими данными. Кликните на ячейку в таблице – она выделится 
черным цветом. Информацию следует вводить в текстовое поле ввода, 
расположенное в самом верху окна. Выбор необходимой ячейки в таблице 
можно выполнять с помощью курсора. 

 
 После ввода необходимой информации по категориям, кликните 

галочку в верхнем правом углу окна «Применить». Таким образом, мы 
построили график. 
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Шаг 2.  
Созданный нами объект (график) – динамический. Т.е. мы всегда можем 

изменить его имя, последовательность данных, номер категории и/или 
данных. Если вы закрыли информационное окно графика, откроем его снова 
с помощью меню Object > Graph > Data (Объект > Диаграмма > Тип). 

 
Для примера, изменим вид графика. Я выбрала вид диаграммы «Радар». 

Свойства применяются только после нажатия на клавишу «Ок». 
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Шаг 3.  
Давайте исследуем окно Graph Type («Тип диаграммы»). Здесь мы 

можем изменять Bar Width (Ширину Полос), Value Axis (Оси Значений) и 
даже Add Drop Shadow (Добавить тень).  

  
 Более того, мы можем редактировать Value Axis (Ось Значений) и 

Category Axis (Ось Категорий). 
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Многие графические дизайнеры совершают одну и ту же ошибку: они 

преобразовывают динамический график в группу постоянных векторных 
объектов. Делают это путём расгруппировки объекта графики (Shift + Cmd / 
Ctrl + G). Но в этом случае теряется возможность изменения данных объекта. 
Поэтому мы не станем совершать такую ошибку и сохраним возможность 
редактирования данных. Как изменить внешний вид графика, вы узнаете 
немного позже.   

 Шаг 4. 
Теперь давайте создадим еще два динамических графика.  
Первый график «Использование сети Интернет в мире» постоим с 

помощью Pie Graph Tool (Круговая Диаграмма). 

  
Второй график постоим с помощью инструмента «Column Graph Tool» 

(Вертикальные полосы). 
Принцип работы с данными видами графиков ничем не отличается от 

работы с первым графиком (см. Шаг 1). 
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 Шаг 5.  
Теперь давайте создадим фон, на котором расположим графики. Я 

решила использовать стиль «Оригами» (т.к. этот стиль довольно популярен в 
наши дни). С помощью инструмента Rectangle Tool или клавиши М 
(инструмент «Прямоугольник») создадим прямоугольник и зальем его 
радиальным градиентом от белого цвета к нежно-голубому. 

 
В процессе добавления элементов на этот фон его размеры изменятся. 
Шаг 6. 
С помощью инструмента Pen Tool или клавиши P (Инструмент «Перо») 

создадим форму бумажной ленты, где поместим название. Закрасим объект 
линейным градиентом от белого цвета к серому. 

Направление градиента соответствует направлению лучей от источника 
света. Все последующие части рисунка будут освещаться этим же 
воображаемым источником. Для создания хорошего рисунка, выбор общего 
освещения является очень важным моментом. Поэтому следует обратить 
внимание на выбор освещения. 
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 Шаг 7. 
Создадим впечатление загнутой бумаги с помощью того же инструмента 

Pen Tool (P) (Инструмент «Перо»). Изменяя цвет линейного градиента, я 
покажу, как изменяется свет на этих поверхностях. 

 
Создадим некоторый контраст между светлым фоном и листом бумаги, 

нарисовав падающую тень. С помощью «Ellipse Tool» (L) (Инструмент 
«Эллипс») нарисуем окружность и зальем радиальным градиентом от серого 
цвета к белому. 

 
Преобразуем круг в эллипс с помощью инструмента Selection Tool (V) и 

клавиш Opt/Alt help. 
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Применим к слою режим непрозрачности Multiply (Умножение) и 

поместим его под лентой. 

 
По такому же принципу создадим тень в верхней части бумаги. Вот что 

у меня получилось: 

 
  
Шаг 8. 
Создайте еще один лист бумаги, но большего размера, чем предыдущий, 

по такому же принципу, как описано выше. У меня получилось вот так: 

 
Разместим на этом листе карту мира.  

 
 Шаг 9. 
Пора вернуться к нашим графикам. Разместим первый график на листе. 
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Как видите, график слишком большой, поэтому его надо уменьшить. 

Сделать это с помощью Selection Tool (V) («Выделение») нельзя. Поэтому 
выделим график и перейдем в меню Object > Transform > Scale (Объект > 
Трансформация > Масштабирование), и устанавливаем необходимое 
значение уменьшения в процентах. 

 
 Шаг 10. 
На примере этого графика давайте посмотрим, как изменить его 

элементы без потери динамических функций. К примеру, мне надо удалить 
оси. Для этого выберем одну из них и с помощью Direct Selection Tool (A) 
(«Прямое выделение») кликнем клавишу Delete. 

 
Как вы увидели, это невозможно. Но я могу схитрить – отключить 

обводку контура и объект станет невидимым. 
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Сделаем обе оси невидимыми. 

 
Сделаем и цифры невидимыми. 

 
 Шаг 11. 
Далее выделите текст с помощью Direct Selection Tool или клавиши А 

«Прямое выделение», и с помощью Символьной панели Window > Type > 
Character (Окно > Текст > Символ) измените параметры текста. 
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С помощью Lasso Tool (Q) (Инструмент «Лассо») или Direct Selection 

Tool (А) выделите точки, как показано на рисунке ниже и удерживая 
клавишу Shift удлините столбцы с помощью Direct Selection Tool. 

 
  
Шаг 12. 
Теперь будем работать со столбцами. Мы применю все настройки в 

панели Appearance Panel в меню Window > Appearance (панель 
«Оформление» в меню Окно > Оформление). Заменим заливку колонки на 
голубую и сделаем обводку белым. 

 
  
Шаг 13. 
Теперь давайте создадим очень простую заготовку. Идем в меню View и 

выбираем Pixel Preview (Просмотр > Просмотр в виде пикселов). Это 
необходимо сделать, чтобы элементы расположились именно в клетках 
пиксельной сетки. Возьмите Rectangl Tool (M) (Инструмент 
«Прямоугольник») и создайте 10 квадратов размером 1х1 пиксел, как 
показано на рисунке ниже. 
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Выделите все квадраты и перейдите в меню Объект > Узор > Создать. В 
вашей панели образцов появился созданный нами узор. 

 
 Шаг 14. 
Выделите колонку с помощью инструмента «Прямое выделение». 

Откройте панель «Оформление» и нажмите в нижнем левом углу на 
«Добавить новую заливку». Затем кликните по появившемся квадратике в 
меню заливки – перед вами откроется окно с образцами всех узоров и палитр. 
Выберите созданную вами заготовку узора и уменьшите непрозрачность до 
60%. 

 
Добавим еще одну заливку и применим линейный градиент голубого 

цвета, один из краев которого будет иметь прозрачность 0%. Таким образом, 
мы затемнили одну из сторон нашей колонки.  

161 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
 Шаг 15. 
Создадим тень под колонкой. Для этого выделим колонку, добавим еще 

одну заливку в панели Оформление и разместим её ниже всех остальных. 
Применим к ней градиент от черного цвета к светло-серому. 

 
Выделите заливку и перейдите в Effect > Warp > Arc Lower (Эффект > 

Деформация > Дуга вниз) и примените параметры, как показано на рисунке 
ниже. 

 
Далее идем в Effect > Trancform & Distort > Trancform (Эффект > 

Исказить и трансформировать > Трансформировать) и установим параметры, 
как показано на рисунке ниже. 
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Установим для заливки непрозрачность в режиме Умножение на панели 

Оформление. 

 
 Шаг 16. 
Для того, чтобы не повторять все эти действия с другой колонкой и 

сэкономить свое время, сохраните стиль данной колонки с помощью нижней 
клавиши «Новый стиль графики». 

 
Примените данный стиль к последней колонке и поменяйте цвет.  

 
Применим этот же стиль и к средним колонкам, но удалим настройки 

тени. 
С помощью инструмента Type Tool или клавиши T (Текст) напишим 

данные категорий и укажим ресурс, откуда взята информация. 
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 Шаг 17. 
Давайте проверим, можно ли изменять данные в графике. Идем в Object 

> Graph > Data (Объект > Диаграмма > Данные). 

 
Как видите, появилось окно. Это значит, что график до сих пор можно 

изменять.  
  
Шаг 18.  
Я изменила и остальные графики, используя те же принципы. Немного 

приукрасив и добавив информацию, которая может быть интересна 
пользователям, получилась вот такая страничка с инфографикой. 
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Заключение.  
Инфографика должна всегда оставаться динамичной, чтобы любой при 

необходимости мог внести изменения. Данные не могут быть постоянными, 
они изменяются. Поэтому и график должен быть динамичным, чтобы в 
любой момент можно было подправить данные, а не перерисовывать весь 
график заново.  

 
 

ТЕМА 14. ИМПОРТ И ЭКСПОРТ ИЗОБРАЖЕНИЙ. ДОПЕЧАТНАЯ 
ПОДГОТОВКА 

 
Лабораторная работа 12 по теме 14: осуществить допечатную 

подготовку индивидуальных проектов студентов. Распечатать итоговые 
проекты к зачету по дисциплине «Графический дизайн». 
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4. РАЗДЕЛ КОНТРОЛЯ ЗНАНИЙ 
 
В качестве одного из элементов, рекомендуемого для выявления уровня 

учебных достижений студента, используются критериально- 
ориентированные тесты. Они представляют собой совокупность тестовых 
заданий закрытой формы с одним или несколькими вариантами правильных 
ответов; заданий открытой формы с формализованным ответом; заданий на 
установление правильной последовательности. 

Для измерения степени соответствия учебных достижений студента 
требованиям образовательного стандарта также рекомендуется использовать 
проектную деятельность, включающую проблемные, творческие задачи, 
предполагающие эвристическую деятельность и неформализованный ответ. 

 
4.1. ЗАДАНИЯ ДЛЯ КОНТРОЛИРУЕМОЙ САМОСТОЯТЕЛЬНОЙ 

РАБОТЫ СТУДЕНТОВ 
Методические рекомендации 

по организации и выполнению самостоятельной работы студентов по 
учебной дисциплине 

Самостоятельная работа студентов направлена на обогащение их умений 
и навыков по учебной дисциплине «Графический дизайн» в свободное от 
обязательных учебных занятий время. Цель самостоятельной работы 
студентов – содействие усвоению в полном объеме содержания учебной 
дисциплины через систематизацию, планирование и контроль собственной 
деятельности. Преподаватель даёт задания по самостоятельной работе и 
регулярно проверяет их выполнение. 

Дисциплина изучается в течение одного семестра и предусматривает 
самостоятельную работу студентов. К зачету студент должен представить 
созданный им проект «Рекламно-информационный плакат кафедры». 
Предполагается теоретический контроль знаний в виде итогового теста или 
ответа на вопросы. Перечень вопросов и тест прилагаются. 

 
 

ТЕМА 10. Самостоятельная работа: Проект «Весна» 
 

 
1. Рисуем тело птицы 

166 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



Шаг 1 
Создайте новый документ и нажмите Ellipse Tool (L). Мы сначала 

создать тело птицы. Установите цвет обводки без заливки. Создайте 
эллипс. Затем добавить меньший эллипс на вершине. Возьмите Rectangle 
Tool (M) и нарисуйте прямоугольник; это будет горлышко птицы. Чтобы 
завершить фигуру, возьмите инструмент Direct Selection Tool (A) и сделать 
нижнюю часть прямоугольника широкой. 

В конце концов, форма должна выглядеть следующим образом: 

 
Шаг 2  
Использование Ellipse Tool (L), нарисуйте два длинных узких эллипса, 

чтобы создать хвост. Поместите их, как показано на рисунке ниже. 

 
 

Шаг 3 
Теперь давайте создадим клюв. Вам нужно будет получить острый угол 

с помощью Convert Anchor Point Tool (Shift-C). Нажмите на правую опорную 
точку. Затем возьмите инструмент Direct Selection Tool (A) и выберите 
верхний и нижний опорные точки. Сдвиньте их влево.  

  
Шаг 4 
Поместите клюв в его месте и добавьте эллипс, чтобы показать глаза 

птицы. 

 
Шаг 5 
Выберите формы, которые мы использовали, чтобы создать тело птицы. 

Перейдите  к Pathfinder панели (Окно> Pathfinder) и нажмите 
на Unite (объединить). 
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Возьмите Convert Anchor Point Tool (Shift-C) и конвертируйте острые 

углы в гладкие.   
Шаг 6 
Удалить все обводки,залить цветом. Цвет глаз черный с белой 

подсветкой. 

 
Шаг 7 
Теперь давайте создадим крыло. Установите цвет заливки  R = 96 G = 

115 B = 128 (или свой) и с помощью Ellipse Tool (L), нарисовать эллипс. С 
помощью Convert Anchor Point Tool (Shift-C) изменяем форму. Затем 
переместите верхнюю и нижнюю опорные точки слева. Выберите опорные 
точки, используя инструмент Direct Selection Tool (A), и переместите их, 
используя стрелки на клавиатуре. 

 
Шаг 8 
Поместите крыло на птицу. 

 
Шаг 9 
Теперь, давайте создадим темную область вокруг птичьего 

глаза. Сделайте острыми углы эллипса (R = 96 G = 115 B = 128). 

 
Шаг 10 
Поместите его за глаза птицы. 
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Шаг 11 
Нарисуйте эллипс. Поместите его, как показано на рисунке 

ниже. Выберите форму тела птицы и сделайте еще одну копию на переднем 
плане (Ctrl-C, F-Ctrl). Держите его выбран и, удерживая Shift,ключ, выберите 
новый перекрытия овал. В Pathfinder, нажмите Intersect (пересечение). 

 
Шаг 12 
Нарисуйте узкий эллипс, установите цвет заливки на R = 221 G = 213 B 

= 74. Затем выделите опорную точку перейдите к Effect> Warp> Arc (Эффект, 
искажение, арка). Введите нужные параметры. Не забудьте разобрать 
полученную фигуру (Object> Expand Appearance). 

 
Шаг 13 
Поместите вновь созданную форму на клюве. Птица готова! 

 
2. Создание другой птицы 
Используя тот же процесс и изменение цвета, мы можем создать другую 

птицу. 
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3. Создание Лук 
Шаг 1 
Начните с розового (R = 246 G = 160 B = 169) прямоугольника, с 

помощью Rectangle Tool (M). Перейти к Effect> Warp> Arc и введите 
следующие параметры: 

 
Шаг 2  
Разобрать форму (Object> Expand Appearance) и нарисуйте 

прямоугольник перекрывающийся, как показано на рисунке. Выберите две 
фигуры и на Pathfinder панели, нажмите Intersect (Пересечь). 

 
Шаг 3 
Выберите Reflect (зеркальное отражение) в контекстном меню 

Трансформации и в диалоговом окне выберите Vertical и 
нажмите Копировать. 

 
Шаг 4 
Прямоугольник который будет составлять среднюю часть 

банта. Введите параметры Warp с настройками, которые вы видите ниже: 

 
Шаг 5 
Использование Reflect Tool (O), сделать горизонтальное отражение 

частей банта и установите цвет заливки  R = 232 G = 116 B = 18. Не забудьте 
положить их за бант (Ctrl-X, Ctrl-B). 
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Шаг 6 
Возьмите одну из частей и сделайте ее немного 

больше. Наклоните. Затем поместите его позади всего (Ctrl-C, Ctrl-B) и 
измените цвет заливки на R = 244 G = 144 B = 159. После этого сделайте 
вертикальное отражение. 

 
4. Размещение. 
Упорядочить все, как показано. 

 
5. Составление цветочных веточек 
Шаг 1 
Теперь давайте создадим ветку. Установите цвет заливки  R = 128 G = 69 

B = 0.Возьмите инструмент Polygon Tool установите 3 стороны с 
любым радиусом. Вы получите треугольник, который вам нужно будет 
сделать очень узким и длинным. Copy-Paste несколько раз. 

 
Шаг 2  
Эллипс  залейте цветом R = 177 G = 190 B = 45. Выберите Convert 

Anchor Point Tool (Shift-C), и сделатйте острыми опорные точки. Вы 
получите форму листа. 

 
Шаг 3 
Скопируйте и вставьте  создать столько листьев, сколько вы хотите, и 

расположите их на ветке. 
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Шаг 4 
Возьмите инструмент Polygon Tool и сделайте 6 сторон,  радиус не 

имеет значения, но не слишком большой. Установите белый цвет заливки с 
любым цветом обводки. Из него сделаем цветок, перейдем в Effect> Distort & 
Transform> Втягивание & Bloat и установим ползунок на 60%. Цветок готов.  

  
Шаг 5 
Добавим желтый круг на средней части цветка. 

 
Шаг 6 
Расположите цветы на ветке, как вам нравится. 

 
6. Размещение. 
Сделайте вертикальное отражение и добавьте еще несколько цветов и 

листьев. 

 
7. Создание фона 
Шаг 1 
Нарисуйте прямоугольник поместите его на задний план. 

 
 
ТЕМА 13. Самостоятельная работа: Создать рекламно-информационный 

плакат с применением созданных элементов инфографики  
 
Проект «Рекламно-информационный плакат кафедры» 
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4.2. ПРОМЕЖУТОЧНЫЙ ТЕСТ ПО ПРОГРАММЕ «ADOBE 
ILLUSTRATOR» 

1. Каким графическим  
редактором является Adobe Illustrator? 

 
o Векторным  
o Фрактальным. 
o Растровым. 

 

2.  Какие  способы выбора 
инструментов  существуют  в 
программе Adobe Illustrator? 

 
o Выбор инструмента в панели 

инструментов или горячими 
клавишами с клавиатуры. 

o Выбор инструментов в 
контекстном меню некоторых 
палитр. 

o Выбор в главном меню. 
3.  В каких цветовых 

пространствах программа Adobe 
Illustrator может создавать рабочие 
документы?  

 
o Lab. 
o CMYK и RGB. 
o HSB. 

4.  Какое расширение 
файлов является в Adobe  Illustrator  
основным? 

 
o  .gif. 
o  .jpg. 
o  .cdr. 
o  .ai. 

5.  Что представляет собой 
pattern (узор) в программе Illustrator? 

 
o Повторяющийся рисунок, 

расположенный в пределах 
единичной плитки. 

o Плавный переход между 
цветами. 

o Расположенные в ряд объекты. 

6.  Каким образом в 
программе Adobe Illustrator можно 
менять прозрачность объектов?  

 
o Через палитру Layers (слои). 
o Через палитру Transparency 

(прозрачность).  
o Через панель инструментов. 

 
7.  Какая из 

нижеперечисленных палитр 
используется для управления 
параметрами текста? 

 
o Type (Тип). 
o Appearance (Внешний вид). 
o Graphic Style (Графический 

стиль). 
o Character (Символ). 

8.  Каким образом 
возможно редактирование настроек 
эффектов после их применения к 
объекту? 

 
o Через палитру Appearance 

(Внешний вид). 
o Через палитру Layers (Слои). 
o Через главное меню Effects 

(Эффекты). 
o Через палитру Swatches 

(Образцы). 
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9.  Как называют векторные 
линии, на основании которых 
программа Adobe Illustrator строит 
контуры? 

 
o Кривые Рено. 
o Кривые Безье. 
o Кривые Adobe. 

10.  При создании нового 
образца pattern он появляется в 
палитре: 

 
o Color (Цвет). 
o Swatches (Образцы). 
o Brushes (Кисти). 
o Symbols (Символы). 

11.  Какие типы заливок 
могут использоваться в программе 
Adobe Illustrator? 

 
o Цвет (Color), Градиент 

(Gradient), Узор (Pattern). 
o Цвет (Color), Материал 

(Material). 
o Материал (Material), Градиент 

(Gradient) 

12.  Как нарисовать 
треугольник? 

 
o Указать в настройках 

инструмента Многоугольник 
(Polygon) количество сторон – 3. 

o Создать прямоугольник и у 
него удалить одну из сторон. 

o Воспользоваться специальным 
инструментом Треугольник 
(Triangle). 

 
 

13. Каким графическим  
редактором является Adobe Illustrator? 

 
o Векторным  
o Фрактальным. 
o Растровым. 

 

14.  Какие  способы выбора 
инструментов  существуют  в 
программе Adobe Illustrator? 

 
o Выбор инструмента в панели 

инструментов или горячими 
клавишами с клавиатуры. 

o Выбор инструментов в 
контекстном меню некоторых 
палитр. 

o Выбор в главном меню. 
15.  В каких цветовых 

пространствах программа Adobe 
Illustrator может создавать рабочие 
документы?  

 
o Lab. 
o CMYK и RGB. 
o HSB. 

16.  Какое расширение 
файлов является в Adobe  Illustrator  
основным? 

 
o  .gif. 
o  .jpg. 
o  .cdr. 
o  .ai. 
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4.3. ВОПРОСЫ К ЗАЧЕТУ 
 
1. Основные концепции графического дизайна.  
2. Историческая реконструкция развития графического дизайна.  
3. Разделы графического дизайна по категориям решаемых задач.  
4. Основные категории в графическом дизайне.. 
5. Основы 2D графики, возможности и применение программ.  
6. Виды компьютерной графики, отличительные особенности.  
7. Характеристики цифровых изображений: цветовые модели 

(режимы), глубина цвета, размер и разрешение, форматы файлов.  
8. Обзор инструментария  для создания и обработки векторной 

графики.  
9. Редактор векторной графики Adobe Illustrator. Элементы 

интерфейса.  
10. Палитры. Рабочее пространство. Навигация в окне документа. 
11. Монтажные области. Линейки. Сетка. Направляющие. Умные 

направляющие. 
12. Построение двумерных примитивов. Инструменты выделения.  
13. Основы комбинирования изображений 
14. Работа с кривыми Безье в векторном редакторе 
15. Типографика. Шрифты. Работа с текстовой информацией 
16. Инструменты для работы с текстом. Создание и размещение 

текста. Заголовочный текст. Блочный текст.  
17. Работа с избыточным текстом. Создание текста в области. 

Создание текста по закрытому и открытому контуру. 
18. Преобразование текста в кривые. Стили символов и абзацев. 
19. Группировка и упорядочивание графических объектов. 

Выравнивание и распределение объектов 
20. Порядок следования. Изменение порядка наложения объектов. 

Скрытие объектов. Закрепление объектов.  
21. Группировка объектов. Работа с группами. Вложенные группы. 

Добавление в группу. Работа в режиме изоляции.  
22. Палитра Выравнивание. Выравнивание объектов относительно 

друг друга. Выравнивание по ключевому объекту. Выравнивание по 
монтажной области. Распределение объектов.  

23. Комбинирование и редактирование фигур. Палитра Обработка 
контуров. Объединение, пересекание, вычитание и исключение контуров.  

24. Работа с инструментом Создание форм. Инструменты 
деформации объектов.  

25. Инструмент Переход. Поворот и масштабирование габаритного 
контейнера. Трансформация объекта командами меню Трансформация: 
перемещение, масштабирование, поворот, наклон, зеркальное отражение.  
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26. Применение нескольких преобразований. Меню 
Трансформирование. Инструмент Свободная трансформация. Повтор 
трансформаций. 

27. Цветовые режимы. Палитра Цвет и Образцы. Создание и 
сохранение образцов цвета.  

28. Глобальные цвета. Плашечные цвета.  
29. Создание цветовых групп. Библиотека образцов.  
30. Инструмент Пипетка. Инструмент Быстрая заливка. Панель 

Обводка. Палитра Градиент. Настройка и выбор цвета.  
31. Сохранение образцов. Инструмент градиент. Инструмент 

Градиентная сетка: способы создания.  
32. Применение существующих узоров. Создание собственных 

узоров. Редактирование узоров.  
33. Трансформирование объектов с заливкой узором.  
34. Палитра Стили графики. Библиотека стилей. Создание и 

редактирование стилей.  
35. Векторная живопись в иллюстративной графике.  
36. Инструмент Кисть. Применение кистей к обводкам. Типы кистей: 

дискретные, каллиграфические, из щетины, объектные, узорчатые.  
37. Палитра кистей. Параметры кистей. Создание и удаление кистей. 

Библиотека кистей. 
38. Палитра Символы. Библиотека символов. Создание и удаление 

символа. Замена образца символа. Отмена связи с символом.  
39. Художественные эффекты в графическом редакторе.  
40. Растровые и векторные эффекты. Эффекты группы 3D, 

искажения, деформации, обработки контуров, стилизации. 
41. Художественные эффекты Photoshop. Применение и 

редактирование эффекта.  
42. Атрибуты оформления. Палитра Оформление. Добавление стилей 

графики на основе атрибутов оформления  
43. Палитра Прозрачность. Маска непрозрачности. 
44. Веб-графика: особенности и ограничения. Виды веб-графики: 

визуал, фоновая графика, навигационная, логотип, фовикон, банер. Форматы 
графических изображений в Интернет. Системы представления цвета в 
Интернет (Цветовые модели. Веб-цвета). 

45. Иконографика в Adobe Illustrator.  Подготовка векторных 
изображений для публикации в сети Интернет. Оптимизация размера 
графического файла.  

46. Информационная графика. Диаграммы и графики. Типы 
графиков и диаграмм. Создание объектов инфографики.  

47. Представление о перспективе. Инструмент Сетка перспективы. 
Добавление и редактирование объектов и текста в перспективу.  

48. Импорт векторных, растровых изображений. Работа с 
растровыми изображениями в Illustrrator.  
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49. Способы переноса растровых рисунков. Связанные файлы. 
Палитра Связи.  

50. Трассировка растрового изображения. Настройка, виды 
трассировки.  

51. Импорт текста. Экспорт из Adobe Illustrator. Сочетание графики 
Adobe Illustrator и Photoshop. 

52. Допечатная подготовка. Настройка параметров печати (цветовые 
модели, разрешение, форматы, обрезка, вывод, программная настройка 
принтеров). 
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4.4. ИТОГОВЫЙ ТЕСТ ПО ДИСЦИПЛИНЕ «ГРАФИЧЕСКИЙ 
ДИЗАЙН» 

1. Каким графическим  
редактором является Adobe Illustrator? 

 
o Векторным  
o Фрактальным. 
o Растровым. 

 

2.  Какие  способы выбора 
инструментов  существуют  в 
программе Adobe Illustrator? 

 
o Выбор инструмента в панели 

инструментов или горячими 
клавишами с клавиатуры. 

o Выбор инструментов в 
контекстном меню некоторых 
палитр. 

o Выбор в главном меню. 
3.  В каких цветовых 

пространствах программа Adobe 
Illustrator может создавать рабочие 
документы?  

 
o Lab. 
o CMYK и RGB. 
o HSB. 

4.  Какое расширение файлов 
является в Adobe  Illustrator  
основным? 

 
o  .gif. 
o  .jpg. 
o  .cdr. 
o  .ai. 

5.  Что представляет собой pattern 
(узор) в программе Illustrator? 

 
o Повторяющийся рисунок, 

расположенный в пределах 
единичной плитки. 

o Плавный переход между 
цветами. 

o Расположенные в ряд объекты. 

6.  Каким образом в программе 
Adobe Illustrator можно менять 
прозрачность объектов?  

 
o Через палитру Layers (слои). 
o Через палитру Transparency 

(прозрачность).  
o Через панель инструментов. 

 
7.  Какая из нижеперечисленных 

палитр используется для управления 
параметрами текста? 

 
o Type (Тип). 
o Appearance (Внешний вид). 
o Graphic Style (Графический 

стиль). 
o Character (Символ). 

8.  Каким образом возможно 
редактирование настроек эффектов 
после их применения к объекту? 

 
o Через палитру Appearance 

(Внешний вид). 
o Через палитру Layers (Слои). 
o Через главное меню Effects 

(Эффекты). 
o Через палитру Swatches 

(Образцы). 
9.  Как называют векторные 

линии, на основании которых 
10.  При создании нового образца 

pattern он появляется в палитре: 178 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



программа Adobe Illustrator строит 
контуры? 

 
o Кривые Рено. 
o Кривые Безье. 
o Кривые Adobe. 

 
o Color (Цвет). 
o Swatches (Образцы). 
o Brushes (Кисти). 
o Symbols (Символы). 

11.  Какие типы заливок могут 
использоваться в программе Adobe 
Illustrator? 

 
o Цвет (Color), Градиент 

(Gradient), Узор (Pattern). 
o Цвет (Color), Материал 

(Material). 
o Материал (Material), Градиент 

(Gradient) 

12.  Как нарисовать треугольник? 
 

o Указать в настройках 
инструмента Многоугольник 
(Polygon) количество сторон – 3. 

o Создать прямоугольник и у 
него удалить одну из сторон. 

o Воспользоваться специальным 
инструментом Треугольник 
(Triangle). 

 
 
 
 
 

13.  Как можно повернуть объект?  
 

o Инструментом Черная стрелка 
(Selection) или инструментом Поворот 
(Rotate). 

o Инструментом Белая стрелка 
(Direct Selection). 

o Инструментом Белая стрелка+ 
(Group Selection). 

 

14.  Каким образом можно 
назначить для линии рисунок кисти, 
выбранный в палитре Brushes?  

 
o Выбрать интересующий 

вариант кисти в палитре и 
нарисовать линию инструментом 
Кисть (Paintbrush). 

o Выделить линию и выбрать для 
нее рисунок кисти в палитре Stroke. 

o Нарисовать линию 
инструментом Blob Brush (кисть-
клякса). 

15.  Как выровнять объекты 
относительно монтажной области 
(Artboard)? 

 
o Нарисовать прямоугольник, 

равный по размеру документу и 
выровнять объект относительно него. 

o Включить специальный режим 
Align to Artboard (выровнять 
относительно монтажной области). 

16. Для чего применяется 
маленькая согнутая стрелка, 
нарисованная в панели инструментов 
рядом с Обводкой (Stroke) и 
Заливкой (Fill)? 

 
o Щелкая по ней, можно сделать 

активной то Обводку (Stroke), то 
Заливку (Fill). 

o Щелкая по ней, можно менять 
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o Данная опция задается сразу 
при создании документа. 

 

местами цвета Обводки (Stroke) и 
Заливки (Fill). 

o Щелкая по ней можно убрать 
Обводку (Stroke) или Заливку (Fill) у 
объекта. 

17. Как скрыть из видимости 
отдельный объект? 

 
o Применить к нему команду Hide 

(Спрятать). 
o Включить для него настройку 

Overprint Fill (Наложение фона). 
o Убрать у него обводку. 

18. Каким инструментом можно 
выделять опорные точки? 

  
o Инструментом Черная стрелка 

(Selection). 
o Инструментом Белая стрелка 

+(Group Selection). 
o Инструментом Белая стрелка 

(Direct Selection) или Инструментом 
Лассо (Lasso). 

19. Как переместить объект на 
задний план? 

 
o Написать в Управляющей 

панели (Control) его порядковый 
номер в стопке. 

o Выделить все объекты и 
применить к ним команду 
Object>Arrange>Send to Back (Объект 
– Расположение-Отправить на задний 
план). 

o Применить к отдельному 
объекту команду 
Object>Arrange>Send to Back. 

20. На основе каких критериев, 
может выделять объекты инструмент 
Magic Wand?  

 
o Цвет. 
o Толщина линий обводки. 
o Размер. 
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5. ВСПОМОГАТЕЛЬНЫЙ РАЗДЕЛ 
 

5.1.УЧЕБНАЯ ПРОГРАММА (прилагается) 
 

5.2.ОСНОВНАЯ ЛИТЕРАТУРА 
 

1. Голомбински, К. Основы визуального дизайна для графики, веб и 
мультимедиа / К. Голомбински, Р. Хаген. – СПб.: Питер, 2013. – 272 с.  

2. Дизайн. История, современность, перспективы : учеб. пособие / 
В.И. Куманин ; под общ. ред. И. В. Голубятникова. – М.: Аванта+, Астрель, 
2011. – 224 с. 

3. Корпан, Л. Компьютерная графика и дизайн /  
Л. Капран, В. Тозик. – М. : Академия, 2015. – 201 с. 

4. Крейг, Д. Шрифт и дизайн. Современная типографика / Д. Крейг. 
– СПб.: Питер, 2016. – 76 с. 

5. Курушин, В. Графический дизайн и реклама / В. Курушин. – М. : 
ДМК Пресс, 2012. – 272 с. 

6. Лаврентьев, Α. Η. История дизайна : учеб. пособие / 
Α. Η. Лаврентьев. – М. : Гардарики, 2007.– 303 с.  

7. Луптон, Э. Графический дизайн. Базовые концепции / Э. Луптон. 
– СПб. : Питер, 2017. – 256 с. 

8. Миронов, Д. Компьютерная графика в дизайне / Д. Миронов. – 
М.: HVB, 2014. – 560 с.  

9. Моисеев, В. С. Теория и методология дизайна : учеб. пособие / В. 
С. Моисеев. – Минск : РИВШ, 2015. – 204 с. + 1 электрон. опт диск (CD-
ROM). 

10. Пигулевский, В. Дизайн и культура / В. О. Пигулевский. – Харьков 
: Гуманитар. Центр, 2014г. – 313 с. 

11. Райтман, М. А. Adobe Creative Team. Adobe Illustrator CS6. Офиц. 
учеб. курс / М. А. Райтман. – М. : Эксмо, 2013. – 592 с. 

12. Райтман, М. А. Цифровой дизайн / М. А. Райтман. – М. : 
Рид Групп, 2011. – 768 с. 

13. Розенсон, И. А. Основы теории дизайна: учебник для вузов / И. 
А. Розенсон. – СПб. : Питер, 2013. – 252 с. 

14. Филь, П. Графический дизайн в XXI векe / П. Филь, Ш. Филь. – 
М. : АСТ, 2008. – 192 с. 

 
 

5.3. ДОПОЛНИТЕЛЬНАЯ ЛИТЕРАТУРА 
 

1. Adobe Illustrator CC. Офиц. учеб. курс. – М.: Эксмо, 2014. – 592 с. 
+ 1 электрон. опт. диск (CD-ROM). 

2. Айсманн, К. Ретуширование и обработка изображений : пер. с 
англ. – М.: Вильямс, 2007. – 484с. 
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Питер, 2016. – 200 с.  
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учеб. пособие / М. О. Сурина. – Ростов н/Д. : Феникс : МарТ, 2010. – 151 с.  
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	Ввод текста в точке
	Ввод текста в область
	Изменение размера области текста
	Изменение поля вокруг текстовой области

	Создание строк и столбцов текста
	Разгонка заголовка по всей ширине текстовой области
	Связывание текста между объектами
	Связь текста
	Удаление или разрыв связей

	Обтекание текстом вокруг объекта
	Обтекание текстом
	Установка параметров обтекания
	Отмена обтекания текстом вокруг объекта

	Выравнивание текста по объекту
	Удаление пустых текстовых объектов из изображения
	Выбор текста
	Выделение символов
	Выделение текстовых объектов
	Выделение контура текста
	Выделение контура текста позволяет изменить его форму и применить к нему атрибуты заливки и обводки. Такой уровень выделения недоступен для текста из точки. Если выделен контур текста, в палитре «Оформление» отображается слово «Контур».

	Изменение цвета и оформления символов
	Обзор палитры «Символ»
	Подчеркивание и перечеркивание текста
	Преобразование текста в кривые

	Группировка объектов
	Масштабирование объектов с помощью инструмента «Масштабирование»
	Масштабирование объектов с помощью ограничительной рамки
	Масштабирование объектов до определенной высоты или ширины
	Масштабирование объектов с указанием масштаба в процентах
	Масштабирование нескольких объектов
	Наклон объектов
	Наклон объектов с помощью инструмента «Наклон»
	Наклон объектов с помощью команды «Наклон»
	Наклон объекта с помощью инструмента «Свободное трансформирование»
	Наклон объектов с помощью палитры «Трансформирование»
	Искажение объектов с помощью инструмента «Свободное трансформирование»
	Искажение объектов с помощью инструментов «Пластика»


	Тема 9. Работа с цветом. Цветовые атрибуты
	Цветовые режимы. Палитра Цвет и Образцы. Создание и сохранение образцов цвета. Глобальные цвета. Плашечные цвета. Создание цветовых групп. Библиотека образцов. Инструмент Пипетка. Инструмент Быстрая заливка. Панель Обводка. Палитра Градиент. Настройка...
	Инструмент Быстрая заливка. Live Paint Bucket Tool.
	Eyedropper Tool (Пипетка). Клавиша быстрого вызова ‹I›. Предназначен для копирования аттрибутов оформления с одного объекта на другой. Копирование аттрибутов при помощи Eyedropper Tool возможно двумя способами.
	Первый способ:
	Изменение цвета узлов градиентной сетки при помощи инструмента Mesh Tool.
	Изменение прозрачности узлов градиентной сетки при помощи инструмента Mesh Tool.
	Для изменения прозрачности точек мешевой сетки выделите нужные точки любым способом и измените прозрачность при помощи палитры Transparency.
	Если хотите изменить распределение цвета между точками, перемещайте маркеры на концах направляющих при помощи Mesh Tool или Direct Selection Tool.
	Рисование кистями
	Каллиграфические кисти
	Дискретные кисти
	Художественные кисти
	Узорчатые кисти

	Создание новых кистей

	Растровые и векторные эффекты. Эффекты группы 3D, искажения, деформации, обработки контуров, стилизации. Художественные эффекты Photoshop. Применение и редактирование эффекта. Атрибуты оформления. Палитра Оформление. Добавление стилей графики на основ...
	- познакомиться с типами эффектов: растровыми и векторными.

	- Растровые эффекты
	- векторные эффекты
	-  Трассировка растрового изображения
	- Создание эффектов (искажения, деформации, обработки контуров, стилизации, группы 3D).
	- Настройка и редактирование объектов.
	- Использование художественных эффектов Photoshop.
	- Редактирование эффекта.
	- Создание векторной иллюстрации по теме.
	- освоить системы представления цвета в Интернет
	- научиться оптимизировать графические файлы
	- Веб-графика: особенности и ограничения.
	- Создание иконок.
	Создание ссылок
	Эффект перекатывания
	Уменьшение объема файлов
	Анимированный GIF
	Особенности вёрстки
	Психологический аспект

	Диаграммы и графики. Типы графиков и диаграмм. Создание объектов инфографики. Настройка и редактирование объектов. Использование декоративных элементов. Представление о перспективе. Инструмент Сетка перспективы. Добавление и редактирование объектов и...
	- познакомиться с типами диаграмм.
	- узнать о различных способах выделения элементов диаграммы.
	- научиться добавлять к диаграмме легенды и категории.

	- научиться использовать декоративные элементы в диаграммах.
	-освоить инструмент Сетка перспективы.
	- Диаграммы и графики.
	- Типы графиков и диаграмм.
	- Представление о перспективе.
	- Инструмент Сетка перспективы.
	- Создание объектов инфографики.
	- Настройка и редактирование объектов.
	- Использование декоративных элементов.
	- Добавление и редактирование объектов и текста в перспективу.
	Краткий конспект
	Основы построения диаграмм
	Что такое диаграмма
	Типы диаграмм
	Создание диаграммы
	Ввод данных
	Выделение элементов диаграммы
	Добавление к диаграмме легенды и категорий
	- узнать о различных способах экспорта и импорта изображений.
	- научиться трассировать растровое изображение.


	-освоить палитру Связи
	- освоить механизмы допечатной подготовки.
	- Экспорт файлов из Adobe Illustrator.
	- Работа со связанными файлами
	-Допечатная подготовка.
	Экспорт и импорт файлов Adobe Illustrator.
	В создании, трансформировании и передаче графической информации рационально использовать изображения и тексты других программ и других форматов. Поэтому программа Adobe Illustrator располагает процедурами обмена информации — импортом (использование ма...
	Трассировка растрового изображения. Настройка, виды трассировки.
	Порядок действий

	ПРАКТИЧЕСКИЙ РАЗДЕЛ
	Лабораторная работа 2. Создание векторной иллюстрации для закрепления практических навыков по теме 4: «Рисуем мишку».
	Создание визитки в Adobe Illustrator

	Как создать городской пейзаж в Adobe Illustrator
	1.  Создать первый тип зданий
	Шаг 1
	Шаг 2
	Шаг 3
	Шаг 4
	/Шаг 6
	Шаг 1
	Шаг 2
	/
	Шаг 4. Чтобы создать тень, с инструмент Direct Selection Tool (A),  выберите форму стены и перетащите его на стороне. Теперь возьмите инструмент Pen Tool и нарисуйте форму, как на рисунке ниже. Удалить контур с обеих форм и в Pathfinder панели нажмите...

	3.  Дублировать Здания
	Шаг 1

	5.  Создадим башню
	Шаг 2
	Шаг 3
	Шаг 1
	Шаг 2


	Тема 9. Работа с цветом. Цветовые атрибуты
	Рисуем птичек в Иллюстраторе.
	Шаг 1. Нарисуем круг с помощью Инструмента Эллипс (Ellipse Tool) и закрасим его желто-белым радиальным градиентом (см. рисунок).

	Лабораторная работа 9. Для закрепления практических навыков по теме 11 научиться: создавать и применять эффекты  (искажения, деформации, обработки контуров, стилизации, группы 3D). Использовать художественныхе эффекты Photoshop, редактировать эффекты.
	Создание векторной иллюстрации по теме.
	Практическая работа «Как нарисовать цветы»
	Revolve Effect

	Объемная иконка
	/Организация слоев
	Создаем основу
	Контур внутреннего света
	Рисуем блик света
	Рисуем контур блика
	Создаем иконку для Vimeo
	Применяем градиент
	Создаем логотип
	/Создаем тень Drop Shadow
	Добавляем тень под иконкой
	Инфографика в Adobe illustrator
	Методические рекомендации
	ТЕМА 10. Самостоятельная работа: Проект «Весна»
	1. Рисуем тело птицы
	Шаг 1
	Шаг 2
	Шаг 3
	Шаг 4
	Шаг 5
	Шаг 6
	Шаг 7
	Шаг 8
	Шаг 9
	Шаг 10
	Шаг 11
	Шаг 12
	Шаг 13

	2. Создание другой птицы
	3. Создание Лук
	Шаг 1
	Шаг 2
	Шаг 3
	Шаг 4
	Шаг 5
	Шаг 6

	4. Размещение.
	5. Составление цветочных веточек
	Шаг 1
	Шаг 2
	Шаг 3
	Шаг 4
	Шаг 5
	Шаг 6

	6. Размещение.
	7. Создание фона
	Шаг 1


	Основы 2D графики, возможности и применение программ.
	Виды компьютерной графики, отличительные особенности.
	Характеристики цифровых изображений: цветовые модели (режимы), глубина цвета, размер и разрешение, форматы файлов.
	Типографика. Шрифты. Работа с текстовой информацией
	Инструменты для работы с текстом. Создание и размещение текста. Заголовочный текст. Блочный текст.
	Работа с избыточным текстом. Создание текста в области. Создание текста по закрытому и открытому контуру.
	Преобразование текста в кривые. Стили символов и абзацев.
	Цветовые режимы. Палитра Цвет и Образцы. Создание и сохранение образцов цвета.
	Глобальные цвета. Плашечные цвета.
	Создание цветовых групп. Библиотека образцов.
	Инструмент Пипетка. Инструмент Быстрая заливка. Панель Обводка. Палитра Градиент. Настройка и выбор цвета.
	Сохранение образцов. Инструмент градиент. Инструмент Градиентная сетка: способы создания.
	Применение существующих узоров. Создание собственных узоров. Редактирование узоров.
	Трансформирование объектов с заливкой узором.
	Палитра Стили графики. Библиотека стилей. Создание и редактирование стилей.
	Растровые и векторные эффекты. Эффекты группы 3D, искажения, деформации, обработки контуров, стилизации.
	Художественные эффекты Photoshop. Применение и редактирование эффекта.
	Атрибуты оформления. Палитра Оформление. Добавление стилей графики на основе атрибутов оформления
	Палитра Прозрачность. Маска непрозрачности.
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